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Preface

Purpose of the manual
This manual contains information and instructions you need to install or upgrade EMC
Documentum Content Server™ on Windows, UNIX, or Linux with the Oracle, DB2, SQL
Server, or Sybase relational database management systems. It describes decisions you
must make and requirements that must be met before you install the server. It also
provides step-by-step instructions for installing and upgrading Content Server.

If you are installing full-text indexing, refer to the Content Server Full-Text Indexing
Installation Guide.

Intended audience
This manual is intended for the person installing Content Server. Typically, a system
administrator installs the software. After installation is complete, a repository
administrator can add users and groups to the repository so that users can begin using
the installation.

Revision history
The following revisions have been made to this document:

Revision History

Date Description

July 2006 Initial publication

Terminology changes
Two common terms are changed in 5.3 and later documentation:
• Docbases are now called repositories.
• DocBrokers are now called connection brokers.
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Chapter 1
Server Installation Quick Start

This chapter discusses which sections of this manual you must read in order to install or upgrade
Content Server successfully. Before you read them, review the Content Server Release Notes. If you are
upgrading Content Server, review the sections of the System Migration Guide that discuss changes and
migration issues in Content Server.

Installing full-text indexing
The Content Server Full-Text Indexing Installation Guide contains the configuration and
installation information required to install the full-text indexing system.

If you are an experienced Content Server user
If you are an experienced Content Server user and have created new repositories
and upgraded existing repositories, use the checklists in Appendix A, Preinstallation
Checklists as a guide to which sections of this manual to review in order to install or
upgrade this release of Content Server. Ensure that you review the Content Server Release
Notes, which contain a list of new and changed features. Ensure that you review the
Content Server Full-Text Indexing Installation Guide.

If you are creating a new installation
If you are creating a new repository and Content Server, review these chapters:
• Chapter 2, Planning for Content Server Installation contains detailed information on

the requirements for installing Content Server and on the decisions you must make
before you begin to prepare the database installation and Content Server host.
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• Chapter 3, Preparing for Content Server Installation contains detailed instructions
for configuring the Content Server host on Windows, UNIX, and Linux.

You do not need to read the section on preparing the host for an upgrade.
• Chapter 4, Preparing the Database for Content Server Installation contains detailed

information and instructions on preparing the database installation that supports
Content Server and the repository.

Review the requirements in this chapter with your database administrator.
• Chapter 9, Postinstallation Tasks contains instructions on additional steps that must

be completed after the Server is installed.
• Appendix A, Preinstallation Checklists contains checklists to help you ensure that all

necessary tasks are completed successfully before Content Server is installed.
After you review these chapters, use the instructions in Chapter 5, Express Installation for
a fast Content Server installation in which default values are used, or use the instructions
in Chapter 6, Custom Installation for a customized Content Server installation in which
you can control various database parameters and edit repository configuration scripts.
The Content Server Full-Text Indexing Installation Guide contains instructions for installing
the full-text indexing system.

If you are creating a new single-repository
distributed conguration

If you are creating a new single-repository distributed configuration, a configuration
program separate from the Content Server configuration program is used for installing
remote (content-file) servers and creating the storage areas on the remote hosts
and related location objects. Chapter 7, Installing Remote Servers in Distributed
Configurations contains instructions for installing and configuring remote servers in
distributed configurations. Note that remote Content Server hosts must meet the same
preinstallation requirements as the primary Content Server host.

Review the Distributed Content Guide before you install a distributed configuration.

If you are upgrading a repository
If you are upgrading an existing repository and Content Server installation, review the
Content Server Release Notes and read the following documentation:
• The sections of the System Migration Guide that discuss changes to Content Server.
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• Chapter 2, Planning for Content Server Installation contains detailed information on
the requirements for installing Content Server and on the decisions you must make
before you begin to prepare the database installation and Content Server host.

• The Content Server Full-Text Indexing Installation Guide contains information on
planning for full-text indexing and installing the full-text indexing software.

• Chapter 3, Preparing for Content Server Installation contains detailed instructions
for configuring the Content Server host on Windows, UNIX, and Linux.

Preparing for a Content Server upgrade, page 57 contains information on supported
upgrade paths and other upgrade issues.

• Chapter 4, Preparing the Database for Content Server Installation contains detailed
information and instructions on preparing the database installation that supports
Content Server and the repository.

Review the requirements in this chapter with your database administrator.
• Chapter 8, Upgrading Content Server contains instructions for upgrading the Server.
• If you are upgrading a pre-5.3 SP1 repository that uses the distributed content model,

read Upgrading a distributed configuration, page 120.

The new configuration program for remote Content Servers cannot be used to
upgrade remote servers in distributed content environments created before 5.3 SP1.
Upgrading a distributed configuration, page 120 describes the process you must
use to upgrade existing remote servers.

• Chapter 9, Postinstallation Tasks contains instructions on additional steps that must
be completed after the Server is upgraded.

• Appendix A, Preinstallation Checklists contains checklists to help you ensure that all
necessary tasks are completed successfully before Content Server is upgraded.

Other Content Server tasks
Review other chapters in the manual as needed:
• Chapter 10, Uninstalling Content Server contains information on deleting

repositories and connection brokers and uninstalling the Content Server and full-text
indexing software.

• Appendix C, Troubleshooting Content Server Installation. contains information to
help solve problems you encounter when you install or upgrade the Server.

• Appendix D, Content Server Installation Directories and Repository Configuration
Scripts contains information about the directory structure created by installing
Content Server and the scripts that run during repository configuration.

• Appendix E, Object Type Categories for Oracle Database Storage contains
information on Oracle database categories
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• Appendix F, Defining Oracle or DB2 Database Parameters for Repository Tables
contains information on customizing Oracle and DB2 to optimize database storage.

• Appendix G, Installing Content Server With Microsoft Cluster Services contains
information on installing or upgrading Content Server under Microsoft Cluster
Services.

• Appendix H, Configuring Multiple Servers on a Single Host for a Particular
Repository contains information on creating additional server in an existing
installation.
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Chapter 2
Planning for Content Server Installation

This chapter contains the information you need to plan a Content Server installation or upgrade. It
contains the following topics:
• About installation, page 17
• Operating systems and databases , page 22
• Other required software, page 22
• Host requirements, page 25
• Network requirements and topologies, page 27
• System sizing, page 27
• Configuration decisions, page 28
• Repository name and ID, page 35
• Internationalization decisions, page 36
• Planning for a Content Server upgrade, page 38
Before installing or upgrading the Server, review this chapter, Chapter 3, Preparing for Content
Server Installation, and Chapter 4, Preparing the Database for Content Server Installation. Complete
the checklists in Appendix A, Preinstallation Checklists. Perform any tasks described in Chapter 3,
Preparing for Content Server Installation that apply to your installation.

Content Server does not function properly unless the database is installed correctly. Review the
requirements in Chapter 4, Preparing the Database for Content Server Installation, carefully and
ensure that your database installation meets these requirements. If full-text indexing is required in
any repositories you create or upgrade, review the Content Server Full-Text Indexing Installation Guide.

About installation
Content Server installation has two stages. The first stage copies the server software from
the installation media to the proper directories on the Content Server host machine and,
on Windows, modifies the Registry and environment variables. The software installed
allows you to create Content Servers, repositories, and connection brokers.
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• Content Servers manage the documents in the repositories and respond to client
requests.

• Repositories store content files, metadata associated with the content files, and other
objects used by Content Server

• Connection brokers provide repository connection information to client applications.
Installing the server software also installs the Documentum Foundation Classes (DFC)
Runtime Environment if DFC is not already installed. This process creates a server
installation on the host.

On Windows, only one installation can be created on a particular host. The installation
can have multiple repositories and multiple instances of Content Server running against
each repository. All servers and repositories in the installation have the same version
number.

On UNIX and Linux, multiple installation can be created on a particular host, including
installations of different server versions. For example, a 5.2 installation and a 5.3
SP1 installation can exist on a single UNIX host. Each installation can have multiple
repositories and multiple instances of Content Server running against each of the
repositories. All servers and repositories in a single installation have the same version
number.

All repositories in an installation must be upgraded at the same time, on Windows
and UNIX platforms.

Instructions for creating additional servers on the repository host are provided in
Appendix H, Configuring Multiple Servers on a Single Host for a Particular Repository.

The second stage starts the server and configures the repository. It also configures and
starts the connection broker service. The second stage requires the person performing
the installation to provide information about the repository and components such as the
RDBMS.

Effects of installation

On Windows, UNIX, and Linux hosts, installation typically has these effects:
• Java and the Documentum Foundation Classes (DFC) are installed.
• The Content Server software is installed.
• A Content Server is created and started.

Content Server provides services such as document versioning, check in and check
out, workflow, and document lifecycle. Refer to Content Server Fundamentals and the
Content Server Administrator’s Guide for complete information on Content Server.

• The Java method server (Apache Tomcat) is installed and started.
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A single Tomcat instance serves all repositories created from a particular server
software installation. You can optionally use Tomcat for running custom Java
methods. (Do not use the instance for purposes other than running Java methods.)
For more information, refer to “Application Server” in the chapter call Methods and
Jobs, in the Content Server Administrator’s Guide. For information on starting and
stopping Tomcat, refer to Starting and stopping the Java method server, page 136.

• An ACS server is created and started.

An ACS server is a content server that serves content, but does not interact with the
repository’s database or metadata. The ACS server runs in the same Tomcat instance
as the Java method server. An ACS server is created in any Content Server or remote
Content Server installation. For more information about ACS servers, refer to the
Content Server Administrator’s Guide and the Distributed Configuration Guide.

• In an express configuration, a connection broker is installed and started; in a custom
configuration, you can optionally create and start one or more connection brokers.

A connection broker provides repository connection information to client
applications. For more information on connection brokers, refer to the Content Server
Administrator’s Guide.

• The Dmbasic method server is started.

This is a process that executes Docbasic methods. For more information, refer
to “Method Server” in Chapter 4, Methods and Jobs, in the Content Server
Administrator’s Guide.

• A repository is configured.

The repository consists of content files and object metadata. The metadata is stored
in database tables.

• Scripts are run to configure the repository.

For more information on the scripts, refer to Appendix D, Content Server Installation
Directories and Repository Configuration Scripts.

• More disk space is used in the installation directory.
• More disk space is used on the drive used by the RDBMS.
• New subdirectories are created.

For more information on the installation directory structure, refer to Appendix D,
Content Server Installation Directories and Repository Configuration Scripts.

• A keystore is created, containing a passphrase that is used to encrypt passwords
used for accessing the database and repository.

The passphrase created during installation can be changed after installation.
• Several users are created in the repository.

These are:

— The repository owner
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This is the account used to connect to the database. For more information, refer
to the sections on the repository owner in Windows host preparation, page 41 or
UNIX and Linux host preparation, page 48.

— The installation owner

This is a repository account for the account used to create the server installation
and configure the repository. The installation owner is a Superuser, with the
ability to create other users and perform administrative tasks in the repository.
For more information, refer to the sections on the installation owner in Windows
host preparation, page 41 or UNIX and Linux host preparation, page 48.

— Content Rendition Server Windows and Macintosh users

These are the accounts used by Content Rendition Services to retrieve rendition
requests that are queued in the repository. For more information, refer to the
documentation for Content Rendition Services.

— Media Services user

This is the account used by EMC DocumentumMedia Server to retrieve requests
to Media Server that are queued in the repository. For more information, refer to
the documentation for Media Services.

— Full-text indexing user

This is the user to whom index queue items are directed. For more information
on the full-text indexing user, refer to the Content Server Administrator’s Guide.

— Global registry user

This is the user whose account is used by DFC installations to connect to the
repository and retrieve service-based objects (SBOs) required by DFC client
applications or to access network locations. The user is created in all repositories,
but is activated only in repositories designated as global registries. For more
information on the user, refer to Global registry, page 31.

• Default content storage areas are created.

— filestore_01 is used for all content formats except thumbnails and streaming
media.

— thumbnail_storage_01 is used for thumbnail content files.

— streaming_storage_01 is used for streaming content.

— replicate_temp_store is used on a replication target host to hold the dump file
transferred during replication jobs.

— replica_filestore_01 is used in object replication on the target repository for
replicated content files.
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Streaming content and thumbnail content are created by Media Services. For more
information, refer to the documentation for Media Services. You can alter existing
storage areas or add new storage areas after installation.

Additional effects on a Windows host

Installing Content Server has the following additional effects on a Windows system:
• A menu item called Documentum is created (or, if the item already exists, it is

modified).
• An icon labeled Documentum Server Manager is added to the Start menu.
• A Content Server installation directory is created and files are copied to it.
• The following Windows user rights are given to the user performing the installation,

unless the user already has these rights:

— Act as part of the operating system

— Create a token object

— Increase quotas

— Log on as a service

— Log on locally

— Replace a process-level token

— The Windows registry is modified to reflect the new repository.

— The Windows TCP services file is modified.

Effects of upgrading

Upgrading an existing installation has the following effects:
• Content Server is stopped and then restarted.
• An ACS Server is installed and started.
• Type definitions are modified and new type definitions may be added.
• Existing full-text index, TDK collect, and TDK index objects are removed from the

repository.

New full-text indexes must be created for 5.3 and later repositories. New full-text
index objects are associated with the new indexes. Refer to the Content Server
Full-Text Indexing Installation Guide for complete information on installing the
full-text indexing components.
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• New dm_format objects are created in the repository.
• Some dm_format objects are updated.

If you modified any format objects, back up the changes before upgrading the
repository, which overwrites any changes.

• Some system administration objects are created or modified.
• New directories are created.
• Creates or modifies the Desktop Client configuration objects, templates, and

repository folders.
• All passwords are encrypted.
• On Windows, upgrading may affect the port on which a repository listens, if you are

using Trusted Content Services and the next available port is not sequential.
Upgrading Content Server does not affect the content in the repository, which remains in
the repository and requires no special migration.

Operating systems and databases
Content Server runs under the following operating system and database combinations:
• On Windows with Oracle, DB2, and SQL Server

Refer to Windows host preparation, page 41 for information on configuring
Windows for Content Server.

• On Solaris with Oracle and Sybase
• On HP-UX with Oracle
• On AIX with Oracle and DB2
• On Linux with Oracle
English version and the localized Japanese and Korean versions of SQL Server and
Oracle are supported.

Refer to the Content Server Release Notes for complete information on the specific
operating system and RDBMS versions you need for running Content Server.

Other required software
Installing and running Content Server requires certain other software, as detailed below.
Some of this software is installed when Content Server is installed.
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Database requirement

A properly-configured relational database management system must be available locally
or remotely. For full information on database requirements, refer to Chapter 4, Preparing
the Database for Content Server Installation.

Connection broker requirement

Your network must include a running connection broker. The connection broker provides
server connection information to client applications. You can install and start a
connection broker on the Content Server host as part of the installation process, or your
server can project to a connection broker located on a different host. If your server
projects to a connection broker on another host, you must provide the host name and
the port on which the connection broker listens during server configuration. There
can be one or more connection brokers on a network, and your repository can project
to multiple connection brokers.

The default port on which a connection broker listens is 1489. If multiple connection
brokers are installed on a particular host, each connection broker must be assigned a
unique port number on which to listen.

For more information on connection brokers, refer to the Content Server Administrator’s
Guide.

Requirements for full-text indexing

If full-text indexing is required in your repositories, the index agent and index server
must be installed. For a complete description of the supported configurations for full-text
indexing, refer to the Content Server Full-Text Indexing Installation Guide.

Index agent

The index agent prepares documents in a repository for full-text indexing and directs
the documents to its associated index server. (Full-text indexing allows users to easily
locate documents containing specific text.) A particular index agent runs against only
one repository. If you use full-text indexing, you must have an index agent installed
for each repository.
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Index server

The index server creates and maintains full-text indexes and responds to full-text queries
from Content Server. An index server can serve more than one repository.

Apache Tomcat application server

The Apache Tomcat application server is installed on the Content Server host and is
required for running the dm_event_template_sender method, the job sequencing utility,
and the LDAP Synchronization job.

Tomcat is required by EMC Documentum Content Server. It supports a variety of
features and licenses in the server. Use of an alternative application server, instead of
Apache Tomcat, is not supported.

SMTP mail server requirement on Windows

Content Server uses the SMTP mail protocol for sending routers, tasks, and notifications
to user mailboxes.

On Windows hosts, Content Server must be able to connect to an SMTP mail server. The
SMTP server can be an SMTP server located on your network or it can be the SMTP
server provided with Windows 2000. During the installation or upgrade procedure, you
must provide the name or IP address of the computer hosting the SMTP server.

If a valid SMTP server host name is not available during installation, supply an invalid
host name and the installation will finish. Do not leave the field blank. After installation,
add a valid SMTP server host name to the smtp_server attribute of the server config
object. Reinitialize the server after you update the server config object.

Documentum Administrator

Most repository and Content Server administration is performed using Documentum
Administrator, a WDK application that is installed on a supported application server
and accessed using a supported browser. For information on installing Documentum
Administrator, refer to theWDK and Applications Installation Guide. For information on
using Documentum Administrator, refer to the online help system for Documentum
Administrator.
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Host requirements
The hardware and operating system requirements for installing and running Content
Server are listed in the Content Server Release Notes.

Content Server can be installed in many configurations. In the most basic configuration,
which is typically used in development environments, the Server, index agent, index
server, and database are installed on the same host and the content files reside on the
same host. In production environments, the Server and database are often on different
hosts. The database instance does not need to be used exclusively for Content Server.

For performance reasons, it is recommended that you install the index server and
index agent on a host separate from the Content Server. For additional information on
supported full-text indexing configurations, refer to the Content Server Full-Text Indexing
Installation Guide.

You can run multiple Content Servers against one repository, with multiple Servers on
the repository host or on other hosts. For more information on Server configuration
options, refer to the Distributed Configuration Guide. If you are installing a distributed
configuration, the remote Content Server hosts must meet the same preinstallation
requirements as the primary Content Server host.

For information on creating multiple servers on the repository host, refer to Appendix H,
Configuring Multiple Servers on a Single Host for a Particular Repository.

If you run multiple servers against a single repository, all servers must enable Trusted
Content Services or none must enable Trusted Content Services. Running both trusted
and non-trusted Content Servers against a single repository is not supported. For more
information about Trusted Content Services, refer to Trusted Content Services, page 33.

A federation may contain different Content Server versions and may contain a mix of
trusted and non-trusted Content Servers.

There are specific configuration requirements for Content Server on Windows, UNIX,
and Linux hosts. These requirements are discussed below in Windows host preparation,
page 41 and UNIX and Linux host preparation, page 48.

Your host computer’s video card setting must be at least 256 colors (16 bit) for the
graphical installer to work correctly.

The host computer’s name must use only ASCII characters.

Required ports

Content Server and software associated with the Server require that a number of ports
are available:
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• Content Server requires two consecutive port numbers to be assigned to native
connections and secure connections.

On Windows, the ports are determined by the server configuration program. On
UNIX, the ports are assigned by you in the services file before the installation process
begins. Refer to Setting up the services file, page 55 for more information.

• The Java method server and ACS server run in a Tomcat instance that requires two
ports on which to listen.

• The connection broker requires a port on which to listen.

The default connection broker port is 1489. Refer to Connection broker requirement,
page 23 for more information about connection brokers.

• The index agent, which may be installed on the Content Server host, runs in a Tomcat
instance that requires two ports on which to listen.

The default index agent ports are 9081 and 9008.
• The index server, which may be installed on the Content Server host, requires an

available range of four thousand (4,000) consecutive ports.

The default range is from 13000 to 17000.

Application servers and WDK applications

If your environment includes WDK applications such as Webtop or Web Publisher,
for performance and security reasons it is strongly recommend that you install the
application server and any WDK applications on a host remote from the Content Server
host.

If you decide to install the application server and WDK applications on the Content
Server host, it is strongly recommended that you use an account that is not an EMC
Documentum user for installing the application server and WDK applications. If the
application server installation owner is an EMC Documentum user, a security hole is
created because trusted login allows any EMC Documentum user who has successfully
connected to a host to connect to Content Server without providing a password.

However, using different user accounts to install multiple EMC Documentum
applications on a single host undermines version control and product interoperability
because the version-control mechanism used by the installers is based on the ISMP
per-user vital product registry. It cannot validate or enforce version control and
guarantee product interoperability unless all products are installed using the same
system account.
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Network requirements and topologies
Content Server requires a properly-configured TCP/IP network. The network must
be able to support the required number of users and must have sufficient capacity
for the number of client connections to the server that your business requires and for
transferring content files from client hosts to the repository.

If you are installing a distributed configuration, there are special network requirements.
For a brief description of distributed configurations, refer to Installing a distributed
configuration, page 30. For complete information on the requirement, refer to the
Distributed Configuration Guide.

If you are installing on a host computer that uses multiple network cards, by default
Content Server only binds to the first network card. For information on changing the
binding behavior so that Content Server binds to a different IP address, refer to the
Content Server Administrator’s Guide.

System sizing
System sizing is the process of determining what hardware, software, and network
configurations will provide the best performance for users at the lowest cost to the
enterprise. Another term for system sizing is capacity planning. EMC Documentum
provides tools and guides for system sizing. These are available on the Technical Support
Web site and MarketingNet.

Java method server
Content Server uses Apache Tomcat for running Java methods.

If you are installing a new Content Server, a Tomcat instance is created and the Java
method server is installed by default. It requires two ports. The Tomcat instance is also
used for running the ACS server.

Do not use the installed Tomcat instance for any purpose other than running Java
methods and the ACS server, including running Documentum WDK applications or
Documentum Business Process Services.

On Windows, the Java method server is installed as a Windows service and is configured
to start automatically as a service.

Apache Tomcat, installed with Content Server, is required by EMC Documentum
Content Server. It supports a variety of features and licenses in the server. Use of an
alternative application server, instead of Apache Tomcat, is not supported.
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Conguration decisions
Before you install Content Server, decide whether to use express or custom repository
configuration, whether you are installing a distributed configuration, whether you are
installing Trusted Content Services, and whether you are installing Content Services for
EMC Centera . The following topics are discussed in this section:
• Full-text indexing, page 28
• Express or custom configuration, page 28
• Repository size, page 29
• Client connection types, page 29
• Installing DocApps, page 30
• Installing a distributed configuration, page 30
• Global registry, page 31
• Trusted Content Services, page 33
• Content Services for EMC Centera, page 33
• Content Storage Services, page 34
• Collaborative Edition, page 34

Full-text indexing

Full-text indexing in repositories 5.3 and later requires installing and configuring the
index agent and index server. For complete information on configuration choices and for
installation instructions, refer to the Content Server Full-Text Indexing Installation Guide.

Express or custom conguration

The installation procedure for Content Server gives you a choice between express and
custom configuration options. The custom configuration option gives you considerable
flexibility in how the repository is configured, while the express option is faster and
uses many default values.
• Express configuration:

— Uses default installation choices.

— Allows you to install the first site in a distributed configuration

— Automatically installs a connection broker on the Content Server host.
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For additional information on installing a distributed configuration, refer to Installing
a distributed configuration, page 30 and to the Distributed Configuration Guide.

• Custom configuration:

— Allows you to edit any of the server installation, initialization, or startup scripts

Use caution in editing these scripts. Errors in the scripts can cause repository
errors or abort server startup. For information on each of the initialization files
and installation scripts, refer to the Content Server Administrator’s Guide.

— Allows you to choose language support for a language other than the language
of the host computer’s operating system

— Allows you to install additional servers for a repository

— Enables configuration of Content Server to run with Microsoft Cluster Services

Refer to Appendix G, Installing Content Server With Microsoft Cluster Services,
for full instructions on installing with Cluster Services enabled.

— Allows you to install the first site in a distributed configuration

Repository size

During repository configuration, you are asked to choose a repository size. The
repository size you choose determines the sizes of the tablespaces, log file sizes, and
index tablespace sizes, and also whether all of these can be configured. In a custom
installation, you can also modify the initial sizes during installation. The initial sizes
differ by RDBMS. For more information, refer to the individual sections for each RDBMS
in Chapter 4, Preparing the Database for Content Server Installation.

Client connection types

During repository configuration, you are asked what type of connection clients will
connection to the repository. The choices are:
• native

When native connections are chosen, Content Server listens for clients only on an
unsecure port. Content Server refuses requests for a secure connection.

• secure

When secure connections are chosen, Content Server listens for clients only on
a secure port, using SSL. The client and server do not use SSL authentication to
authenticate each other. However, the information exchanged between the client and
server is encrypted. Content Server refuses requests for an unsecure connection.
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Do not set the mode to secure if you have pre-5.2 clients connecting to the repository.
The connection requests from such clients will fail.

• native and secure

Content Server accepts both native and secure connection requests.

Installing DocApps

A DocApp packages lifecycles, workflows, object types, alias sets, permission sets, and
other objects required by an application. The DocApp must be installed in a repository
before the application can store documents in that repository.

If a new repository is created in a server installation where an existing repository is
loaded with a particular DocApp, you are asked during repository configuration
whether to install that DocApp in the new repository. If there are multiple repositories
in a server installation, and a DocApp is loaded in one of the repositories, when the
other repositories are upgraded, you are asked whether to install the DocApp in the
other repositories.

Installing a distributed conguration

Repositories and Content Servers can be installed in distributed configurations. A
distributed configuration may take one of these forms:
• A single repository with multiple servers, using a distributed storage area and

content servers
• A single repository with multiple servers, using a distributed storage area and

content replication
• Multiple repositories that replicate objects among themselves
• Multiple repositories organized as a federation
If you plan to set up a distributed configuration, review Chapter 1, Distributed Models,
and Chapter 2, Building Blocks, of the Distributed Configuration Guide for information on
the benefits, uses, and configuration requirements for different distributed configuration
models. You can use either express or custom installation to set up the first site of a
distributed configuration. If you are setting up a single-repository configuration, refer to
the chapter titled Implementing Single-Repository Models in theDistributed Configuration
Guide for information on setting up the other sites and for further installation information.

If you are setting up a multi-repository distributed configuration or cross-repository
operations, refer to the chapter titled Implementing Multi-Repository Models in the
Distributed Configuration Guide for details about additional required configuration.
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If you are installing a single-repository distributed configuration, all servers must enable
Trusted Content Services or none must enable Trusted Content Services. Running both
trusted and non-trusted Content Servers against a single repository is not supported.

Including both trusted and non-trusted Content Servers in a repository federation
is supported.

If you are creating a new single-repository distributed content configuration, use the
instructions in Chapter 7, Installing Remote Servers in Distributed Configurations
to create the Content Servers at the remote sites. If you are upgrading an existing
distributed configuration, refer to Upgrading distributed configurations, page 60.

A repository using a distributed storage area with encrypted filestores as components
cannot use shared content.

EMC DocumentumWeb Publisher and EMC Documentum Site Caching Services are not
supported in distributed configurations, in federations, or where replication is used.

If you are using distributed content, all content is copied to the primary content store for
full-text indexing. Ensure that there is sufficient space on the drive where the primary
store is located for all content that may be copied for full-text indexing.

If you install a distributed configuration, ensure that all host computers in the
configuration are set to the same UTC time.

Caution: Once a repository has been configured to use distributed storage, it is not
possible to revert to using nondistributed storage.

Global registry

A global registry is a central repository used to make certain types of objects available
to DFC instances throughout a Documentum installation. The global registry serves
two purposes in Documentum 5.3 SP1:
• Deploying service-based business objects (SBOs)

SBOs are required by some out-of-the-box Documentum applications and may be
required by your custom applications.

• Storing network location objects

Network location objects define a Web client user’s location on a network. Network
locations are used by Content Server to determine from which storage area content
files are served to Web client end users in distributed configurations. The Distributed
Configuration Guide contains more information on network locations objects and
distributed configurations.
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A global registry is required in your Documentum installation if any of the following
conditions are true:
• You have a custom application that deploys any BOF 5.3 or 5.3 SP1 SBOs
• You plan to install a Documentum application that requires SBOs.

The following Documentum client applications or features use SBOs:

— Business Process Services (BPS)

— Web Services Framework

— Webtop with queue management enabled

— Webtop with the Collaborative Edition enabled

This is a separately-licensed feature for Webtop.

— Webtop with Rich Text Attributes enabled

— Digital Asset Manager with the Collaborative Edition enabled

— Any other WDK application that enables Collaborative Edition
• You use Web clients to access a distributed repository configuration.

Network locations, which must be created in a global registry repository, are
required for determining the correct storage area from which to server content to
Web client end users.

You must make the following decisions during repository configuration:
• Whether the repository will be enabled as a global registry

It is strongly recommended that only one production repository in your installation
is designated as a global registry.

• If yes, the login credentials for the global registry user

This is the user that DFC instances uses to connect to the global registry repository.

If you provide the credentials, the user is created in the current repository in the
active state, and the login credentials can then be provided to DFC installations on
other hosts. If you do not provide the credentials, the user is created in the inactive
state. To enable to repository as a global registry at a later time, use Documentum
Administrator to activate the user and provide login credentials.

• If no, which global registry repository DFC on the current Content Server host will
access

You must then provide the login credentials for the global registry user in that
repository. The global registry repository is not required to be a repository on the
current Content Server host. You may choose any 5.3 SP1 repository that is enabled
as a global registry. The repository may be located on any host.
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If you are installing a remote Content Server for a distributed content environment, you
are not asked for global registry login credentials. DFC on the remote Content Server
host does not require that information.

The global registry user is also discussed in Preparing for the global registry, page 56.

Trusted Content Services

Trusted Content Services (TCS) is an optional Content Server feature that provides
these security features:
• Encrypted filestores
• Electronic signatures on PDF documents

Electronic signatures are not supported on Linux and HP Itanium. (This does not
affect digital signatures on those platforms.)

• Additional access control list (ACL) entries, including required groups, required
group sets, permit restrictions, and extended restrictions

For more information, refer to the Content Server Administrator’s Guide.
• Digital shredding
If you have obtained a license for Trusted Content Services, you can optionally
install TCS when you install or upgrade to Content Server 5.3.x. TCS is enabled on
a per-installation basis. If you enable TCS during server installation, all repositories
created in the installation include TCS. If you do not initially enable TCS, you can run the
server configuration program and enable TCS at a later time.

By default, repositories created with TCS enabled have non-encrypted filestores. The
filestores can then be converted to encrypted filestores. For more information on creating
encrypted filestores, refer to the Content Server Administrator’s Guide.

If you are installing a single-repository distributed configuration, all servers must enable
Trusted Content Services or none must enable Trusted Content Services. Running both
trusted and non-trusted Content Servers against a single repository is not supported.
However, in a repository federation, you can mix trusted and non-trusted repositories.

Content Services for EMC Centera

Content-addressed storage is recommended for use when you want to store massive
amounts of unchanging data, such as email archives or check images. The EMC Centera
content-addressed storage system allows you to store metadata values with each piece
of content in the system. You can also define a retention period for the content. If a
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retention period is defined, the content cannot be removed from the storage system even
if the associated document is removed from the repository.

You can enable Content Services for EMC Centera during server installation. If you do
not, you can run the server configuration program at a later time and enable Content
Services for EMC Centera then.

Content Services for EMC Centera is not supported on the HP Itanium platform.

For more information on creating and using content-addressed storage, refer to the
Content Server Administrator’s Guide.

Content Storage Services

Content Storage Services (CSS) is a feature that automates business rules governing
where content files are stored. Content assignment policies (or assignment policies)
ensure that new content files are stored in the correct file store or content-addressable
store. Migration policies move existing content files to the correct file store or
content-addressable store.

Content Storage Services is enabled during server installation. If you do not enable the
feature, you can run the server configuration at a later time and enable CSS then.

Collaborative Edition

Collaborative Edition is a feature that allows use of a rich-text editor by all users, rich-text
description fields on the Properties dialog box for all folders and folder subtypes, the
creation and use of note objects in the repository, and discussion threads, which can be
embedded in folders, folder subtypes, and notes, with stand-alone discussion threads
available for other documents and objects as well. In addition, Collaborative Edition
has Rooms, which are secure areas within the repository where access is restricted to
a defined membership.

This feature is enabled with a license key during server installation. If it is not enabled
during installation, it can be enabled at a later time using Documentum Administrator.

If Collaborative Edition is enabled in a repository, by default, only 5.3 and later clients
can access that repository. This is because installing Collaborative Edition sets two
attributes on the docbase config object to restrict client access. They are:
• oldest_client_version, which is set to 5.3
• check_client_version, which is set to TRUE
If older client products must access the repository, you must manually set
check_client_version to FALSE or set oldest_client_version to an earlier version.

34 Content Server Installation Guide



Planning for Content Server Installation

The SBOs for Collaborative Edition are installed automatically at repository
configuration, whether or not Collaborative Services is enabled in that particular
repository. If you use Collaborative Services, ensure that any arbitrary 5.3 or later
repository on your network is designated as a global registry and ensure that the DFC
installation on the Webtop application server host is able to connect to that repository
using the global registry user’s credentials.

Retention Policy Services

Retention Policy Services is a compliance-oriented feature that gives you control over
how long and under what circumstances documents and other objects are retained in a
repository and how the objects are disposed of at the end of the retention period. The
feature is enabled with a license key during server installation. If it is not enabled during
installation, it can be enabled at a later time using Documentum Administrator.

If Retention Policy Services is enabled in a repository, by default, only 5.3 and later clients
can access that repository. This is because installing Retention Policy Services sets two
attributes on the docbase config object to restrict client access. They are:
• oldest_client_version, which is set to 5.3
• check_client_version, which is set to TRUE
If older client products must access the repository, you must manually set
check_client_version to FALSE or set oldest_client_version to an earlier version.

Repository name and ID
Each repository must have a unique name and ID. You provide the name and ID during
repository configuration.

The name for a new repository must be no longer than 32 characters. The name must
consist of letters, numbers, and underscores (_). The first character must be a letter. The
repository name cannot include spaces or non-alphanumeric characters and all letters
and numbers in the name must be ASCII characters.

The repository name “docu” is reserved by EMC Documentum.

The repository name is used as the name of the primary Content Server’s server config
object. There is a limitation of 32 characters for the length of the server config object
name, and the string repository_name.server_config_name@host_name, which is part
of the string identifying a repository at connect time, cannot exceed 120 characters in
length or connect requests fail.
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For remote Content Servers in distributed configurations, the name of the server config
object is limited to 25 characters. The name is determined by the remote Content Server
configuration program. The same restrictions apply that apply to a repository name. The
name must consist of letters, numbers, and underscores (_). The first character must be a
letter. The repository name cannot include spaces or non-alphanumeric characters and
all letters and numbers in the name must be ASCII characters.

The repository ID can be any number from 1 to 16777215 and must not start with a zero
(0). It is strong recommended that repository IDs are unique on your network. If two
repositories on your network have the same ID, ensure that they do not project to the
same connection broker.

Internationalization decisions
Content Server runs in the UTF-8 code page. To take full advantage of Content Server’s
multilingual features, you must install on the correct server host code page and set
the code page correctly in the database.

For additional information on how internationalization affects upgrading, refer to
Preparing for a Content Server upgrade, page 57. For complete information on Content
Server internationalization, refer to the “Server Internationalization” chapter of Content
Server Fundamentals.

Server host code page

On Content Server hosts, the following host code pages are supported:
• For U.S. and Western European sites, ISO-8859_1 (Latin-1)
• For Korean sites, EUC-KR
• For Japanese sites using UNIX, EUC-JP
• For Japanese sites using Windows, Shift_JIS

Server host locale

The following server host locales are supported:
• English (en)
• French (fr)
• German (de)
• Korean (ko)
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• Japanese (ja)
• Italian (it)
• Spanish (es)
On Windows hosts, the host locale is set on the Regional Settings dialog box.

On UNIX and Linux hosts, the host locale is set with the LANG environment variable.

Data dictionary locales

Content Server stores information about object types and their attributes in the data
dictionary. During repository configuration, a set of data dictionary information is loaded
into the repository based on the server host locale. If the host locale is English, French,
German, Italian, Spanish, Japanese, or Korean, the data dictionary information for that
locale is loaded. If the host locale is not one of the seven locales, the server defaults to
loading the English data dictionary information.

You can load additional sets of data dictionary information by modifying the
data_dictionary.ini file. Note that installing additional data dictionary information can
affect server performance, and also that EMC Documentum only supports the seven
languages that are shipped with Content Server. For information on loading additional
data dictionary information, refer to Appendix D, “Populating and Publishing the Data
Dictionary,” in the Content Server Administrator’s Guide.

Database code page

For new repositories, install the database using the Unicode code page, which can
accurately store characters from all supported languages.
• On Oracle, Sybase, and DB2, use UTF-8
• On SQL Server, you can use any collation (SQL Server’s name for code page), because

this only determines the code page of varchar and char types.

For SQL Server repositories version 5.1 and later, Content Server uses only nvarchar
and nchar types, which automatically use Unicode.

Documentum supports upgrading existing repositories that use a database code page
other than UTF-8.

On Oracle and Sybase, migrating existing repositories to Unicode using the tools
supplied by Oracle and Sybase is supported.

On DB2, all repositories should have been created using Unicode. They do not need
to be migrated. If your DB2 repository does not use Unicode, migrate the database
using IBM’s tools.
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On SQL Server, migrating the database to Unicode is not supported.

Planning for a Content Server upgrade
You can upgrade to Content Server 5.3.SP1 only from Server 5.2.5x or 5.3.

If you are running an earlier version of Content Server, you must upgrade to 5.2.5x
before upgrading to 5.3 SP1. Refer to the documentation for Server 5.2.5x for information
on upgrading to that Server version.

Depending on the EMC Documentum Server release from which you are upgrading, you
may need to upgrade the operating system or database. For information on upgrading
those components of your system, refer to the documentation provided by the operating
system or database vendor.

Each step in the upgrade process must be to a platform that is fully supported by EMC
Documentum. After each upgrade step, we strongly recommend testing the repository
to ensure that all functions are normal.

For complete information on supported upgrade paths and the order in which you must
upgrade the components of your system, refer to Supported upgrade paths, page 58.

Content Server 5.3 and 5.3 SP1 use a new implementation of full-text indexing. If you
are upgrading from a Content Server version earlier than 5.3, new indexes must be
created before or after Content Server is upgraded. Before upgrading, ensure that you
review Preparing for a Content Server upgrade, page 57 and the Content Server Full-Text
Indexing Installation Guide.

Planning to upgrade a server installation

AWindows host can have only one Content Server software installation, from which you
can create multiple repositories. When you upgrade the installation, you must upgrade
all of the repositories in that installation.

A UNIX host can have more than one Content Server installation and you can create
multiple repositories from each installation. You can upgrade each installation at
a different time. When you upgrade the installation, you must upgrade all of the
repositories in that installation.
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Change for Tomcat application server startup on UNIX

This section applies to your installation if you have user-defined server methods that rely
on native code libraries.

When Tomcat application server is started on a UNIX platform, it now passes the
following to Java:
-Djava.libary.path=$DOCUMENTUM_SHARED/dfc

This change means that any user-defined value in:
• LIBPATH on AIX
• SHLIB_PATH on HP-UX
• LD_LIBRARY_PATH on Solaris or Linux
will not be used Tomcat for Java methods or by the ACS server. If you require
that directories other than $DOCUMENTUM_SHARED/dfc be searched
when loading native code shared libraries, it is now necessary to edit the file
$DM_HOME/tomcat/bin/setenv.sh.
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Chapter 3
Preparing for Content Server
Installation

Use the information in this chapter to prepare the network and hosts for Content Server installation.
Chapter 4, Preparing the Database for Content Server Installation contains additional information for
preparing the database installation for Content Server. If you are configuring full-text indexing for a
repository, review the Content Server Full-Text Indexing Installation Guide.

This chapter contains the following information:
• Windows host preparation, page 41 discusses configuring a Windows host and creating the

correct user accounts for Content Server installation
• UNIX and Linux host preparation, page 48 discusses configuring a UNIX host and creating the

correct environment variables and user accounts for Content Server installation
• Preparing for the global registry, page 56
• Preparing for a Content Server upgrade, page 57 discusses special preparations that must be made

before upgrading Content Server

Windows host preparation
If you are running Content Server on a Windows host, you must make some
configuration changes in Windows itself and you must ensure that the correct accounts
are set up before you install the server. This section includes the following topics:
• Setting the PATH environment variable, page 42
• Running WDK applications on the Content Server host, page 42
• Restricted characters, page 43
• Regional settings, page 43
• Authentication domains on Windows 2000, page 44
• Distributed configurations and UTC time, page 44
• Setting up the installation owner account, page 44
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• Setting up the repository owner account, page 46
• Setting up repository user accounts, page 47

Setting the PATH environment variable

On Windows hosts, you must manually add the path to Java to the PATH system
environment variable. If this is not set correctly, custom Java methods executed by the
Java method server and the LDAP and federation jobs do not run correctly on the host.

During Content Server installation, you are asked for a DFC installation directory.
This is typically Drive:\Program Files\Documentum. Installing DFC also
installs the JDK. The full path to the Java installation is typically Drive:\Program
Files\Documentum\jdk\version_number\bin, and that is the value to add to the PATH
system environment value.

To modify the PATH environment variable:

1. Right-clickMy Computer.

2. Select the Advanced tab.

3. Click Environment Variables.

4. In the System Variables section, select PATH and click Edit.

5. Add the value DFC_install_location\java_version\bin to the path and click
Ok, where java_version is the Java version support for the Content Server version
you are installing.
The DFC installation location is set during server installation. It is typically
Drive:\Program Files\Documentum.

6. Click Ok and close the System Properties dialog box.

Running WDK applications on the Content Server host

EMC Documentum Web Development Kit and applications built with WDK (such as
Documentum Administrator) are run with an application server. If you install WDK or a
WDK application on the Content Server host, install and run the application server using
an account that is not an EMC Documentum user. This creates security risks because of
trusted login. For more information, refer to theWDK and Applications Installation Guide.
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Restricted characters

The name of the directory in which Content Server is installed must contain only ASCII
characters. Additionally, do not use the following characters in path names accessed
by EMC Documentum product installers:

! \ / : * ? " < > |

Do not use spaces in the name of the product installation directory. For example, do
not use c:\Documentum Products\ or /Documentum Products as the name of the
installation directory.

Regional settings

Before you install a repository, the Windows Regional Settings must be set to specify a
four-digit date.

To specify a four-digit date:

1. Choose Start →Settings→ Control Panel.

2. Double-click Regional Options.

3. Click the Date tab.

4. Select a date style that includes a four-digit year from the dropdown list.

5. Click OK.

SMTP server on Windows

OnWindows hosts, Content Server must be able to connect to an SMTP mail server. The
SMTP server can be an SMTP server located on your network or it can be the SMTP
server provided with Windows 2000. During the installation or upgrade procedure, you
must provide the name or IP address of the computer hosting the SMTP server.

If a valid SMTP server host name is not available during installation, supply an invalid
host name and the installation will finish. Do not leave the field blank. After installation,
add a valid SMTP server host name to the smtp_server attribute of the server config
object. Reinitialize the server after you update the server config object.
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Authentication domains on Windows 2000

On Windows 2000, if you want to authenticate users in a domain other than the host on
which Content Server is installed, the Computer Browser Service must be enabled.

To enable the Computer Browser Service:

1. Click Start→Programs→Administrative Tools→Services.

2. Scroll to Computer Browser Service.

3. If the Computer Browser Service is not running, click Start.

4. Close the Services dialog box.

Distributed congurations and UTC time

If you install a distributed configuration, ensure that all host computers in the
configuration are set to the same UTC time.

Setting up the installation owner account

The installation owner is the user whose account is used to install the Server and create
a repository. The server runs under the installation owner’s account. The installation
owner must have an operating system account. The installation owner account must be
set up before the server software is installed.

When full-text indexing is implemented, the index agent and index server must be
installed using the same installation owner account as the Content Server installation
owner.

The installation owner’s user name must consist of letters, numbers, dashes (-) and
underscores (_). The first character must be a letter. All characters must be ASCII
characters.

The installation owner’s password must consist of letters, numbers, dashes, underscores,
and periods.

On Windows, user accounts are not case-sensitive, but Content Server installation fails if
you connect to the host using the incorrect case in the user name. For example, if the
account is set up as JPSmith and you connect as jpsmith, you can log in to the host, but
server installation fails.
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The installation owner must have Full Control permission on the installation directory.
The installation owner must also have write permission on the directory from which
the installer is run.

On Windows, you can create only one server software installation on a host computer.
You can create multiple repositories from the software installation.

All administrative or maintenance tasks associated with the installation or the repository
can be performed by the installation owner. After a repository is created, the installation
owner can create additional repository accounts with Superuser or System Administrator
privileges, and those accounts can also be used for repository administration. There is
one important postinstallation task that must be performed with regard to the installation
owner. For more information, refer to Enabling the Purge Audit job, page 138.

You can create an operating system account to use exclusively for server installation and
repository maintenance. A single operating system account can be used as installation
owner for multiple Documentum installations on your network.

The installation owner can have a local or domain account, provided the account is a
member of the local machine’s administrator group. However, the installation owner
account must not be the same account as the Windows Administrator. The installation
owner account may be a local account on the Content Server host or a domain account in
the domain where Content Server is installed.

Ensure that the installation owner has an email account on the SMTP mail server.

The installation owner must have the following user rights:
• Act as part of the operating system
• Create a token object
• Increase quotas
• Log on as a service
• Log on locally
• Replace a process-level token
On a standard Windows system, these rights are automatically inherited with
membership in the local Administrators group. The Setup program checks for these
rights and grants them if necessary.

The installation owner in SQL Server repositories

If SQL Server is installed in a different domain from Content Server, the Documentum
installation owner must be a valid user in the remote domain.

Depending on the type of authentication SQL Server uses, the installation owner
requirements are different:
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• If SQL Server uses Windows authentication, the installation owner must have system
administrator privileges in SQL Server.

• If SQL Server uses SQL Server or mixed authentication, the installation owner does
not need system administrator privileges in SQL Server.

Setting up the repository owner account

The repository owner is the user whose account is used to connect to the database. The
repository owner owns all objects in the database. Each repository must have a unique
repository owner.

The repository owner’s user name must consist of letters, numbers, dashes (-) and
underscores (_). The first character must be a letter. All characters must be ASCII
characters.

The repository owner’s password must consist of letters, numbers, dashes, underscores,
and periods.

During server installation, you can designate an existing database account for database
access. If you designate an existing account to use for database access, that user becomes
the repository owner.

Alternatively, the Setup program can create a database user during installation. The new
user then becomes the repository owner. If the Setup program creates the database user,
the database user’s name defaults to the name of the repository (but you may change
this during installation).

The repository owner’s RDBMS user account must have the following privileges:
• Connect to the database
• Create tables, views, and indexes in the database
• Insert records (rows) into tables
• Drop tables, views, and indexes
If you allow the Content Server Setup program to create a database account for
the repository owner, the proper privileges are granted to the repository owner
automatically.

If you create the account before running the installer, give the account these privileges:
• On Oracle, the repository owner must have CONNECT and RESOURCE privileges.
• On DB2, GRANT use of tablespaces, list tablespace, and connect to database

privileges.

On DB2, the repository owner does not have an account in DB2. The repository
owner is created when you GRANT the required privileges to an existing operating
system account.
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• On SQL Server, the repository owner must be able to access tempdb, and if the
account is created before running the installer, the user must own all tables and
views.

Whether the repository owner needs a Windows account depends on the features and
database you use:
• To use Microsoft Cluster Services, the repository owner must have an account in the

domain in which you install the repository.
• To add users and groups to a repository, the repository owner must have an account

in the same domain as the installation owner.
• To use replication, the repository owner must have an operating system or domain

account.

If the repository owner does not have such an account, Content Server functions
correctly except that you cannot use replication, and at Content Server startup, you
see the following error message in the server log:
Tue Feb 28 21:23:16 2006[DM_STARTUP_I_DOCBASE_OWNER_NOT_FOUND]:
The database user (pfieldnet_dev) is not a valid NT User.
This is the user specificed in your server.ini file as the database_owner
attribute. If you are running the optional Replication Services package
you will need to create a valid NT User account for this user.

• Under DB2, the repository owner must be a valid Windows user on the host where
the database is installed.

• Under Oracle, the repository owner does not need to have an operating system
account.

• If you set up the ODBC data source for SQL Server to require Windows
authentication, the repository owner must have an operating system account. If
you use SQL Server authentication, the repository owner is not required to have
an operating system account.

In general, we recommend that you set up a Windows account for the repository owner.

Setting up repository user accounts

Repository users are the end users in the repository. These users may own documents or
other objects that are stored in a repository, but they have no particular responsibilities
for the maintenance of either the repository or the installation.

On Windows, if the default user authentication is used, each user must have a Windows
account in the domain where Content Server is installed. If LDAP authentication or
inline password authentication is used, this is not a requirement.

Content Server Installation Guide 47



Preparing for Content Server Installation

UNIX and Linux host preparation
If you are running Content Server n UNIX or Linux, you must create the installation
owner’s account and set variables in the installation owner’s environment before you
install. You must also create two groups and ensure that the shared C library is available.

This section covers these topics, which include requirements in addition to configuring
the installation owner’s environment correctly:
• Running WDK applications on the Content Server host, page 48
• Restricted characters, page 48
• XWindows requirement, page 49
• Installing remotely, page 49
• Performing the root task, page 49
• The /var/tmp directory, page 50
• Setting up the installation directories, page 50
• Shared memory and semaphore requirements, page 51
• Default operating system permissions on directories and files, page 51
• Distributed configurations and UTC time, page 51
• Required Groups, page 51
• Required individual accounts, page 52
• Setting up the services file, page 55

Restricted characters

Do not use the following characters in path names accessed by Documentum product
installers:

! \ / : * ? " < > |

Do not use spaces in the name of the Documentum installation directory. For example,
do not use c:\Documentum Products\ or /Documentum Products as the name of the
installation directory.

Running WDK applications on the Content Server host

EMC Documentum Web Development Kit and Documentum applications built with
WDK (such as Documentum Administrator) are run with an application server. If you
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install WDK or a WDK application on the Content Server host, install and run the
application server using an account that is not a Documentum user.

XWindows requirement

XWindows must be installed on the UNIX host to run the graphical installer and the
xterm program must be in the Documentum installation owner’s path. The xterm
program may be installed in various locations depending on your operating system and
software packages installed. Some typical locations are:
• On Solaris, /usr/openwin/bin
• On HP-UX and AIX, /usr/bin/X11
Verify that the xterm program is in one of the above paths or in an alternate location and
add that location to the PATH variable.

You can install remotely using Exceed; however, note the restriction in the next section.

Installing remotely

Displaying the installer remotely across platforms is not supported. For example,
remotely displaying from Solaris to Solaris usually works, but Solaris to an HP XServer
or Exceed is not supported.

Performing the root task

At the end of installation you have the option of logging in as root and executing the
dm_root_task script or allowing the installer to execute the dm_root_task script. This
sets the correct file permissions on the dm_check_password and dm_change_password
programs, which are required for user authentication. If you allow the installer to
perform the task, xterm must be in the installation owner’s path. If xterm is not in the
installation owner’s path, you must log in as the root user and run the dm_root_task
manually after installation. For instructions on running dm_root_task, refer to Running
dm_root_task manually on UNIX or Linux systems, page 134.
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The /var/tmp directory

You must have at least 300 megabytes available in the /var/tmp directory to install
Content Server.

The installation owner’s account must have read, write, and execute permission on
the /var/tmp directory.

Setting up the installation directories

Before you install Documentum on a UNIX system, you must determine the directories
in which Content Server will be installed and then set two environment variables in
the installation owner’s environment. You can create the installation directories before
installing the server or you can allow the server installation program to create the
directories from your input. If you allow the server installation program to create the
directories, ensure that the directories you provide during installation match those in the
environment variables.

The environment variables and installation directories must contain only ASCII
characters. The name of the Documentum installation directory must not contain spaces.
• $DOCUMENTUM

This environment variable corresponds to the directory where you are installing
Documentum.

The installation owner must have read, write, and execute permission on the
$DOCUMENTUM directory and its subdirectories.

• $DM_HOME

This is the $DOCUMENTUM/product/version_number directory.

For version_number, substitute the actual version of the software.

For example:

$DOCUMENTUM/product/5.3

If you are upgrading from Content Server 5.2.5, you must create a new $DM_HOME
directory and reset the value of the environment variable. Create a new directory
$DOCUMENTUM/product/5.3 and set $DM_HOME to that directory before you
start the upgrade process. If you are upgrading from Content Server 5.3, do not
create a new $DM_HOME.

Refer to the Content Server Release Notes for the product version.
Refer to Setting up the installation owner account, page 52 for information on defining
$DOCUMENTUM and $DM_HOME in the installation owner’s account.
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Default operating system permissions on directories
and les

When Content Server creates directories and files in the server installation, it assigns
default operating system permissions to those directories and files. The default
permissions assigned to directories are 777 and the default permissions assigned to files
are 666. You can change the defaults assigned to public directories and files by setting
the umask key in the server.ini file. Setting umask affects all public directories and
files created after the key is set.

The umask key works similarly to the UNIX umask functionality. The value is subtracted
from the default permissions to determine the actual permissions assigned to a file or
directory. For example, if you set umask=2, then the default permissions assigned to
directories becomes 775 and the default permissions for files becomes 662. Or, if you set
umask=20, then the permissions become 757 for directories and 626 for files.

If you want to change the default permissions for all files and directories, you must
modify the server.ini file before Content Server starts. Choose Custom repository
configuration, then modify the server.ini file by adding the umask key and a value.

Distributed congurations and UTC time

If you install a distributed configuration, ensure that all host computers in the
configuration are set to the same UTC time.

Shared memory and semaphore requirements

Content Server’s shared memory and semaphore requirements are as follows:
• Configure the host with at least two megabytes of shared memory for Content Server.
• Content Server uses a semaphore.

Ensure that semaphores are enabled on the host.

Required Groups

This section describes the UNIX groups necessary to install Content Server.

On UNIX and Linux, every Content Server installation must have group and user
accounts for the installation owner, repository owner, and repository users. The
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installation owner group and individual accounts must be set up before the Content
Server software is installed. The repository owner (database user) account may be set
up in the database before the software is installed or during repository configuration.
Repository users are created after the repository is created.

The installation owner group

To support external password validation, set up a group account whose members are the
installation owner, any other Content Server administrators, and repository owners. This
will be the group that owns the external password validation program.

Required individual accounts

Every Content Server installation must have an installation owner and each repository
must have a repository owner. Each repository has repository users.

The individual responsibilities of the installation owner, repository owner, and
repositories users are described in the following sections.

Setting up the installation owner account

The installation owner is the user whose account is used to install the Server and create
a repository. The server runs under the installation owner’s account. The installation
owner account must be set up before the server software is installed.

When full-text indexing is implemented, install the index agent and index server as the
same user as the Content Server installation owner.

The installation owner must have an operating system account. The installation owner’s
user name must consist of letters, numbers, dashes (-) and underscores (_). The first
character must be a letter. All characters must be ASCII characters.

The installation owner’s password must consist of letters, numbers, dashes, underscores,
and periods.

The installation owner’s account must have read, write, and execute permission on
the /var/tmp directory and on the installation directory ($DOCUMENTUM and its
subdirectories). The installation owner must also have write permission on the directory
from which the installer is run.

Do not use the root account as the installation owner account.
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All administrative or maintenance tasks associated with the installation or the repository
can be performed by the installation owner. After a repository is created, the installation
owner can create additional repository accounts with Superuser or System Administrator
privileges, and those accounts can also be used for repository administration. There is
one important postinstallation task that must be performed with regard to the installation
owner. For more information, refer to Enabling the Purge Audit job, page 138.

You can create an operating system account to use exclusively for server installation
and repository maintenance. A single user account can be used as installation owner
for multiple Documentum installations on your network.

On UNIX and Linux, you can create multiple server installations on a single host
computer. You can have separate installation owners for each installation or you can
use separate environment files to enable a single installation owner to own all of the
installations.

Ensure that the installation owner has an email account on the SMTP mail server.

The server configuration program is started with the dm_launch_server_config_
program.sh script, which adds required values to the following environment variables:
• PATH
• CLASSPATH
• JAVA_HOME
• On Solaris and Linux, LD_LIBRARY_PATH
• On HP-UX, SHLIB_PATH
• On AIX, LIBPATH
The script also sets required database environment variables.

If you do not use the dm_launch_server_config_program.sh script, you must manually
set the environment variables below and the environment variables discussed in
Appendix B, Required Environment Variables on UNIX and Linux Hosts.

The following table details the environment variables that you must set manually in the
installation owner’s environment before you install Content Server:

Table 3-1. Required environment variables

Environment Variable Description Required Values

DOCUMENTUM The directory in which
Content Server is installed

Any directory in the
installation owner’s
environment

DM_HOME The directory that contains
the link to the directory
containing the executables.

$DOCUMENTUM/
product/version_number
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Environment Variable Description Required Values

DOCUMENTUM_
SHARED

The directory in which
DFC is installed

Any directory in the
installation owner’s
environment

DISPLAY Controls the display
localhost:0.0

LC_ALL C

Set these variables in the installation owner’s .cshrc file (C shell) or .profile file (Bourne or
Korn shells). Alternatively, set the variables in a file called by the .cshrc file or .profile file
or in other fashions permitted by UNIX.

You must also set any environment variables required by the database. For information
on these environment variables, refer to Chapter 4, Preparing the Database for Content
Server Installation and to the documentation for your RDBMS.

Setting up the repository owner account

The repository owner is the user whose account is used to connect to the database. The
repository owner owns all objects in the database. Each repository must have a unique
repository owner.

The repository owner’s user name must consist of letters, numbers, dashes (-) and
underscores (_). The first character must be a letter. All characters must be ASCII
characters.

The repository owner’s password must consist of letters, numbers, dashes, underscores,
and periods.

During server installation, you can designate an existing database account for database
access. If you designate an existing account to use for database access, that user becomes
the repository owner.

Alternatively, the Setup program can create a database user during installation. The new
user then becomes the repository owner. If the Setup program creates the database user,
the database user’s name defaults to the name of the repository.

The repository owner’s RDBMS user account must have the following privileges:
• Connect to the database
• Create tables, views, and indexes in the database
• Insert records (rows) into tables
• Drop tables, views, and indexes
• On Oracle, unlimited tablespace
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If you allow the Content Server installation program to create a database account
for the repository owner, the proper privileges are granted to the repository owner
automatically.

If you are creating the account before you run the installer, give the following privileges
to the account:
• On Oracle, CONNECT and RESOURCE privileges
• On Sybase, the database owner must be the repository owner (Documentum

database user)
• On DB2, GRANT use of tablespaces, list tablespace, and connect to database

On DB2, the repository owner must have an operating system account.
To use replication, the repository owner must have an operating system account. If the
repository owner does not have such an account, Content Server functions correctly
except that you cannot use replication, and at Content Server startup, you see the
following error message in the server log:
Tue Feb 28 21:23:16 2006[DM_STARTUP_I_DOCBASE_OWNER_NOT_FOUND]:
The database user (pfieldnet_dev) is not a valid NT User.
This is the user specificed in your server.ini file as the database_owner
attribute. If you are running the optional Replication Services package
you will need to create a valid NT User account for this user.

Repository users

Repository users are the end users in the repository. These users may own documents or
other objects that are stored in a repository, but they have no particular responsibilities
for the maintenance of either the repository or the installation.

On UNIX and Linux, end users who want to execute a program whose executable is
found in $DM_HOME/bin must have $DM_HOME/bin in their path. For example,
application developers who are writing and testing Docbasic procedures need to have
$DM_HOME/bin in their paths.

Setting up the services le

The services file contains information on the port numbers used by the services or
processes running on a host. The services file must contain two entries for each
repository running on a host. On UNIX and Linux, you must manually create the service
name entries in the services file before you install the server.

The service name entries are made in the /etc/services file or NIS services map for each
repository running on the host. You must have root privileges to edit the /etc/services file.
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The repository does not have default service names or default port numbers. The service
name you put in the services file must be the same name you provide during repository
configuration, which is then used to create the server.ini file. The service name for the
repository can be the same as the repository name, but this is not required.

The services file must include entries designating two consecutive port numbers for use
by Content Server, one for native connections and one for secure (SSL) connections.
You must append _s to the name of the repository service for the secure connections.
Repository service names ending with _s are reserved for secure connections.

Create the service name entries using the following format:
service_name port_number/tcp #Comment here,if desired
service_name_s port_number/tcp #Comment here,if desired

If NIS is running, the local services file (/etc/services) is ignored. Place the entries in
the NIS services map. Use the ypwhich command to identify the hostname of the NIS
master server, if there is one.

The port numbers can be any unused port numbers greater than 1024 (UNIX reserves
port numbers up to 1024 for system use). For example, if the repository service were
named lime, the services file entries might be:
lime 1497/tcp # 5.3 Repository native connection
lime_s 1498/tcp # 5.3 Repository secure connection

If the correct services file entries are not present, the installer stops.

If you have multiple repositories on a single machine, create a services file entry for each
repository, ensuring that the repositories have different names and port numbers.

Preparing for the global registry
During repository configuration, you are asked to make the following choice:
• Use the current repository as a global registry

You must then provide the user login name and password for the global registry user
in the current repository (the repository you are currently configuring). Record that
information and provide the user login name and password to any DFC instance
requiring access to this global registry repository. The DFC instance on the current
host is also configured to access this global registry.

• Specify a different repository as a global registry

You must provide the repository name, and the login credentials (user login name
and password) of the global registry user in that repository. The DFC instance on the
current host is configured to access the remote global registry repository.

• Do later
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If you choose this option, you can delete the dfc.bof.registry.repository,
dfc.bof.registry.username, and dfc.bof.registry.password from the dfc.properties file
and re-run the DFC installer on this host in order to designate the global registry
repository at a later time.

Whether or not you designate the repository as a global registry, the global registry
user is created in the repository.

The global registry user, who has the user name of dm_bof_registry, is the repository
user whose account is used by DFC clients to connect to the repository to access required
service-based objects or network locations stored in the global registry. This user has
Read access to objects in the /System/Modules and /System/NetworkLocations only,
and no other objects.

This user is created in all repositories, regardless of whether the repository is configured
as a global registry:
• If you configure the repository as a global registry, you provide the user login name

and password for the user and the user state is set to Active.

This can be any arbitrary user login name and password. Record the user login
name and password, and provide the user login name and password during DFC
installation on client hosts. Do not use the repository owner’s credentials or the
installation owner’s credentials.

• If you do not configure the repository as a global registry, the user is created with a
default value for the user login name and the user state is set to Inactive.

If you later enable the repository as a global registry, use DocumentumAdministrator
to change the user state to Active and provide the user with a user login name and
password that you choose. Refer to Enabling a repository as a global registry, page
132 for instructions on enabling the repository as a global registry.

Preparing for a Content Server upgrade
This section discusses preparations for a server upgrade on both Windows, UNIX, and
Linux. This section contains information on the following topics:
• Supported upgrade paths, page 58
• Upgrading full-text indexes, page 60
• Backing up the repository, page 60
• Backing up formats, page 60
• Upgrading distributed configurations, page 60
• Apache Tomcat and the Java Method Server, page 61
• Documentum Foundation Classes on Windows hosts, page 62
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• Documentum Foundation Classes on UNIX and Linux hosts, page 62
• Migrating the database to UTF–8, page 62
• Running the consistency checker, page 63
• Upgrading older repositories, page 63
• The database_refresh_interval key, page 64
• Creating a repository copy to test an upgrade, page 64

Supported upgrade paths

This section contains information on the upgrade paths supported by Documentum and
the order in which you must upgrade the components of your system. On all platforms,
you can upgrade to Content Server 5.3 SP1 only from Content Server 5.2.5, including 5.2.5
Service Pack releases, or Content Server 5.3. Review the release notes for Content Server
5.3 SP1for complete information on supported operating system and database platforms.

For additional planning information, refer to Planning for a Content Server upgrade,
page 38.

Windows with Oracle

If you are on Windows with Oracle 9.2, you can upgrade Content Server directly, and
then optionally upgrade to Oracle 10g. If you are on Oracle 8.1.7, you must upgrade
Oracle to 9.2 before upgrading the server.

Windows with SQL Server

If you are on Windows with SQL Server, you can upgrade Content Server directly.

Windows with DB2

If you are on Windows with DB2 8.1, you can upgrade Content Server directly. If you are
on DB2 7.2, you must upgrade DB2 to 8.1, then upgrade Content Server.
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Solaris with Oracle

If you are on Solaris with Oracle 9.2, you can upgrade Content Server directly, and then
optionally upgrade to Oracle 10g. If you are on Oracle 8.1.7, you must upgrade Oracle to
9.2 before upgrading the server.

Solaris with Sybase

If you are on Solaris with Sybase, you can upgrade Content Server directly.

AIX with Oracle

If you are on AIX with Oracle 9.2, you can upgrade Content Server directly, and then
optionally upgrade to Oracle 10g. If you are on Oracle 8.1.7, you must upgrade Oracle to
9.2 before upgrading the server.

If you are on AIX 5.1, you must upgrade to AIX 5.2 before upgrading to Content Server
5.3 SP1.

AIX with DB2

If you are on AIX 5.2 with DB2 8.1, you can upgrade Content Server directly. If you
are on AIX 5.1 or DB2 7.2, you must upgrade AIX to 5.2 and DB2 to 8.1, then upgrade
Content Server.

If you are on Content Server 5.2.5 or any 5.2.5 Service Pack version of the server and the
database is DB2 8.1.5, use the following upgrade order:

1. Upgrade Content Server to 5.3 SP1.

2. Upgrade DB2 to version 8.1 FixPak 7a.

HP-UX with Oracle

If you are on HP-UX with Oracle 8.1.7, you must first upgrade Oracle to 9.2, then upgrade
Content Server to 5.3 SP1. You can then optionally upgrade to Oracle 10g.
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Upgrading full-text indexes

Content Server 5.3 SP1 has a new implementation of full-text indexing. Existing Verity
indexes do not work with Content Server 5.3 and later and must be replaced before
or after upgrading Content Server with new indexes. For complete information on
planning for and creating new full-text indexes, refer to the Content Server Full-Text
Indexing Installation Guide .

Backing up the repository

Before upgrading a repository, back it up. Several third-party tools are available for
creating repository backups. Please note that Documentum Technical Support does not
provide assistance with backups.

Backing up formats

repository formats (dm_format objects) are upgraded by the dm_apply_formats.ebs
script, which reads values from the formats.csv file. If the attributes of a format in
the repository do not match the format descriptions in the formats.csv file, the script
overwrites the existing values with the values in the file.

Caution: If your repository contains customized formats, back up the customizations
before you upgrade the repository.

Upgrading distributed congurations

Use these guidelines in deciding how to upgrade a distributed configuration.
• Repository federations

Documentum supports federations that contain repositories of different versions. In
this release, any mix of 5.1 and later repositories may be federation members. If you
are upgrading the repositories in a federation, upgrade the governing repository first.

If the governing repository is a 5.3 or 5.3 SP1 repository, keep in mind the following
caveats:

— Prior releases do not support dynamic groups. Consequently, any dynamic
groups defined in the governing repository are propagated to any pre-5.3
members as standard, non-dynamic groups.
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— Similarly, prior releases do not support access restricting (AccessRestriction,
ExtentendRestriction) entries in ACLs. If the federation’s federation mode is
replicating ACLs with those kinds of entries to pre-5.3 member repositories, the
entries are ignored by pre-5.3 Content Servers.

— The restricted_folder_ids attribute for users (introduced in release 5.3) is a local
attribute. This means that any restricted users in the governing repository are
propagated as unrestricted users in the member repositories. (If the member is a
5.3 or 5.3 SP1 repository, you can set that attribute locally if desired.)

• Repositories with distributed content

Shut down the primary server and all content file servers. Upgrade the primary
server first, then upgrade the content-file servers.

The new cfsConfig program, which is used for creating remote Content Servers,
cannot be used to upgrade pre-5.3 SP1 content-file servers. Refer to Upgrading
a distributed configuration, page 120 for instructions on upgrading content-file
servers to 5.3 SP1.

• Repositories with object replication

Upgrade the source repository, then the target repositories. If you have a group
of repositories where each repository is both a source and a target – for example,
objects are replicated repository A to repository B, repository B to repository C, and
repository C to repository A – then upgrading can begin with any of the repositories.

You can run replication between repositories that use different server versions, but
you lose attributes that are in the newer version, since they cannot be replicated to
a version that does not contain them. Content Server 5.3 SP1 supports replication
among server versions 5.1 and later only.

If you are upgrading a distributed configuration on Windows, do not reboot the remote
hosts using Terminal Services. Reboot the remote hosts directly from those hosts.

Apache Tomcat and the Java Method Server

Apache Tomcat, installed with Content Server, is required by EMC Documentum
Content Server. It supports a variety of features and licenses in the server. Use of an
alternative application server, instead of Apache Tomcat, is not supported.

Content Server can optionally use Apache Tomcat for running Java methods.

When you upgrade Content Server, if there is already a Tomcat instance or another
application server on the server host, stop the application server before you start the
upgrade. If you are installing a new Content Server, the Java method server is installed
by default. It requires two ports.
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The installed Tomcat instance is used by the Java method server and the ACS server.
Do not use the installed Tomcat instance for any other purpose, including running
Documentum WDK applications or Documentum Business Process Services.

Documentum Foundation Classes on Windows hosts

The Documentum Foundation Classes are upgraded in place on Windows hosts.

On Windows, you have the option of installing a Microsoft installer package for the
DFC primary interop assembly. Refer to the DFC release notes for more information on
the PIA.

Documentum Foundation Classes on UNIX and Linux
hosts

On UNIX and Linux hosts, if you are upgrading from Content Server 5.2.5, including
Service Pack releases, create new directories for DFC 5.3 SP1 and ensure that the DFC
environment variables point to these directories. If you are upgrading from Content
Server 5.3, you do not need to create a new DFC directory. For more information, refer to
the DFC release notes and UNIX and Linux host preparation, page 48.

Migrating the database to UTF–8

If your database was installed with a code page other than UTF-8 under a previous
Content Server version, you do not have to migrate the database to UTF-8 in order to
upgrade your Content Server version. However, to use Content Server’s multilingual
functions, you must migrate the database to UTF-8.

For upgrades, Documentum supports upgrading repositories using the existing database
code page.

On Oracle and Sybase, you can migrate existing repositories to Unicode using the tools
supplied by Oracle and Sybase. Contact Oracle or Sybase for any support you require in
migrating the database.

On DB2, all repositories should have been created using Unicode. They do not need to
be migrated. If your DB2 repository does not use Unicode, migrate the database using
IBM’s tools. Contact IBM for any support you require.

On SQL Server, you cannot migrate the database to Unicode.
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Running the consistency checker

Before you upgrade, run the repository consistency checker on each existing repository.
The consistency checker is a script that looks for repository inconsistencies, such as users
with nonexistent groups, permissions sets with nonexistent users, and sysobjects that
point to nonexistent content files. Fixing inconsistencies in the repository improves the
quality of the data in the repository and results in a smoother upgrade.

The consistency checker is packaged with the server installation files. After you
uncompress the server distribution file, the consistency checker script is in the same
directory as the other installation files. The file is called consistency_checker.ebs.

After you run the consistency checker, fix any inconsistencies reported as ERROR.

To run the consistency checker:

1. Uncompress the server distribution file.

2. Run the consistency checker:
dmbasic -fconsistency_checker.ebs -eEntry_Point --
repository_name superuser password
where repository_name is the name of the repository against which you are running
the consistency checker, superuser is the user name of a repository superuser, and
password is the password for the superuser’s account.
The results of the consistency checker are directed to standard output.

3. Fix the inconsistencies reported by the consistency checker as ERRORs.
For complete information on the consistency checker, refer to the Appendix entitled
Consistency Checks in the Documentum Content Server Administrator’s Guide.

Upgrading older repositories

If a repository was originally created prior to version 4.0 (and has consequently been
upgraded from the pre-4.0 server version), the database tables contain columns called
column_name_id_i (for example, r_object_id_i). These columns correspond to attributes
that are not used by Content Server. By design, the upgrade to version 4.0.x did not
remove the columns, which remain in the database tables. Do not register these tables
and do not create applications that directly access the columns.
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The database_refresh_interval key

During server installation or upgrade, the change checker process runs once per minute
by default. The process updates type caches as types are created or altered. Before you
upgrade, ensure that the key is set to 1 minute or remove it from the server.ini file.

Creating a repository copy to test an upgrade

Before upgrading a repository, create an environment in which to test the upgrade
process. To do this, create a new installation using the original server software version,
copy the repository, and upgrade that copy. After the upgraded copy is tested, upgrade
the original repository.

Use the instructions for creating a repository copy on the same platform as the original
repository. The procedure is not supported for moving a repository from one platform to
another.

It is not required that you copy the content files from the production repository to the
repository copy. However, if you want to test operations involving the content files, you
must copy the content files to the repository copy.

You cannot create copies of more than one repository in a single new installation if the
repositories were created in different installations.

If you are creating a repository copy to test the upgrade, and the production and copy
repositories have the same database owner password, you must copy the dbpasswd.txt
file from the production repository installation to the repository copy installation or
the copy repository will not start.

For example, if you are copying two repositories, Paris and London, that were created
in separate server installations, you must copy them to separate server installations.
Creating a repository copy requires you to copy the aek.key file from the original
repository host to the repository copy host, because each repository copy must have
access to the aek.key file from its original installation. You cannot have more than one
aek.key file in an installation.

If you are copying two repositories, Tokyo and Beijing, that were created in the same
server installation, you can create their copies in the same new installation, with the
aek.key file from the original installation copied to the installation where you create
the copies.

Before you create the repository copy, complete these tasks:
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Table 3-2. Precopying tasks

Task For More
Information

Your Value/Completed?

Decide whether to copy the
content files

Obtain the repository name Consult the
repository
administrator

Obtain the repository ID from
the server.ini file

Consult the
repository
administrator

Obtain the repository owner’s
name and password

Consult the
repository
administrator

Create a database instance
separate from the database
instance used by the production
repository

Consult the DBA.

Obtain connection information
for the alternative database
instance

The DBA and
documentation for
the database

Identify a target host computer
on which to create the
repository copy

Obtain the system or
administrator user name
and password for the database

Consult the DBA.

Note the drive on which the
production repository resides.

Decide whether to create the
copy on the equivalent drive.

You must decide whether to create the copy on a drive equivalent to the drive on which
the production repository resides. If the copy is on a different drive (for example, on
drive D: rather than drive E:), there are additional steps you must perform.

After you have completed the tasks in Table 5-1, above, create the repository copy. The
instructions below are high- level instructions, but they include crucial steps. To create
the repository that becomes the copy, refer to Content Server Installation Guide for server
5.2.5 for complete installation instructions and to this manual for instructions on how
to upgrade the copy to 5.3 SP1.
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In the following instructions, the test repository is called the repository copy. Your
original repository is called the production repository.

Caution: The instructions assume that the production repository is running and on the
network while the repository copy is tested. However, it is strongly recommended that
you shut down the production repository or take it off the network while you test the
repository copy. Conflicts and data corruption can result from having two repositories
on the network with the same name and repository ID.

To copy a repository:

1. Shut down the production repository.

2. On the target host, create a new server installation and repository (the repository
copy) of the same version number as the production repository.
Follow the instructions in the Content Server Installation Guide for the server version
from which you are upgrading.
• When you create the repository copy, ensure that you use the same repository

name, repository ID, and repository owner name and password as the
production repository.

• You cannot create copies of more than one repository in a single new installation
if the repositories were created in different installations.

For example, if you are copying two repositories, Paris and London, that were
created in separate server installations, you must copy them to separate server
installations. Creating a repository copy requires you to copy the aek.key file
from the original repository host to the repository copy host, because each
repository copy must have access to the aek.key file from its original installation.
You cannot have more than one aek.key file in an installation.

If you are copying two repositories, Tokyo and Beijing, that were created in the
same server installation, you can create their copies in the same new installation,
with the aek.key file from the original installation copied to the installation
where you create the copies.

• Ensure that you use a different database instance from the instance used by the
production repository and that you provide the correct connection information
when you install.

For example, under Oracle the tnsnames.ora on the host where the repository
copy resides must point to the Oracle instance used by the copy, not the instance
used by the production repository.

• Ensure that the repository copy projects to a connection broker different from the
connection broker used by the production repository.

• Copy the $DOCUMENTUM/dba/secure/aek.key file from the original host to the
same location on the repository copy host.

3. Apply to the repository copy any patches you applied to the production repository.
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4. Connect to the database instance serving the production repository.

5. Using the database vendor’s tools, export all objects owned by the repository owner
and export the schema for the tables comprising the repository.
Contact the database vendor for technical support you require to use the database
tools.

6. On the production repository host’s file system, create a backup of the entire
$DOCUMENTUM/data/repository_name directory.
This is the directory containing the repository’s content files.

7. Stop the repository copy.

8. Connect as the database system administrator to the database instance serving the
repository copy.
For example, on Oracle, connect as the System account.

9. Destroy the existing tablespaces or database using the dm_DeleteTableSpace.sql
script in $DOCUMENTUM/dba/config/repository_name/.
The scripts are database-specific. Run the script using the tools provided by your
database vendor.

10. Remove the physical database file from the file system.
The name and location of the physical file are in the dm_CreateTableSpace.sql script.

11. Create new tablespaces or databases for the repository copy using the
dm_CreateTableSpace.sql script in $DOCUMENTUM/dba/config/repository_name/.
The scripts are database-specific. Run the script using the tools provided by your
database vendor.

12. Import the database export taken from the production repository into the
newly-created tablespaces or database.

13. Verify that the database tables have the correct value for the test system host name
by checking the following values:
• r_host_name in dm_server_config_s
• host_name in dm_mount_point_s
• target_server in dm_job_s
• projection_targets in dm_server_config_r

14. Connect to the database serving the repository copy as the repository owner .

15. If any of the values in Step 13 are incorrect, use SQL to correct the values.

16. Set the server to rebuild the Documentum views with this SQL statement:
update dm_type_s set views_valid=0

17. If you are testing operations that require the content files, copy the content file
backup from the production repository to the file system of the repository copy.
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18. Navigate to the DOCUMENTUM/dba/config/repository_name directory and open the
server.ini file in a text editor.

19. Ensure that the preserve_existing_types key in the SERVER_STARTUP section is
set to TRUE:
preserve_existing_types=T

20. Save the server.ini file.

21. Start the server for the repository copy.

22. If you are testing the migration of a Web content management repository, modify the
user objects to reflect the new authentication domain.

a. Start IDQL and connect to the repository as the installation owner.

b. Issue the following commands:
update dm_user objects
set user_os_domain =’new_machine_name’
where user_os_domain =’old_machine_name’

c. Disconnect from the repository and close IDQL.

23. If the server and content files of the copy reside on a drive different from the
drive used by the production repository (for example, drive D: instead of drive
E:), use IDQL to update the file_system_path attribute of the dm_location and
dm_mount_point objects to the new location:
update dm_location objects
set file_system_path='newpath' where file_system_path='old path'
update dm_mount_point objects
set file_system_path='newpath' where file_system_path='old path'

24. Deactivate all jobs by changing the is_inactive attribute on all job objects to TRUE.

25. Upgrade the repository copy to Content Server 5.2 and verify the upgrade.
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Preparing the Database for Content
Server Installation

Each repository must have a properly-configured database. This chapter contains information on
configuring the database properly. It contains these topics:
• Requirements for all databases, page 69
• System performance and database parameters on Oracle and DB2, page 72
• Oracle requirements, page 73
• SQL Server requirements, page 75
• Sybase requirements, page 78
• DB2 requirements, page 81
Please note that instructions on installing and configuring databases for use with Content Server are
provided for your convenience. Documentum does not provide support for the database. Contact the
database vendors for database support.

Requirements for all databases
Documentum Content Server requires a properly configured database. The database
tables store attribute values for each object in the repository.

This section discusses those requirements and decisions that apply to all database
vendors. It contains the following sections:
• Local or remote database installation, page 70
• Database code page, page 70
• English and localized version of the database, page 70
• Database service on Windows, page 70
• Repository size, page 71
• Remote Content Servers and the database_conn key in the server.ini file, page 71
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• Database client and remote Content Servers, page 71
• Repository owner account, page 71
• Database administrator account, page 72

Local or remote database installation

The database can be either a remote or local installation, installed on any operating
system supported by the database vendor. For example, Content Server can be installed
on a Windows host and use a database installed on a Solaris host.
• For remote database installations, verify that you can connect to the database by

using a database client from the system where you intend to install Content Server.
• For local database installations on a UNIX host, verify that the system path includes

the installation directory for the database. (On Windows hosts, the installer updates
the system path automatically.)

Database code page

If you are creating a new database or tablespace for Content Server, designate UTF-8 as
the code page.

If you are upgrading Content Server you do not have to migrate the database to UTF-8;
however, to use Content Server’s multilingual features in an upgraded repository, you
must also migrate the database to UTF-8.

English and localized version of the database

English version and the localized Japanese and Korean versions of SQL Server and
Oracle are supported.

Database service on Windows

If Content Server and the database are located on the same Windows host, ensure that
the database service is set to start automatically. Server installation sometimes requires a
restart of the computer. After the restart, installation does not proceed correctly unless
the database starts automatically.
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Repository size

You can configure a small, medium, or large repository. The sections of this chapter for
each RDBMS discuss the differences among the repository sizes.

Remote Content Servers and the database_conn key
in the server.ini le

When a remote Content Server is created for a distributed content environment, the
server.ini file from the primary Content Server host is copied from the primary host to the
remote host. The values used on the primary and remote hosts for database connectivity
must be identical to ensure that the database_conn key on the primary Content Server
host is valid on the remote hosts. For example, if the database is SQL Server, ensure that
the DSN name for the SQL Server instance’s ODBC data source is the same on all hosts.

Database client and remote Content Servers

The database client must be installed on hosts where remote Content Servers are
installed. The remote Content Server configuration program must connect to the
database to create the server config object, acs config object, file store storage object,
and location objects for the remote server.

Repository owner account

The repository owner (database user) account is the account used by Content Server to
connect to the RDBMS. The server runs as the installation owner, but a separate account
must exist to provide the server with access to the database tables underlying the
repository. Each repository must have a unique repository owner and each repository
owner must have a unique RDBMS account.

You can create the repository owner account and the database or tablespace that the
repository uses before Content Server installation, or the server installation software can
create the account and database or tablespace. Before you begin installation, decide
whether to create the account yourself or allow the installation program to create the
account.

The account must have the appropriate privileges to perform the following tasks:
• Connect to the database

Content Server Installation Guide 71



Preparing the Database for Content Server Installation

• Create tables, views, and indexes in the database
• Insert records (rows) into the tables
• Drop tables, views, and indexes
The names of the privileges depend on the RDBMS.

For example, in Oracle, granting CONNECT and RESOURCE privileges to the accounts
gives them the required capabilities.

For complete information on the repository owner, refer to Windows host preparation,
page 41 and UNIX and Linux host preparation, page 48.

Database administrator account

Regardless of the database you use with Content Server, you must know the database
administrator’s user name and password. This information is needed to create the
repository owner account in the database if you choose to have the server installation
software create the account for you.

System performance and database parameters
on Oracle and DB2

To improve performance and increase the throughput of the system, you may want to
control where the RDBMS stores repository information. For example, you can store
frequently used data and less frequently used data on different disks. Defining database
parameters to store data in different tablespaces also partitions data into smaller, more
manageable pieces.

To modify the database parameters, choose custom configuration and edit the server.ini
file to change the default database configuration parameters. You can only change this at
the time the repository is created. You cannot modify this after repository creation or
during an upgrade.

You can install and run Content Server without making any changes to the default
database configuration parameters. However, if you want to change the database
configuration parameters, you must do so before you start Content Server. Refer to
Appendix F, Defining Oracle or DB2 Database Parameters for Repository Tables for full
information on changing the database configuration parameters.
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Oracle requirements
The Oracle RDBMS must meet the following requirements:
• Create the repository’s database with the UTF-8 code page. This is not a requirement

for upgrading Content Server.

On Oracle 9i, when you create the database and choose the database character
set (code page), select Unicode (AL32UTF8). If you choose to migrate an existing
database to UTF-8, use AL32UTF8.

• On UNIX and Linux, ensure that the correct Documentum environment variables are
set in the installation owner’s environment.

For information on these variables, refer to Setting up the installation directories,
page 50 and Setting up the installation owner account, page 52.

• On UNIX and Linux, ensure that the ORACLE_HOME environment variable is set in
the installation owner’s environment.

• On UNIX and Linux, ensure that the TNS_ADMIN environment variable is set in
the installation owner’s environment.

This environment variable points to the location of the tnsnames.ora file. The Content
Server installation program looks first for TNS_ADMIN, then for ORACLE_HOME,
in order to locate the tnsnames.ora file.

• Ensure that SQL*Plus is installed on the Content Server host.

SQL*Plus is needed for creating tablespaces and the database user (repository
owner) account.

• Ensure that client side of SQL*Net is set up properly.

The database aliases must be in the tnsnames.ora file and the tnsnames.ora files must
be configured on the Content Server host. Use the SQL*Net configure tool to alter
values in the tnsnames.ora file. You can edit the tsnames.ora file using the SQL*Net
icon in the Oracle group.

• Install the Oracle client software on the Content Server host.

Use the Oracle 9 or 10 client software.
• The Oracle Listener process must be running on the machine where the Oracle

database resides.
• Verify that you can connect to the Oracle RDBMS by using SQL*Plus from the system

where you intend to install Content Server.
• Do not install Oracle HTTP Server and Documentum RightSite® on the same host

computer.
Documentum does not provide support for Oracle. If you need assistance in setting up
Oracle, contact your database administrator or Oracle.
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Oracle optimization

In the init.ora file or spfile, use the following settings:
optimizer_index_cost_adj=5
optimizer_index_caching=95

To improve performance when upgrading large repositories for Content Servers running
with Oracle, ensure that the optimizer mode (optimizer_mode in the init.ora file) is not
set to ALL_ROWS.

Oracle database aliases

Oracle database aliases (TNS aliases) are defined by entries in the tnsnames.ora file.
You cannot connect to an Oracle database without an alias. Use the Oracle SQL*Net
configuration tool to create a database alias referring to the database instance you
plan to use for Content Server. After you create the alias, test the alias by connecting
to Oracle with SQL*Plus.

Entries in tnsnames.ora le

Entries in the tnsnames.ora file for the Oracle HTTP service and data expo service do not
contain parameters for HOST, SID, and SERVICE. If the first entry in the tnsnames.ora
file is for one of these services, the Content Server installation program is unable to parse
the tnsnames.ora file and cannot connect to the database. To work around this problem,
the first entry in the tnsnames.ora file must not be for the Oracle HTTP service or data
expo service.

The database_conn key in the server.ini filemustmatch exactly the database entry in the
tnsnames.ora file. If it does not, you see this error:
Error - Failed to obtain database connection information
corresponding to the repository from the server.ini file.
String index out of range: -1
Please read error log /tmp/installation_owner_name.ServerInstaller.log
for more information.

If you see this error, modify the database_conn key in the server.ini file and continue
with the installation or upgrade.
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Oracle repository sizes

In a small repository on Oracle, a single tablespace contains the data and indexes and
an index tablespace cannot be configured. A small Oracle repository has an initial data
file size of 100 MB.

In a medium or large repository on Oracle, one tablespace contains the data and another
tablespace contains the indexes, and an index tablespace can be configured. A medium
Oracle repository has an initial data file size of 180 MB and an initial index file size of
180 MB. A large Oracle repository has an initial data file size of 250 MB and an initial
index file size of 250 MB.

SQL Server requirements
If you are using SQL Server, ensure that ODBC is properly configured. Refer to
Configuring an ODBC Data Source for SQL Server, page 76 for more information.

Use a full SQL Server installation on the host where SQL Server is installed. The SQL
Server client must be installed on the Content Server host, whether the database is local
or remote.

Use the Custom installation option so that you can set the database code page,
case-sensitivity, and other options.

If you create the repository owner account before starting the Content Server installation
program, ensure that the repository owner owns all SQL Server tables and views.

If SQL Server is installed in a different domain from Content Server, the Documentum
installation owner must be a valid user in the remote domain.

Depending on the type of authentication SQL Server uses, the installation owner
requirements are different:
• If SQL Server uses Windows authentication, the installation owner must have system

administrator privileges in SQL Server.
• If SQL Server uses SQL Server or mixed authentication, the installation owner does

not need system administrator privileges.
If SQL Server is installed on a machine remote from the machine where Content Server is
installed, you must install Microsoft Data Access Components 2.71 on the Content Server
host. (This is the version of MDAC provided with SQL Server 2000, SP3.)

Caution: The database must be installed in case-sensitive mode with row-level locking
enabled. If you installed SQL Server in case-insensitive mode, you must reconfigure the
database before you install or upgrade Documentum.
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Youmust install SQL Server correctly in order to use Content Server’s internationalization
features. Refer to Configuring SQL Server for Internationalization, page 76,” below,
for instructions.

Documentum does not provide support for SQL Server. If you need assistance in setting
up SQL Server, contact your database administrator or Microsoft.

Conguring SQL Server for Internationalization

On SQL Server, you can use any collation (SQL Server’s name for code page), because
this only determines the code page of varchar and char types. For new SQL Server
repositories, Content Server uses only nvarchar and nchar types, which automatically
use Unicode. If you need to determine the collation settings of an existing SQL Server
database, use the system stored procedure sp_helpsort or view the properties of the
particular database in Enterprise Manager.

Conguring SQL Server Case Sensitivity

SQL Server must be installed with the case-sensitivity option turned on. The default
installation setting is case-insensitive. The Content Server Setup program detects
case-sensitivity during the installation and notifies you if SQL Server is configured with
the case-insensitive default.

Conguring an ODBC Data Source for SQL Server

To install Content Server, you must configure SQL Server correctly. SQL Server requires
you to add a DSN entry manually.

If you have two SQL Server instances on the same host, you must enter
hostname/instancename, not only hostname, when you provide the SQL Server name.

To congure an ODBC data source for a new installation of SQL Server:

1. Log in to Windows using an account that has Administrator privileges.

2. Choose Start→ Programs→ Administrative Tools→ ODBC.
The ODBC Data Source Administrator is displayed.

3. Choose the System DSN tab.

4. Click Add
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The Create New Data Source dialog box is displayed.

5. Select SQL Server and click Finish.
The Create a New Data Source to SQL Server dialog box is displayed.

6. Type the name of the new data source, choose the SQL Server instance you want to
connect to, and optionally provide a description of the data source.
The name of the new data source must be the name of the host on which your are
configuring ODBC and installing Content Server.

7. Click Next.
Another Create a New Data Source dialog box is displayed.

8. Choose an authentication method for SQL Server to use.
• If you choose Windows authentication, the database user (repository owner)

must have a Windows account and the installation owner must have System
Administrator privileges in SQL Server.

• If you choose SQL Server authentication, the database user (repository owner)
does not have to have a Windows account.

9. Click Client Configuration.
• If SQL Server is on the same host as Content Server, choose Named Pipes.
• If SQL Server is on a different host from Content Server, choose TCP.
Another Create a New Data Source dialog box is displayed.

10. Accept the defaults by clicking Next.
Another Create a New Data Source dialog box is displayed.

11. Accept the defaults by clicking Finish.
The ODBC Microsoft SQL Server Setup dialog box is displayed and provides a
summary of the information entered.

12. Click Test Data Source.
The connection to SQL Server is tested.

13. Click OK.
The ODBC data source is configured.

SQL Server repository sizes

In a small repository on SQL Server, the log file size can be changed, but the device size
for the database cannot be changed. A small SQL Server repository has a data file size of
100 MB and a log file size that is 30% of the size of the data file.
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In a medium or large repository on SQL Server, the device size and the log file size for the
database can be changed. A medium SQL Server repository has a data file size of 180 MB
and a log file size that is 30% of the size of the data file. A large SQL Server repository
has a data file size of 500 MB and a log file size that is 30% of the size of the data file.

Sybase requirements
The Sybase RDBMS installation must meet the following requirements:
• In the $SYBASE/server_name.cfg file, set the system parameters number of open

objects, number of open indexes, and number of locks.

For more information, refer to Sybase parameters, page 79.
• The database for a new repository is installed with the UTF-8 code page.

For instructions, refer to Enabling the UTF-8 code page on Sybase, page 79. An
upgraded repository can continue to use a different code page.

• The correct environment variables are set in the installation owner’s environment

For information on these variables, refer to Setting up the installation owner account,
page 52.

• The correct Sybase environment variables are set in the installation owner’s
environment:

— SYBASE

— SYBASE_OCS

— SYBASE_SYSAM

— SYBASE_JRE

— SYBASE_ASE

If these Sybase environment variables are not set, you see ct_init
(CS_VERSION_100) errors.

• In a new repository, set a page size of 4 KB or 8KB.

Refer to Setting the Sybase 12.5 page size, page 80.
• In a repository upgraded to 5.3 SP1, a page size of 2 KB is acceptable, but a page

size of 4 KB or 8 KB is recommended
• On Sybase versions 12.0 and greater, ensure that certain Sybase files are in the

correct locations.

For more information, refer to Sybase directory structure, page 81.
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• If you are using file system devices rather than raw devices, you can manually reset
the dsync option on the tempdb devices by using the sp_deviceattr. Refer to Sybase
documentation for more information on this option.

• You can improve performance of some Documentum scripts by increasing the
network packet size to 4 K or 8K.

Documentum does not provide support for Sybase. For assistance in setting up Sybase,
contact your database administrator or Sybase.

To increase the network packet size:

1. Log in the ISQL.

2. Display the current maximum network packet size:
sp_configure "max network"

3. Change the size to 4 K:
sp_configure "max network packet size", 4096

or to 8K
sp_configure "max network packet size", 8192

Sybase parameters

You must change some parameters in the $SYBASE/$SYBASE_ASZ/server_name.cfg file.

To modify parameter values in the $SYBASE/$SYBASE_ASZ/server_name.cfg le:

1. Stop the Sybase server.

2. Open the $SYBASE/$SYBASE_ASZ/server_name.cfg file in a text editor.

3. Set the following parameters to the values shown:
number of open objects = 2000
number of open indexes = 1000
number of locks = 20000

4. Save the $SYBASE/$SYBASE_ASZ/server_name.cfg file.

5. Restart the Sybase server.

Enabling the UTF-8 code page on Sybase

When Sybase is installed, perform these additional configuration steps to enable the
UTF-8 code page, which is required for Content Server’s internationalization features.
UTF-8 must be installed and must be the default code page for the Sybase installation.
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To enable the UTF-8 code page in a new Sybase installation:

1. Install the Sybase server with the UTF–8 code page.

2. Connect as Sybase administrator.

3. Using isql, connect and run the following query to determine if UTF-8 is installed:
1)use master
2)go
1)select name from syscharsets where name='utf8'
2)go

If the query returns an answer, UTF-8 is installed.

4. Issue this command to determine whether UTF-8 is the default character set:
1> sp_configure 'default character set id'
2> go

5. If UTF-8 is not installed or is not the default code page:

a. Execute this command on the command-line to install the UTF-8 code page:
charset -Usa -Ppassword -Shost_name binary.srt utf8

b. Using isql, execute these commands to make UTF-8 the default code page:
1)use master

2)go

1)sp_configure ‘default character set id',190

2)go

6. Restart the Sybase server.

7. Install Content Server and configure a repository.
If you are upgrading a repository, the procedure is different.

To enable the UTF-8 code page for a repository upgrade:

1. Export the database for the existing repository.

2. Use the procedure above for a new installation.

3. Import the database.

4. Perform a repository upgrade using the upgrade-in-place procedure.

Setting the Sybase 12.5 page size

Content Server 5.3 SP1 is certified only on Sybase 12.5. We recommend the following
page sizes:
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• For new repositories, a minimum of 4 KB is required, with 8 KB recommended.
• For upgraded repositories, 2 KB is acceptable, but we recommend upgrading to

a larger page size.

Sybase directory structure

Ensure that on Sybase, the file isql exists inside $SYBASE/OCS-12_5/bin/isql. If the file is
there, you need not take further action. If not, create a symbolic link as follows:
mcd $SYBASE
mkdir OCS-12_5
cd OCS-12_5
mkdir bin
ln -s $SYBASE/$SYBASE_OCS/bin/isql $SYBASE/OCS-12_5/bin/isql

Sybase connections

Sybase 12.5 defaults to 25 user connections. We recommend increasing this number
to at least 200:
sp_configure 'number of user connections', 200

Sybase repository sizes

In a small repository on Sybase, the log file size can be changed, but the device size for
the database cannot be changed. A small Sybase repository has a data file size of 100
MB and a log file size of 100 MB.

In a medium or large repository on Sybase, the device size and the log file size for the
database can be changed. A medium Sybase repository has a data file size of 180 MB
and a log file size of 180 MB. A large Sybase repository has a data file size of 250 MB and
a log file size of 250 MB.

DB2 requirements
The DB2 configuration requirements apply whether DB2 and Content Server are running
on Windows or AIX or a combination.
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On AIX, ensure that the following DB2 environment variables are set in the installation
owner’s environment:
• DB2_BASE

This must point to /DB2_installation_dir/home/instance_name/sqllib.
• DB2INSTANCE

This must point to the name of the default DB2 instance.
• Ensure that the LIBPATH environment variable includes $DB2_BASE/lib.
Do not set the environment variable DB2OPTIONS. If set to T, the DB2 command-line
processor uses a semicolon (;) as the statement termination character. Content Server
does not install properly on AIX with DB2 when DB2OPTIONS is set.

Configuring DB2 requires you to install DB2, create a database for your repository to
use, and set some parameters. We also strongly recommend that you run the DB2
Performance Wizard in order to fine-tune the database’s performance.

You can create the database and set the parameters from the DB2 command line or from
the Control Center. You must use the Control Center to run the Performance Wizard.
You can run the Control Center on AIX, or you can run Performance Wizard from a
Windows system to tune performance for the instance on AIX.

Ensure that DB2 is installed with the UTF-8 code page.

Use the following general procedure to install and configure DB2:

1. Install DB2 using the procedure described in the next section, Installing and
configuring DB2, page 83.”

2. Use the Performance Wizard to fine-tune DB2 performance, using procedure
described in Using the Performance Wizard, page 84.

This step is optional, but we strongly recommend using the Performance Wizard to
ensure the best possible database performance. You can use the Performance Wizard
at a later time (after you complete configuring DB2), but if you do so, ensure that the
parameter values required by Content Server are not changed.

3. Configure DB2 using the procedure described in Configuring DB2 From the Control
Center, page 86 or the procedure described in Configuring DB2 From the command
line, page 87.

You can review DB2’s current configuration from the DB2 command line:

• To review all database management parameters:
get dbm cfg

• To review the parameters for a specific database dbname:
get db cfg for dbname
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Installing and conguring DB2

Use the following instructions to install and configure the DB2 instance with which
your repository is running.

To install and congure DB2:

1. Install DB2.

2. Before you create a database for use by Content Server, unset the DB2CODEPAGE
environment variable from the command line:

db2set DB2CODEPAGE =

3. Ensure that the DB2 clients are installed on the Content Server host.
• If you install DB2 locally (on the same machine as the Documentum Server),

the clients are installed automatically.
• If you install DB2 remotely (on a different machine from the Documentum

Server), you must manually install the DB2 clients on the Content Server host.
4. Create a database for use by the repository.

a. Start the Control Center.

b. Provide a name for the database.

c. Provide an alias for the database and note the alias name.
The alias name must be available during repository creation.

d. Use database-managed space (DMS) in the three system tablespaces
(SYSCATSPACE, TEMPSPACE1, and USERSPACE1).

e. Set the size of TEMPSPACE1 to a minimum of 400 megabytes.

f. Set the size of USERSPACE1 and SYSCATSPACE to a minimum of 200
megabytes.

g. Set the code page to UTF-8.

5. After you create the database, start the DB2 command line.

6. From the command line, set the DB2CODEPAGE environment variable to 1208:
db2set DB2CODEPAGE=1208

7. Set the DB2_RR_TO_RS environment variable:
db2set DB2_RR_TO_RS=YES

This prevents deadlocks and live locks.

8. Set the DB2NTNOCACHE environment variable:
db2set DB2NTNOCACHE=1
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9. If you are installing DB2 7, set the DB2_INDEX_2BYTEVARLEN environment
variable:
db2set DB2_INDEX_2BYTEVARLEN=ON
This is not required on DB2 8, where new indexes are type 2 indexes by default.

10. Complete DB2 configuration.

a. To fine-tune DB2 performance, optionally use the following procedure, Using
the Performance Wizard, page 84.
We strongly recommend using the Performance Wizard to tune DB2
performance. If you skip this step now and later decide to use it, ensure that the
parameters described in Configuring DB2 From the Control Center, page 86 or
Configuring DB2 From the command line, page 87 are set to the correct values.

b. Set the parameters to the values required by Content Server using the procedures
described in Configuring DB2 From the Control Center, page 86 or Configuring
DB2 From the command line, page 87.

Using the Performance Wizard

If your DB2 instance runs on AIX, run Performance Wizard from a Windows system to
tune performance for the instance on AIX.

To use the Performance Wizard to tune DB2 performance:

1. Start the Control Center.

2. Right-click the database you created for the repository.

3. On the context menu, choose Configure Performance Using Wizard.
The name of the production database dialog box is displayed.

4. Click Next.
The server memory dialog box is displayed.

5. Set the server memory target value.
• If DB2 is installed on the Content Server host and you are installing DB2

Enterprise Edition, set the target memory to 40%.
• If DB2 is installed on the Content Server host and you are installing DB2

Workgroup Edition, set the target memory to 20%.
• If DB2 is installed on a different machine from Content Server and you are

installing Enterprise Edition, set the target memory to 80%.
6. Ensure that the buffpage value is at least 6000.

7. Click Next.
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The workload type dialog box is displayed.

8. ClickMixed, and click Next.
The typical database transaction dialog box is displayed.

9. Indicate the allowable number of SQL statements and transactions.
• If you are installing DB2 Enterprise Edition, clickMore than 10 SQL statements

and 60 transactions per minute, and click Next.
• If you are installing DB2 Workgroup Edition, click Less than 10 SQL statements

and 30 transactions per minute, and click Next.
The database administration priority dialog box is displayed.

10. Click Faster transaction performance (slower recovery), and click Next.
The database data population dialog box is displayed.

11. Click No and click Next.
After the repository is in use and the database contains more data, you can run the
Performance Wizard again and change this parameter.
The number of connected applications dialog box is displayed.

12. Provide the average number of local and remote connections.
• If you are installing DB2 Enterprise Edition, type in 4 average local connections

and 20 average remote applications and click Next.
• If you are installing DB2 Workgroup Edition, type in 4 average local connections

and 2 average remote connections and click Next.
These numbers may be larger depending on the number of clients connecting to
your repository. A production repository may have many more client applications
connecting.
The isolation level dialog box is displayed.

13. Click Cursor stability (many locks of short duration) and click Next.
The Performance Wizard displays values it recommends based on the information
you provided and choices you made.

14. Check Apply these recommendations immediately and click Finish.

15. From the command line, restart the DB2 server:
db2stop force
db2start

16. Complete DB2 configuration from the Control Center or the DB2 command line.
• To configure DB2 from the Control Center, use the procedure described in

Configuring DB2 From the Control Center, page 86
• To configure DB2 from the command line, use the procedure describe in

Configuring DB2 From the command line, page 87
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Conguring DB2 From the Control Center

Use these instructions to configure DB2 from the DB2 Control Center.

To congure DB2 from the Control Center:

1. Start the Control Center.

2. Right-click the database and choose Configure from the context menu.

3. Click the Performance tab.

a. Set the sort heap.
• If you are configuring DB2 Enterprise Edition, set the sort heap to 1024.
• If you are configuring DB2 Workgroup Edition, set the sort heap to 512.

b. Set the application heap size to 1024.

c. Set the application control heap size to 256.

d. Set the log buffer size.
• If you are configuring DB2 Enterprise Edition, set the log buffer size to 128.
• If you are configuring DB2 Workgroup Edition, set the log buffer size to 64

e. Set the locklist size.
• If you are configuring DB2 Enterprise Edition, set the locklist size to a

minimum of 500.
• If you are configuring the DB2Workgroup Edition, set the locklist size to 300.

4. Click the Applications tab and set the maximum number of locks to 80.

5. Click the Logs tab.

a. Set the log file size to 1000.

b. Set the number of primary logs to 5.

c. Set the logsecond size.
• If you are configuring DB2 Enterprise Edition, set the size to 10.
• If you are configuring DB2 Workgroup Edition, set the size to 15.

6. Click Okay and close the dialog box.

7. When the Control Center is displayed, click the database for your repository and
right-click Buffer Pools.

8. Choose Alter.
The Alter Buffer Pool dialog box displays.

9. Check Use default bufferpool size, and click Okay.

10. From the command line, restart the DB2 server:
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db2stop force
db2start

Conguring DB2 From the command line

To conguring DB2 from the command line:

1. Start the DB2 command line.

2. Set the application heap size to 1024 or greater, where dbname is the name of the
database you created for use by the repository:

update
db cfg for dbname using applheapsz 1024

3. Set the application control heap size to 256 or greater:
update

db cfg for dbname using APP_CTL_HEAP_SZ 256

4. Set the transaction file sizes.
• If you are configuring DB2 Enterprise Edition:

update db cfg for dbname using LOGFILSIZ 1000
update db cfg for dbname using LOGPRIMARY 5
update db cfg for dbname using logbufsz 128
update db cfg for dbname using logsecond 10

• If you are configuring DB2 Workgroup Edition:
update db cfg for dbname using LOGFILSIZ 1000
update db cfg for dbname using LOGPRIMARY 5
update db cfg for dbname using logbufsz 64
update db cfg for dbname using logsecond 15

5. Set the maximum number of locks:
update db cfg for dbname using maxlocks 80

6. Set the locklist size to a minimum of 500.
• On the DB2 Enterprise Edition, set it to a minimum of 500:

update db cfg for dbname using locklist 500

• On the DB2 Workgroup Edition, set it to 300:
update db cfg for dbname using locklist 300

7. Set the sort heap and buffer page sizes.
Ensure that the buffer page size (buffpagesize) is set to a minimum of 6000:
• If you are configuring DB2 Enterprise Edition:

update db cfg for dbname using sortheap 1024
update db cfg for dbname using buffpage buffpagesize

• If you are configuring DB2 Workgroup Edition:
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update db cfg for dbname using sortheap 512
update db cfg for dbname using buffpage buffpagesize

• If Documentum and the DB2 server are on the same machine and you are
configuring DB2 Enterprise Edition, set buffpagesize to 40% of the available
physical memory divided by the page size of your tablespace.

• If Documentum and the DB2 server are on the same machine and you are
configuring DB2 Workgroup Edition, set buffpagesize to 20% of the available
physical memory divided by the page size of your tablespace.

• If Documentum and the DB2 server are on different machines, set buffpagesize
to 80% of the available physical memory divided by the page size of your
tablespace.

Note: If you are running more than one repository and database on the same DB2
server, the percentage recommended for buffer pool is for the sum of all databases.
In all cases, ensure that the buffer page size is a minumum of 6000.

8. If you see the SQL1482W error message “The BUFFPAGE parameter will only be
used if one of the buffer pools is defined with a size of -1,” change the buffer pool size:
ALTER BUFFERPOOL buffpoolname SIZE -1

9. From the command line, restart DB2:
db2stop force
db2start

10. If DB2 is installed remotely, use the DB2 Client Configuration Assistant after
database creation to add the database alias to the list of available databases.

Running multiple Documentum Servers on the DB2 host

If you run multiple Content Servers on the DB2 host machine, you may see a DB2
SQL1224N error. This can occur with multiple repositories on the host or with multiple
servers running against a single repository. To work around this, change two parameters:
• On AIX, set EXTSHM to ON in the environment of the DB2 instance owner. You can

do this in the .cshrc file or the corresponding system file for the different shells.
setenv EXTSHM ON

• On Windows, set the EXTSHM environment variable at the system level.
• In the DB2 environment, run this command:

db2set DB2ENVLIST=EXTSHM
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DB2 repository sizes

In a small repository on DB2, a single tablespace contains the data and indexes and
an index tablespace cannot be configured. A small DB2 repository has an initial data
file size of 200 MB.

In a medium or large repository on DB2, one tablespace contains the data and another
tablespace contains the indexes, and an index tablespace can be configured. A medium
DB2 repository has an initial data file size of 400 MB and an initial index file size of 200
MB. A large DB2 repository has an initial data file size of 800 MB and an initial index
file size of 300 MB.
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Chapter 5
Express Installation

This chapter contains step-by-step instructions for installing the Content Server software and using
the express configuration option to create a connection broker and repository.

Choosing express installation minimizes the amount of information that you must provide during
the installation procedure. It also constrains how much you can customize the configuration of
Content Server and the repository.

To customize Content Server and repository configuration, use the installation procedure described in
Chapter 6, Custom Installation.

To upgrade from a previous release of Content Server, use the procedure described in Chapter 8,
Upgrading Content Server.

If you are setting up Microsoft Windows Cluster Services to provide failover support to your
repository, do not use the procedures in this chapter. Use the procedures described in Appendix G,
Installing Content Server With Microsoft Cluster Services.

If full-text indexing will be enabled for the new repositories, review the Content Server Full-Text
Indexing Installation Guide.

If you are setting up a distributed configuration, you can use the instructions in this chapter to install
the primary site, or you can use the instructions in Chapter 6, Custom Installation. To add additional
sites, refer to Chapter 7, Installing Remote Servers in Distributed Configurations.

Before you install, review Chapter 2, Planning for Content Server Installation, Chapter 3, Preparing
for Content Server Installation, Chapter 4, Preparing the Database for Content Server Installation, and
Appendix A, Preinstallation Checklists.

This chapter contains the following information:
• Creating the Server software installation on the host, page 92
• Configuring the Server and repository, page 95
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Creating the Server software installation on the
host

The first part of the installation process copies files from the installation media to the
correct directories on your hard disk.

On Windows, this procedure also sets environment variables needed by Content Server.

On Windows, if you exit the Setup part of the installation program, all Content Server
registry entries are deleted. To install a component that was not previously installed, you
must go through the complete Setup program.

To create the server installation on the host computer:

1. Log in to the host system using the installation owner account.
• OnWindows, use an account that is a member of the local Administrators group.

On Windows, user accounts are not case-sensitive, but Content Server
installation fails if you connect to the host using the incorrect case in the user
name and password. For example, if the account is set up as JPSmith and you
connect as jpsmith, you can log in to the host, but server installation fails.

• On UNIX and Linux, connect using an account that is a member of the
Documentum and installation owner group.

To confirm the account’s group membership, type the following at the command
prompt:

Solaris:
% id -a

AIX and HP-UX:
% id

2. To install from the Documentum FTP site:

a. Navigate to the correct product directory.

b. Navigate to the server version corresponding to your operating system and
database.

3. To install from a CD:

a. Insert the CD into the CD-ROM drive.

b. On the CD, navigate to the subfolder corresponding to your operating system
and database.

4. Save the compressed distribution file from the CD or the FTP site to your hard disk.

5. Navigate to the file’s location on your hard disk.
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6. Extract the file.

a. On Windows, double-click the file.

b. On UNIX and Linux, untar the file:
% tar xvf filename
The following files are extracted from the compressed file:
bofcollaborationSetup.jar
bofworkflowSetup.jar
consistency_checker.ebs
dfcoperatingsystemSetup.jar
serveroperatingsystemSetup.jar
serverWinSuiteSetup.exe (Windows) or
serveroperatingsystemSuiteSetup.bin (UNIX and Linux)
serveroperatingsystemSuiteSetup.jar
tcfSetup.jar
tomcatoperatingsystem<versionnumber>Setup.jar

7. Start the installation program.
• On Windows, double-click the file named serverWinSuiteSetup.exe.
• On UNIX and Linux, type
% serveroperatingsystemSuiteSetup.bin

and press Enter, where operatingsystem is the operating system on which you are
installing.
The Setup program starts and a Welcome dialog box is displayed.

8. Read the information on the dialog box and click Next.
The installer verifies operating system requirements. The license agreement dialog
box is displayed.

9. Click Next if you accept the terms of the license agreement.
Otherwise, the installer exits.

10. If you are installing on Windows, choose installation directories for Content Server
and DFC; if you are installing on UNIX and Linux, skip to step Step 11.

a. Click Next to accept the default Content Server installation directory or click
Browse to choose a different installation directory.
The default directory is C:\Documentum.

b. To install the DFC developer documentation, select the checkbox.

c. To install the Primary Interop Assembly, select the checkbox.
Check the Primary Interop Assembly Installer checkbox to request installation of
a Microsoft installer package (.msi file) for the DFC primary interop assembly
(PIA), or leave the box unchecked if you do not wish to have the package
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installed. The installer places the installer package for the DFC PIA into the
setup subdirectory of the program root.

d. Click Next.

e. If DFC is not on the host, click Next to accept the default DFC installation
directory or click Browse to choose a different directory.
A dialog box is displayed indicating the default user directory. This directory is
used by DFC during the checkout or export of documents.

f. Click Next to accept the default User directory or click Browse to choose a
different directory.

g. Designate a repository that is a business objects framework global registry for
the DFC to use.

h. Type the global registry user’s user login name and password for the repository.
Do not check Validate Entries or the installer fails.

11. To enable Trusted Content Services, select the checkbox and type in the Trusted
Content Services license key, then click Next.

12. To enable Content Services for EMC Centera, select the checkbox and type in the
Content Services for EMC Centera license key, then click Next.

13. Type the port numbers for the Java method server.
• The first port is the primary port used by the Java method server (Apache

Tomcat) for communications with Content Server.

The default port is 9080.
• The second port is the port used for Tomcat administration.

The default port is 9007.
The ports must not be used by another application and must not be the ports used by
Site Caching Services.
The Tomcat instance is also used for running the ACS server.

14. Click Next.
A panel displays the software to be installed.

15. Click Next.

16. If any components already exist on the host computer, click Yes or Yes to All. to
replace the older components.
A dialog box displays information about the products installed and their locations
and indicates that the installation is complete.

17. Click Next.
DFC and Content Server are installed.
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18. If you are installing on UNIX or Linux, you are asked whether to perform the root
task, which sets file permissions for the password checking and password changing
programs.

a. To perform the task, click Next.

b. Type the root password and press Enter.
A new window opens.

c. Provide the name of the administrator group and press Enter.
The windows closes and you are returned to the main Xterm window to continue
installation.
The Documentum Foundation Classes (DFC) Runtime Environment and
Documentum Content Server software are installed.

19. Choose whether to continue with server configuration.
• To configure the server immediately, click Configure server for new repository

or upgrade existing repository and click Next.
• To configure the server at another time, click Configure server later and click

Next.
20. Click Next.

21. On Windows, indicate whether to restart the host now or later.
The installation is not complete until the host is restarted.
• To restart the host immediately, click Yes, restart my system and click Finish.

The host restarts.
• To restart the host at a later time, click No, restart my system at a later time

and click Finish.

Server installation is complete.

Conguring the Server and repository
This section provides instructions for configuring the Server and a repository. Perform
this part of the installation after you install the software and restarted the machine.

To congure the repository:

1. If you are on Windows, log in to Windows as the Documentum installation owner.
If the setup process continues automatically, a Welcome dialog box is displayed.
If the setup process does not continue automatically, follow these steps:

a. Restart the machine manually.
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b. After the reboot is completed, log in as the Documentum installation owner.

c. Navigate to the DM_HOME/install directory.

d. Double-click the Server_Configuration_Program.exe file.

2. If you are on UNIX or Linux, type these commands:
% cd $DM_HOME/install
% dm_launch_server_config_program.sh

A welcome dialog box is displayed.

3. Click Next.

4. If you are installing on Windows, provide the installation owner’s password and
click Next.
The installer verifies the password.

5. Click Express and then Next.
The installer verifies system information and creates a new connection broker. The
New Repository dialog box is displayed.

6. Configure a repository.

a. To enable Content Storage Services in the repository, select the checkbox and
type in the license key, then click Next.

b. To enable Collaborative Services or Collaborative Services with Rooms in the
repository, select the checkbox and type in the license key, then click Next.

c. To enable Retention Policy Services in the repository, select the checkbox and
type in the license key, then click Next

d. To enable Records Manager in the repository, select the checkbox and type in the
license key, then click Next.

e. Type the name of the repository.
For more information on the repository name, refer to Repository name and
ID, page 35.

f. Type the repository ID.
For more information on the repository ID, refer to Repository name and ID,
page 35.

g. Type a description for the repository.

h. Select the repository size.

i. On UNIX and Linux, provide the service name for the repository.
This is the service name you entered in the services file.

j. On Windows, select the authentication domain.
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k. On Windows, indicate whether the repository service starts automatically or
manually. Check Automatic to start the Server automatically orManual to start
the Server manually.

l. Click Next.

m. Select the mode in which clients connect to the repository.
• Select Native for unsecure connections
• Select Secure for secure connections
• Select Native and Secure if clients can use either connection mode

n. Click Next.

7. Select whether to create a new database user account and storage areas or use an
existing user account and storage and click Next.
The database user is the repository owner.

8. If you chose to create a new database user account, provide database information.

a. Choose the correct database connection string for your database instance.
• On Oracle, select the connection string from the dropdown list.
• On SQL Server, select an ODBC Datasource from the dropdown list
• On DB2, select the database name from the dropdown list
• On Sybase, select the database name from the dropdown list

b. Type the database user’s name.
This defaults to the repository name. This user becomes the repository owner.

c. Type the database user’s password and confirm the password.

d. Type the database administrator’s user name and password.

e. Click Next.

9. If you chose to use an existing database account and tablespaces or databases,
provide database information.

a. Choose the correct database connection string for the database instance you
are using.

b. Type the database user’s name.
This is for an existing database account. This user becomes the repository owner.

c. Type the database user’s password.

d. Click Next.
The repository service starts.

10. Type the name of an SMTP server on the network and the email address of the
installation owner.
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11. Click Next.
The installation program runs the repository configuration scripts.

12. To use the current repository as the global registry repository, select Use this
Repository and click Next.
The global registry repository is used for storing SBOs and network locations. For
more information on the global registry and global registry user, refer to Global
registry, page 31 and Preparing for the global registry, page 56.

a. Accept the user login name of the global registry user or type in a new user
login name.

b. Type the global registry user’s password.

c. Confirm the global registry user’s password and click Next.

13. To use a different repository as the global registry repository, select Specify a
Different Repository and click Next
The global registry repository is used for storing SBOs and network locations. For
more information on the global registry and global registry user, refer to Global
registry, page 31 and Preparing for the global registry, page 56.

a. Type the repository name.
The repository must be known to the connection broker you specified during
DFC installation.

b. Type the user login name of the global registry user for the repository.

c. Type the global registry user’s password.

14. To designate the global registry repository at a different time, select Do Later and
click Next.

15. A warning message to enable the global registry connection is displayed. Click
CONTINUE.

16. If you are enabling SSL, indicate whether to restart the repository and click Next.
Restarting the repository enables secure client connections to the server.

17. If the installer displays the repository successfully created screen, then click Next.

18. Click Finish.

19. On AIX, restart the repository.
This loads required full-text plugins.

20. If you created a new repository on a host where Thumbnail Server is already
installed, manually configure the base_url:

a. Determine the value of base_url.
• The base_url attribute takes the following format:
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http://host:port/thumbsrv/getThumbnail?

host is the name of the host where you are installing. The value of host can
be the machine name (for example, isadora) or a fully-qualified name (for
example, isadora.mycompany.com).

port is the primary Thumbnail Server port you provided when you installed
Thumbnail Server.

• The Thumbnail Server installation log contains the value of base_url for the
host. The log is located in %DM_HOME%\thumbsrv\install\install.log.

b. Use IDQL or Documentum Administrator to connect to the repository as a
superuser.

c. Execute the following query to set base_url:
UPDATE dm_filestore OBJECTS SET base_url='base_url' WHERE
media_type=1

base_url is the value you determined in Step a above.

d. Disconnect from the repository.

21. Start the Tomcat instance running the Java method server and ACS server using the
instructions in Starting and stopping the Java method server, page 136.
The Tomcat instance starts automatically only on Windows hosts that restart after
installation.

22. To install the full-text indexing software, refer to the instructions in the Content
Server Full-Text Indexing Installation Guide.
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Chapter 6
Custom Installation

This chapter contains step-by-step instructions for installing the Content Server software and using
the custom configuration option to create the connection broker and repository.

Use the procedures in this chapter if you are installing Content Server for the first time on a particular
machine and you want to customize the default configuration. If you do not plan to customize
the default repository configuration, use the simplified procedure described in Chapter 5, Express
Installation.

To upgrade from a previous release of Content Server, use the instructions in Chapter 8, Upgrading
Content Server.

If you are setting up Microsoft Cluster Services in order to provide failover support for your
repository, use the procedure described in Appendix G, Installing Content Server With Microsoft
Cluster Services.

If full-text indexing will be enabled for the new repositories, review the Content Server Full-Text
Indexing Installation Guide.

If you are setting up a distributed configuration, you can use the instructions in this chapter to install
the primary site, or you can use the simplified installation procedure described in Chapter 5, Express
Installation. To add additional sites to a distributed content environment, use the instructions
in Chapter 7, Installing Remote Servers in Distributed Configurations. Refer to the Documentum
Distributed Configuration Guide for information on other distributed configurations.

Before you install, review Chapter 2, Planning for Content Server Installation, Chapter 3, Preparing
for Content Server Installation, Chapter 4, Preparing the Database for Content Server Installation, and
Appendix A, Preinstallation Checklists.

This chapter contains the following information:
• Creating the Server software installation on the host, page 102
• Configuring the Server and repository , page 105
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Creating the Server software installation on the
host

The first part of the installation process copies files from the installation media to the
correct directories on your hard disk.

On Windows, this procedure also sets environment variables needed by Content Server.

If you exit the Setup part of the installation program, all Content Server registry entries
are deleted. To install a component that was not previously installed, you must go
through the complete Setup program.

To create the server installation on the host computer:

1. Log in to the host system using the installation owner account.
• OnWindows, use an account that is a member of the local Administrators group.

On Windows, user accounts are not case-sensitive, but Content Server
installation fails if you connect to the host using the incorrect case in the user
name and password. For example, if the account is set up as JPSmith and you
connect as jpsmith, you can log in to the host, but server installation fails.

• On UNIX and Linux, connect using an account that is a member of the
Documentum and installation owner group.

To confirm the account’s group membership, type the following at the command
prompt:

Solaris:
% id -a

AIX and HP-UX:
% id

2. To install from the Documentum FTP site:

a. Navigate to the correct product directory.

b. Navigate to the server version corresponding to your operating system and
database.

3. To install from a CD:

a. Insert the CD into the CD-ROM drive.

b. On the CD, navigate to the subfolder corresponding to your operating system
and database.

4. Save the compressed distribution file from the CD or the FTP site to your hard disk.

5. Navigate to the file’s location on your hard disk.
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6. Extract the file.

a. On Windows, double-click the file.

b. On UNIX and Linux, untar the file:
% tar xvf filename
The following files are extracted from the compressed file:
bofcollaborationSetup.jar
bofworkflowSetup.jar
consistency_checker.ebs
dfcoperatingsystemSetup.jar
serveroperatingsystemSetup.jar
serverWinSuiteSetup.exe (Windows) or
serveroperatingsystemSuiteSetup.bin (UNIX and Linux)
serveroperatingsystemSuiteSetup.jar
tcfSetup.jar
tomcatoperatingsystem<versionnumber>Setup.jar

7. Start the installation program.
• On Windows, double-click the file named serverWinSuiteSetup.exe.
• On UNIX and Linux, type
% serveroperatingsystemSuiteSetup.bin

and press Enter, where operatingsystem is the operating system on which you are
installing.
The Setup program starts and a Welcome dialog box is displayed.

8. Read the information on the dialog box and click Next.
The installer verifies operating system requirements. The license agreement dialog
box is displayed.

9. Click Next if you accept the terms of the license agreement.
Otherwise, the installer exits.

10. If you are installing on Windows, choose installation directories for Content Server
and DFC; if you are installing on UNIX or Linux, skip to step Step 13.

a. Click Next to accept the default Content Server installation directory or click
Browse to choose a different installation directory.
The default directory is C:\Documentum.

b. To install the DFC developer documentation, select the checkbox.

c. To install the Primary Interop Assembly, select the checkbox.
Check the Primary Interop Assembly Installer checkbox to request installation of
a Microsoft installer package (.msi file) for the DFC primary interop assembly
(PIA), or leave the box unchecked if you do not wish to have the package
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installed. The installer places the installer package for the DFC PIA into the
setup subdirectory of the program root.

d. Click Next.

e. If DFC is not on the host, click Next to accept the default DFC installation
directory or click Browse to choose a different directory.
A dialog box is displayed indicating the default user directory. This directory is
used by DFC during the checkout or export of documents.

f. Click Next to accept the default User directory or click Browse to choose a
different directory.

g. If there is no dmcl.ini file on the host, provide the name of the connection broker
to be used by clients on the host and the port number on which the connection
broker listens, then click Next.
The information is used to create the dmcl.ini file on the host. The default
connection broker port is 1489.

11. If you wish to install the DFC developer documentation, select the Developer
Documentation checkbox and then click Next.

12. Type the Primary Connection Broker Host Name and the Port Number, then click
Next. The default port is 1489.

13. To enable Trusted Content Services, select the checkbox and type in the Trusted
Content Services license key, then click Next.
If you are installing a distributed configuration, all servers or no servers must enable
Trusted Content Services.

14. To enable Content Services for EMC Centera, select the checkbox and type in the
Content Services for EMC Centera license key, then click Next.

15. Type the port numbers for the Java method server.
• The first port is the primary port used by the Java method server (Apache

Tomcat) for communications with Content Server.

The default port is 9080.
• The second port is the port used for Tomcat administration.

The default port is 9007.
The Tomcat instance is also used for the ACS server on the host. The ports must not
be used by another application and must not be the ports used by Site Caching
Services.

16. Click Next.
A panel displays the software to be installed.

17. Click Next.
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18. If any components already exist on the host computer, click Yes or Yes to All to
replace the older components.
A dialog box displays information about the products installed and their locations
and indicates that the installation is complete.

19. Click Next.
DFC and Content Server are installed.

20. If you are installing on UNIX or Linux, you are asked whether to perform the root
task, which sets file permissions for the password checking and password changing
programs.

a. To perform the task, click Next.

b. Type the root password and press Enter.
A new window opens.

c. Provide the name of the administrator group and press Enter.
The windows closes and you are returned to the main Xterm window to continue
installation.
The Documentum Foundation Classes (DFC) Runtime Environment and
Documentum Content Server software are installed. Click Finish to exit the
wizard.

21. Choose whether to continue with server configuration.
• To configure the server immediately, click Configure server for new repository

or upgrade existing repository and click Next.
• To configure the server at another time, click Configure server later and click

Next.
22. Click Finish. Server installation is complete.

Conguring the Server and repository
This section provides instructions for configuring the Server and a repository. Follow
these instructions after you complete the instructions in Creating the Server software
installation on the host, page 102.

To congure the Server and repository:

1. Start the configuration program.
• On UNIX and Linux, type these commands:

% cd $DM_HOME/install
% dm_launch_server_config_program.sh

• On Windows, log in to Windows as the Documentum installation owner.
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If the setup process on Windows does not continue automatically, follow these steps:

a. Restart the host manually.

b. After the reboot is completed, log in as the Documentum installation owner.

c. Navigate to the DM_HOME/install directory.

d. Double-click the Server_Configuration_Program.exe file.
A Welcome dialog box is displayed.

2. Click Next.
On Windows, the Installation Owner Password dialog box is displayed.

3. On Windows, provide the installation owner’s password and click Next.
The installer verifies the password.

4. If you did not enable Trusted Content Services during installation, optionally choose
to enable TCS, type in the license key, and click Next.

5. If you did not enable Content Services for EMC Centera during installation,
optionally choose to enable the feature, type in the license key, and click Next.

6. Click Custom Configuration and click Next.

7. Choose whether to configure a connection broker, a repository, or both, and click
Next.
• If you checked connection broker, the connection broker configuration dialog

box is displayed.
• If you checked repository but not connection broker, the repository configuration

dialog box is displayed. Skip to Step 9.
8. Configure a connection broker on the Content Server host.

a. Choose Create a new connection broker and click Next.

b. Type the connection broker name and the port number on which the connection
broker listens or accept the defaults.
The default port is 1489.

c. On Windows, click Automatic for automatic connection broker startup or
Manual for manual startup.
The connection broker is started.

d. Configure more connection brokers or continue to repository configuration.
• To configure more connection brokers on the Content Server host, click

Configure an additional connection broker and click Next.

Ensure that you provide each additional connection broker with a unique
port number that is not used by another application.
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• To configure a repository, click Continue with server configuration and
click Next.

e. Click Next.
The connection broker is configured and started.

9. Configure a repository on the Content Server host.

a. Click Create a new repository and then click Next.

b. To enable Content Storage Services in the repository, select the checkbox and
type in the license key, then click Next.

c. To enable Collaborative Services in the repository, select the checkbox and type
in the license key, then click Next.

d. To enable Retention Policy Services in the repository, select the checkbox and
type in the license key, then click Next
The Data Directory dialog box is displayed. The data directory is where Content
Server stores content files.

e. To enable Records Manager in the repository, select the checkbox and type in the
license key, then click Next.

f. Choose a data directory location.
• On Windows, click Next to accept the default, or click Browse to select a

different location, then click Next.
• On UNIX and Linux, click Next to accept the default, or type in a new

location, then click Next.
Do not choose a directory that is used by another repository for content file
storage or any other purpose.
The Share Directory Destination dialog box is displayed. The Share directory is
where client products, sample code, and libraries are stored.

g. Choose a share directory location.
• On Windows, click Next to accept the default, or click Browse to select a

different location, then click Next.
• On UNIX and Linux, click Next to accept the default, or type in a new

location, then click Next.
The Repository Information dialog box is displayed.

h. Type the name of the repository.
For more information on the repository name, refer to Repository name and
ID, page 35.

i. Type the repository ID.
For more information on the repository ID, refer to Repository name and ID,
page 35.
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j. Type a description of the repository.

k. Select the repository size.

l. On UNIX and Linux, type in the service name for the repository.
This is the service name you entered in the services file.

m. On Windows, select the authentication domain and server startup type.
If you select Automatic, the server starts automatically when the host is restarted.

n. Click Next.

o. Choose the mode in which clients connect to the repository.
• Check Native for unsecure connections
• Check Secure for secure connections
• Check Native and Secure if clients can use either connection mode.

10. Select whether to create a new database user account and storage areas or use an
existing user account and storage and click Next.
The database user is the repository owner.

11. If you chose to create a new database user account, provide database information.
If you are using an existing database account, skip to Step 14.

a. Choose the correct database connection string for your database instance.
• On Oracle, select the connection string from the dropdown list.
• On SQL Server, select an ODBC Datasource from the dropdown list
• On DB2, select the database name from the dropdown list
• On Sybase, select the database name from the dropdown list

b. Type the database user’s name.
The database user’s name defaults to the repository name. The user becomes
the repository owner.

c. Type the database user’s password and confirm the password.

d. Type the database administrator’s user name and password.

e. Click Next.

f. Accept the default paths and sizes for database storage or change them and
click Next.
• On Oracle, these are the Data Tablespace Data File Path and Index Tablespace

Data File Path
• On SQL Server, these are the Data Device File Path and Log Device File Path
• On Sybase, these are the Data Device File Path and Log Device File Path
• On DB2, these are the Tablespace File Path and Index Data File Path

The tablespace or database creation dialog box is displayed.

108 Content Server Installation Guide



Custom Installation

g. Edit or accept the default database scripts.
• To edit the tablespace or database creation or deletion script, select the script

and click Edit. When you have saved the file, click Next.
• To accept the default scripts and run them, click Next.

The new tablespaces or databases are created.
12. Type the connection broker connection information for the connection broker to

which you want the repository to project.
This information is used to create the server.ini file. The default connection broker
is the connection broker on the server host, but the repository can project to any
connection broker on your network.

a. Type the connection broker port number.
The port number is the port where the connection broker listens.

b. Type the connection broker host name and click Next.
The connection broker connection is tested.

13. Accept or modify the Content Server and Site Caching Services initialization files.
The server.ini file contains Content Server initialization information. The
webcache.ini file contains Site Caching Services initialization information. If
you are installing on DB2 or Oracle and you want to the database parameters
for the Documentum type tables, you must edit the server.ini file during this
step. You cannot change this after the server starts and creates the database
tables for the repository. For more information on the server.ini parameters
FUNCTION_SPECIFIC_STORAGE and TYPE_SPECIFIC_STORAGE, refer to
Appendix F, Defining Oracle or DB2 Database Parameters for Repository Tables .
• To accept the files, click Next.
• To edit the server.ini file, select Server Initialization File and click Edit. After

you save the file, click Next.
• To edit the webcache.ini file, select WebCache Initialization File and click Edit.

After you save the file, click Next.
14. If you chose to use an existing database account and tablespaces or databases,

provide database information.

a. Choose the correct database connection string for the database instance you
are using.
• On Oracle, select the connection string from the dropdown list.
• On SQL Server, select an ODBC Datasource from the dropdown list
• On DB2, select the database name from the dropdown list
• On Sybase, select the database name from the dropdown list

b. Type the database user’s name.
This is for an existing database account. The user becomes the repository owner.
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c. Type the database user’s password.

d. Click Next.

e. Choose the correct index tablespace or data file name.

f. Click Next.

15. If you are installing on Windows, provide SMTP server information.
The SMTP server is used to send email notifications to the installation owner and
repository users.

a. Type the name or IP address of a computer on your network that hosts an
SMTP Server.
The computer can be a remote host or the computer hosting Content Server. All
UNIX operating systems and Windows 2000 Server include an SMTP server.

b. Type the installation owner’s email address.

c. Click Next.
If the configuration program cannot connect with the SMTP server, a warning
message is displayed. Provide a valid host name or address for the SMTP server
or ignore the warning and proceed with the installation.

16. To use the current repository as the global registry repository, select Use this
Repository and click Next.
The global registry repository is used for storing SBOs and network locations. For
more information on the global registry and global registry user, refer to Global
registry, page 31 and Preparing for the global registry, page 56.

a. Accept the user login name of the global registry user or type in a new user
login name.

b. Type the global registry user’s password.

c. Confirm the global registry user’s password and click Next.

17. To use a different repository as the global registry repository, select Specify a
Different Repository and click Next.
The global registry repository is used for storing SBOs and network locations. For
more information on the global registry and global registry user, refer to Global
registry, page 31 and Preparing for the global registry, page 56.

a. Type the repository name.
The repository must be known to the connection broker you specified during
DFC installation.

b. Type the user login name of the global registry user for the repository.

c. Type the global registry user’s password.
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18. To designate the global registry repository at a different time, select Do Later and
click Next.

19. A warning message to enable the global registry connection is displayed. Click
CONTINUE.

20. Accept or modify the repository configuration scripts.
• To accept the files, click Next.
• To edit a script, select it and click Edit. After you edit and save all the scripts

you are modifying, click Next.

Use caution in editing the scripts. Errors in the scripts can cause problems in the
repository. For information on what each of the scripts does, refer to Appendix
D, Content Server Installation Directories and Repository Configuration Scripts.

The scripts run and the repository is configured. Click Next.

21. Choose whether to restart the repository service in order to enable SSL (secure)
client connections.
• To enable SSL (secure) client connections, click Restart repository now and click

Next.

The repository stops and is restarted.
• To restart the repository at a different time, click Restart repository later and

click Next.
22. Choose whether to configure additional repositories on the host.

• To configure additional repositories, select the checkbox and click Next, then
skip back to Step 9.

• To continue, click Next.
A dialog box with information about the products configured on the host is
displayed.

23. Click Finish.

24. On AIX, restart the repository.
This loads required full-text plugins.

25. If you created a new repository on a host where Thumbnail Server is already
installed, manually configure the base_url:

a. Determine the value of base_url.
• The base_url attribute takes the following format:

http://host:port/thumbsrv/getThumbnail?

host is the name of the host where you are installing. The value of host can
be the machine name (for example, isadora) or a fully-qualified name (for
example, isadora.mycompany.com).
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port is the primary Thumbnail Server port you provided when you installed
Thumbnail Server.

• The Thumbnail Server installation log contains the value of base_url for the
host. The log is located in %DM_HOME%\thumbsrv\install\install.log.

b. Use IDQL or Documentum Administrator to connect to the repository as a
superuser.

c. Execute the following query to set base_url:
UPDATE dm_filestore OBJECTS SET base_url='base_url' WHERE
media_type=1

base_url is the value you determined in Step a above.

d. Disconnect from the repository.

26. Start the Tomcat instance running the Java method server and ACS server using the
instructions in Starting and stopping the Java method server, page 136.
The Tomcat instance starts automatically only on Windows hosts that restart after
installation.

27. To install the full-text indexing software, refer to the instructions in the Content
Server Full-Text Indexing Installation Guide.
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Chapter 7
Installing Remote Servers in Distributed
Congurations

This chapter provides instructions for installing and configuring remote Content Servers (also known
as content-file servers) in distributed content configurations. It contains the following topics:
• Creating the server software installation on the remote host, page 113
• Configuring the remote Content Server, page 117
Before you install, review Chapter 2, Planning for Content Server Installation, Chapter 3, Preparing
for Content Server Installation, and Appendix A, Preinstallation Checklists. The remote host must
meet the same preinstallation requirements as the primary Content Server host.

If you are upgrading an existing distributed configuration, use the instructions in Upgrading a
distributed configuration, page 120. The remote Content Server configuration program cannot be
used to upgrade pre-5.3 SP1 remote servers.

Creating the server software installation on the
remote host

Creating the Server software installation on the host
The first part of the installation process copies files from the installation media to the
correct directories on your hard disk.

On Windows, this procedure also sets environment variables needed by Content Server.

If you exit the Setup part of the installation program, all Content Server registry entries
are deleted. To install a component that was not previously installed, you must go
through the complete Setup program.

To create the server installation on the host computer:

1. Log in to the host system using the installation owner account.
• OnWindows, use an account that is a member of the local Administrators group.
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On Windows, user accounts are not case-sensitive, but Content Server
installation fails if you connect to the host using the incorrect case in the user
name and password. For example, if the account is set up as JPSmith and you
connect as jpsmith, you can log in to the host, but server installation fails.

• On UNIX and Linux, connect using an account that is a member of the
Documentum and installation owner group.

To confirm the account’s group membership, type the following at the command
prompt:

Solaris:
% id -a

AIX and HP-UX:
% id

2. To install from the Documentum FTP site:

a. Navigate to the correct product directory.

b. Navigate to the server version corresponding to your operating system and
database.

3. To install from a CD:

a. Insert the CD into the CD-ROM drive.

b. On the CD, navigate to the subfolder corresponding to your operating system
and database.

4. Save the compressed distribution file from the CD or the FTP site to your hard disk.

5. Navigate to the file’s location on your hard disk.

6. Extract the file.

a. On Windows, double-click the file.

b. On UNIX and Linux, untar the file:
% tar xvf filename
The following files are extracted from the compressed file:
bofcollaborationSetup.jar
bofworkflowSetup.jar
consistency_checker.ebs
dfcoperatingsystemSetup.jar
serveroperatingsystemSetup.jar
serverWinSuiteSetup.exe (Windows) or
serveroperatingsystemSuiteSetup.bin (UNIX and Linux)
serveroperatingsystemSuiteSetup.jar
tcfSetup.jar
tomcatoperatingsystem4127Setup.jar
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7. Start the installation program.
• On Windows, double-click the file named serverWinSuiteSetup.exe.
• On UNIX and Linux, type
% serveroperatingsystemSuiteSetup.bin

and press Enter, where operatingsystem is the operating system on which you are
installing.
The Setup program starts and a Welcome dialog box is displayed.

8. Read the information on the dialog box and click Next.
The installer verifies operating system requirements. The license agreement dialog
box is displayed.

9. Click Next if you accept the terms of the license agreement.
Otherwise, the installer exits.

10. If you are installing on Windows, choose installation directories for Content Server
and DFC; if you are installing on UNIX or Linux, skip to step Step 11.

a. Click Next to accept the default Content Server installation directory or click
Browse to choose a different installation directory.
The default directory is C:\Documentum.

b. To install the DFC developer documentation, select the checkbox.

c. To install the Primary Interop Assembly, select the checkbox.
Check the Primary Interop Assembly Installer checkbox to request installation of
a Microsoft installer package (.msi file) for the DFC primary interop assembly
(PIA), or leave the box unchecked if you do not wish to have the package
installed. The installer places the installer package for the DFC PIA into the
setup subdirectory of the program root.

d. Click Next.

e. If DFC is not on the host, click Next to accept the default DFC installation
directory or click Browse to choose a different directory.
A dialog box is displayed indicating the default user directory. This directory is
used by DFC during the checkout or export of documents.

f. Click Next to accept the default User directory or click Browse to choose a
different directory.

g. Designate a repository that is a business objects framework global registry for
the DFC to use.

h. Type the global registry user’s user login name and password for the repository.
Do not check Validate Entries or the installer fails.
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11. If the primary Content Server for the repository enables Trusted Content Services,
select the checkbox and type in the Trusted Content Services license key, then click
Next.
All Content Servers in a distributed configuration must enable Trusted Content
Services or none must enable Trusted Content Services.

12. To enable Content Services for EMC Centera, select the checkbox and type in the
Content Services for EMC Centera license key, then click Next.

13. Type the port numbers for the Java method server.
• The first port is the primary port used by the Java method server (Apache

Tomcat) for communications with Content Server.

The default port is 9080.
• The second port is the port used for Tomcat administration.

The default port is 9007.
The Tomcat instance also runs the ACS server. The ports must not be used by
another application and must not be the ports used by Site Caching Services.

14. Click Next.
A panel displays the software to be installed.

15. Click Next.

16. If any components already exist on the host computer, click Yes or Yes to All. to
replace the older components.
A dialog box displays information about the products installed and their locations
and indicates that the installation is complete.

17. Click Next.
DFC and Content Server are installed.

18. If you are installing on UNIX or Linux, you are asked whether to perform the root
task, which sets file permissions for the password checking and password changing
programs.

a. To perform the task, click Yes.

b. Type the root password and press Enter.
A new window opens.

c. Provide the name of the administrator group and press Enter.
The windows closes and you are returned to the main Xterm window to continue
installation.
The Documentum Foundation Classes (DFC) Runtime Environment and
Documentum Content Server software are installed.

19. Choose whether to continue with server configuration.
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• To configure the server immediately, click Configure content-file server for use
with an existing repository and click Next.

• To configure the server at another time, click Configure Server later and click
Next.

20. Click Next.

21. On Windows, indicate whether to restart the host now or later.
The installation is not complete until the host is restarted.
• To restart the host immediately, click Yes, restart my computer and click Finish.

The host restarts.
• To restart the host at a later time, click No, restart my computer at a later time

and click Finish.

The server software installation is complete.

Conguring the remote Content Server
Use these instructions to configure the remote Content Server.

To congure the remote Content Server:

1. Start the remote Content Server configuration program.
• On Windows, the configuration program starts automatically following a reboot

of the host.

If the configuration program does not start automatically, or if you have
delete the remote server and need to reconfigure the server, navigate to
%DM_HOME%\install and double-click cfsConfigurationProgram.exe.

• On UNIX or Linux, navigate to $DM_HOME/install and type:
%dm_launch_cfs_server_config_program.sh

A Welcome dialog box is displayed.

2. Click Next.
On Windows, the Installation Owner Password dialog box is displayed.

3. On Windows, type in the installation owner’s password and click Next.

4. Type the host name of the primary connection broker for the repository and verify or
type in the port on which the connection broker listens, then click Next.
The port defaults to 1489.

5. Select the repository for which you are installing the remote Content Server, type in
the user name and password for a Superuser in that repository, and click Next.
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The repository list is populated with repositories known to the connection broker for
which you provided information in the previous step. The Superuser name defaults
to the Documentum installation owner’s name.

6. Type the name and port number for the connection broker on the current host,
indicate whether connection broker startup following a system restart is automatic
or manual, and click Next.
The default values are Docbroker and 1489. The connection broker is started.

7. Accept the default location of the data directory or browse to a different location
and click Next.
The data directory is where content files are stored in the repository.

8. Accept the default location of the share directory or browse to a different location
and click Next.
The share directory is where clients, example code, and required libraries are stored.

9. Accept the default service name for the new remote Content Server or type in a
different name click Next.

10. Click Finish.
The remote Content Server is configured and running.

11. Start the Tomcat instance running the Java method server and ACS server using the
instructions in Starting and stopping the Java method server, page 136.
The Tomcat instance starts automatically only on Windows hosts that restart after
installation.

12. Use the instructions in Enabling the Surrogate Get method in UNIX distributed
configurations, page 133 to complete the remote Content Server configuration on
UNIX.
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Upgrading Content Server

This chapter describes how to upgrade or reinstall the server from a previous version and how to
upgrade your repositories to Content Server 5.3 SP1.

This chapter contains the following topics:
• Before you upgrade, page 119
• Upgrading a distributed configuration, page 120
• Upgrading the Server software installation on the host, page 122
• Upgrading the connection broker, the Server and the repository, page 126
The Documentum System Migration Guide contains additional information on migrating your
installation from a previous version of Documentum to Documentum 5.

Before you upgrade
Before upgrading Content Server, review the Content Server Release Notes, Chapter
2, Planning for Content Server Installation, Chapter 3, Preparing for Content Server
Installation, and Chapter 4, Preparing the Database for Content Server Installation.

If you are installing the full-text indexing components, review the Content Server Full-Text
Indexing Installation Guide, and decide whether you are performing a pre-upgrade or
post-upgrade migration to the new full-text indexing system.

You can upgrade to Content Server 5.3 SP1 only from Content Server 5.2.5 (including
Service Pack releases) and Content Server 5.3. If you are running a server version earlier
than 5.2.5, you must first upgrade to 5.2.5 before you upgrade to 5.3 SP1. Refer to
documentation for server 5.2.5 for information on upgrade paths to 5.2.5.

Using dump and load operations to upgrade a repository is not supported. Only
in-place upgrade is supported.

If you have Apache Tomcat or another application server on the Content Server host
as a Java method server, stop the application server before you begin the upgrade or
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installation. On Windows, ensure that the application server does not start automatically
after a host restart.

If you are installing on UNIX or Linux, ensure that you have reviewed the information in
UNIX and Linux host preparation, page 48 about setting up the required environment
variables. For example, a new installation directory must be created and the value of
$DM_HOME must be changed to point to that directory.

There are two parts to the upgrade procedure: copying the files required for upgrading
from the product distribution CD or the Documentum FTP site and upgrading the server
and repository.

After upgrading, you cannot revert to previous versions of the server.

The length of time needed to upgrade a repository depends on the size of the repository
and can be substantial. You should allow sufficient time for backing up the repository
and performing the upgrade.

Before you upgrade, test the upgrade procedure using the instructions in Creating
a repository copy to test an upgrade, page 64 and complete the preinstallation and
upgrade checklists in Appendix A, Preinstallation Checklists.

Upgrading a distributed conguration
This section describes the overall procedure for upgrading an existing distributed
configuration to 5.3 SP1.

To upgrade a distributed conguration:

1. On the primary host, use the instructions in this chapter to upgrade the server
software, connection brokers, and repository.
The instructions are in Upgrading the Server software installation on the host, page
122 and Upgrading the connection broker, the Server and the repository, page 126.

2. On each remote host, install the new server software, using the instructions in
Upgrading the Server software installation on the host, page 122.

3. Run the Server Configuration Program, using the instructions in Upgrading the
connection broker, the Server and the repository, page 126, but cancel the process
after step 19.
Do not run the repository configuration scripts.

4. Create an acs config object in the repository for the ACS server installed with each
remote Content Server.
For example, if there are three remote Content Servers, you must create three acs
config objects.
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a. On the remote Content Server host, navigate to $DM_HOME/install/admin
(UNIX or Linux) or %DM_HOME%\install\admin (Windows).

b. Run the dm_acs_install.ebs script:
dmbasic -f dm_acs_install.ebs -e Install -- repository_name
user_name password acs_name server_config_name Java_
method_server_port acs_protocol

The parameters are described in Table 8–1, page 121. The acs config object is
created in server config mode and uses the network locations, connection broker
projection targets, and stores from the associated server config object. If you
need to change the mode to acs config mode, in which you manually set network
locations, connection broker projection targets, and stores, use Documentum
Administrator to change the mode and create the manual settings.
Do notmanually modify the new acs config object using the API or DQL.

Table 8-1. Parameters required by dm_acs_install.ebs script

Parameter Description and values

repository_name Name of the repository served by the
remote Content Server and its ACS server,
where the acs config object is being
created

user_name The user name of a user with Superuser
privileges; for example, the installation
owner

password The password for the Superuser account

acs_name The object name of the acs config object
you are creating. This may be any
arbitrary name, but the name must be
unique among the object names of acs
config objects and the server config objects
of both the primary Content Server and
any remote Content Servers.

server_config_name The object name of the server config object
of the remote Content Server
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Parameter Description and values

Java_method_server_port The port where the Java method server
on the remote server host listens, which
was provided during remote server
installation

acs_protocol The communication protocol used by the
ACS server. Valid values are http and
https.

5. If the remote Content Servers are installed in a different file-system path from the
primary server, create new site-specific location objects for locations that are new in
the upgraded repository.

a. Connect to the repository using Documentum Administrator.

b. Create site-specific dm_dba and auth_plugin location objects containing the
locations on each of the remote sites of the dba directory ($DOCUMENTUM/dba
on UNIX or Linux; %DOCUMENTUM%\dba on Windows) and the
authentication plugin.

c. In the server config object for the remote server, set the auth_plugin_location
and dba_location to the location objects you just created

6. Start the Tomcat instance running the Java method server and ACS server using the
instructions in Starting and stopping the Java method server, page 136.
The Tomcat instance starts automatically only on Windows hosts that restart after
installation.

Upgrading the Server software installation on
the host

Use these instructions to upgrade the server software installation on the host.

To upgrade the software installation:

1. Log in to the host system using the installation owner account.
• OnWindows, use an account that is a member of the local Administrators group.

On Windows, user accounts are not case-sensitive, but Content Server
installation fails if you connect to the host using the incorrect case in the user
name. For example, if the account is set up as JPSmith and you connect as
jpsmith, you can log in to the host, but server installation fails.
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• On UNIX and Linux, connect using an account that is a member of the
Documentum and installation owner group.

To confirm the account’s group membership, type the following at the command
prompt:

Solaris:
% id -a

AIX and HP-UX:
% id

2. To install from the Documentum FTP site:

a. Navigate to the correct product directory.

b. Navigate to the server version corresponding to your operating system and
database.

3. To install from a CD:

a. Insert the CD into the CD-ROM drive.

b. On the CD, navigate to the subfolder corresponding to your operating system
and database.

4. Save the compressed distribution file to the Content Server host’s hard disk.

5. Navigate to the file’s location on the host’s hard disk.

6. Extract the file.
• On Windows, double-click the file.
• On UNIX and Linux, uncompress and untar the file:

% tar xvf filename

The following files are extracted from the compressed file:
bofcollaborationSetup.jar
bofworkflowSetup.jar
consistency_checker.ebs
dfcoperatingsystemSetup.jar
serveroperatingsystemSetup.jar
serverWinSuiteSetup.exe (Windows) or
serveroperatingsystemSuiteSetup.bin (UNIX and Linux)
serveroperatingsystemSuiteSetup.jar
tcfSetup.jar
tomcatoperatingsystem4127Setup.jar

7. Run the consistency checker and correct any errors if you have not already done so:
dmbasic -fconsistency_checker.ebs -eEntry_Point_Register --
repository_name superuser password

Content Server Installation Guide 123



Upgrading Content Server

For more information on the consistency checker, refer to Running the consistency
checker, page 63.

8. Disable all jobs.
• On Windows, disable jobs in all repositories on the host.
• On UNIX and Linux, disable jobs in all repositories in the installation you are

upgrading.
9. Shut down the repositories and connection brokers.

a. To shut down the repositories and connection brokers on Windows:

i. Click Start→Programs→Documentum→Server Manager.

ii. Select the correct repository and click Stop.

iii. Click the connection broker tab.

iv. Select each connection broker.

v. Click Stop.

b. To shut down the repositories and connection brokers on UNIX or Linux:

i. For each repository, run the dm_shutdown_repository script, where repository
is the name of the repository to be stopped.

ii. Stop each connection broker using the dm_stop_connection broker utility.
For instructions, refer to Chapter 7, “The Connection Broker,” in the Content
Server Administrator’s Guide.

10. Shut down the Java method server’s Tomcat instance.
• To shut down Tomcat on Windows, stop the service called Documentum Java

method server.
• To shut down Tomcat on UNIX or Linux, run the script $DM_HOME/tomcat/

bin/shutdown.sh.
11. Start the installation program.

• On Windows, double-click the file named serverWinSuiteSetup.exe.
• On UNIX and Linux, type

% serveroperatingsystemSuiteSetup.bin

and press Enter, where operatingsystem is the operating system on which you
are installing.

A Welcome dialog box is displayed.

12. Click Next
The license agreement dialog box is displayed.

13. Click I accept the terms of the license agreement and then click Next.

124 Content Server Installation Guide



Upgrading Content Server

14. To install the DFC developer documentation and, on Windows, the Primary Interop
Assembly Installer, select the checkboxes and click Next.
Check the Primary Interop Assembly Installer checkbox to request installation of a
Microsoft installer package (.msi file) for the DFC primary interop assembly (PIA),
or leave the box unchecked if you do not wish to have the package installed. The
installer places the installer package for the DFC PIA into the setup subdirectory of
the program root.
The installation program collects information about the host and the Documentum
installation. The installation program indicates that an earlier version of the server
exists on the host and asks if you want to upgrade.

15. Click Ok.

16. To enable Trusted Content Services, select the checkbox and type in the Trusted
Content Services license key, then click Next.

17. To enable Content Services for EMC Centera, select the checkbox and type in the
Content Services for EMC Centera license key, then click Next.

18. To enable Content Storage Services, select the checkbox and type in the license key,
then click Next.

19. Type the port numbers for the Java method server and click Next.
• The first port is the primary port used by the Java method server (Apache

Tomcat) for communications with Content Server.

The default port is 9080.
• The second port is the port used for Tomcat administration.

The default port is 9007.
The ports must not be used by another application. They must not be the ports
used by Site Caching Services or the index agent, if the index agent is installed on
the Content Server host. (For complete information about the index agent, refer to
the Content Server Full-Text Indexing Installation Guide.
A panel listing the components to be installed is displayed.

20. Click Next.

21. If you are upgrading on UNIX or Linux, you are asked whether to perform the root
task, which sets file permissions for the password checking and password changing
programs.

a. To perform the task, click Yes.

b. Type the root password and press Enter.
A new window opens.

c. Provide the name of the administrator group and press Enter.

d. Click O and overwrite the files in $DOCUMENTUM/dba.
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The windows closes and you are returned to the main Xterm window to continue
installation.
The Documentum Foundation Classes (DFC) Runtime Environment and
Documentum Content Server software are installed.

. An informational dialog box is displayed listing the components to be installed.

22. Click Next.
The components are installed.

23. On Windows, choose when to configure the server.
• To configure the server immediately, choose Configure server now and click

Next.
• To configure the server at another time, choose Configure server later and click

Next.
A panel saying that the software has been installed is displayed.

24. On Windows, click Next.

25. On Windows, choose whether to restart the host now or later.
The installation is not complete until the host is restarted.
• To restart the host immediately, click Yes, restart my system and click Finish.

The host restarts.
• To restart the host at a later time, click No, restart my system at a later time

and click Finish.

Server installation is complete.

Upgrading the connection broker, the Server
and the repository

This section provides instructions for upgrading the connection brokers, Servers, and
repositories on the host. Perform this part of the upgrade after you create the installation.
On Windows, this part of the upgrade is after the system restarts.

To upgrade the repository, Content Server, and the connection broker:

1. Start the configuration program.
• On UNIX and Linux, type these commands:

% cd $DM_HOME/install
% dm_launch_server_config_program.sh

• On Windows, log in to Windows as the Content Server installation owner.
If the setup process on Windows does not continue automatically, follow these steps:
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a. Restart the host manually.

b. After the reboot is completed, log in as the Content Server installation owner.

c. Click Start→Programs→Documentum→Server Manager.

d. On the Utilities tab, click Server Configuration.
The server configuration program starts.

A Welcome dialog box is displayed.

2. If you are on Windows, type in the installation owner’s password and click Next.
The installer verifies the password.

3. Click Next.

4. Choose Custom Configuration and click Next.

5. Choose whether to upgrade a connection broker, a repository, or both and clickNext.
• If you checked Connection Broker, the Connection Broker Configuration dialog

box is displayed.
• If you checked Repository but not connection broker, the repository

Configuration Dialog box is displayed. Skip to Step 9.
6. If you did not enable Trusted Content Services during installation, optionally choose

to enable TCS, type in the license key, and click Next.

7. If you did not enable Content Services for EMC Centera during installation,
optionally choose to enable the feature, type in the license key, and click Next.

8. Upgrade a connection broker on the Content Server host.

a. Choose Upgrade an Existing Connection Broker.

b. Select the connection broker to upgrade.
The configuration program attempts to stop the existing connection broker.
If the connection broker is already stopped or if the configuration program is
unable to stop the connection broker, a dialog box is displayed stating that there
was a failure to stop the connection broker.

c. If the error message is displayed, click Yes and continue with the upgrade.
Clicking No stops the upgrade. You may also verify whether the connection
broker is running and stop it manually before clicking Yes.

d. Click Next.
The connection broker is upgraded.

e. Choose whether to upgrade additional connection brokers on the local host or
continue with server configuration.

f. If you are upgrading additional connection brokers, perform steps a-d as
required.
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g. Click Next.
The Repository Configuration dialog box is displayed.

9. Choose Upgrade Existing Repository, select the repository, and click Next.

10. To enable Content Storage Services in the repository, select the checkbox and type in
the license key, then click Next.

11. To enable Collaborative Services or Collaborative Services with Rooms in the
repository, select the checkbox and type in the license key, then click Next.

12. To enable Retention Policy Services in the repository, select the checkbox and type in
the license key, then click Next.
The configuration program attempts to stop the existing repository. If the repository
is already stopped or if the configuration program is unable to stop the repository, a
dialog box is displayed stating that there was a failure to stop the repository.

13. If the error message is displayed, click Yes and continue with the upgrade.
Clicking No stops the upgrade. You may also verify whether the repository is
running and stop it manually before clicking Yes.

14. Provide connection information for the connection broker to which the repository
projects.

a. Type the connection broker port number.
The port number is the port where the connection broker listens. The default
is 1489.

b. Type the connection broker host name.

c. To test the server’s ability to connect to the connection broker, check Test
Connection Broker.

d. Click Next.

15. Choose the mode in which clients connect to the repository.
• Click Native for unsecure connections
• Click Secure for secure connections
• Click Native and Secure if clients can use either connection mode

16. Choose whether to accept or modify the server.ini and webcache.ini files.
In general, this is not necessary.
• To edit the server.ini file, select Server Initialization File and click Edit.
• To edit the webcache.ini file, select Site Caching Services Initialization File

and click Edit.
• To accept the files, or after you edit either or both of the files, click Next.
The repository service starts.

17. If you are installing on Windows, provide SMTP server information.
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The SMTP server is used to send email notifications to the installation owner and
repository users.

a. Type the name or IP address of a computer on your network that hosts an
SMTP Server.
The computer can be a remote host or the computer hosting Content Server. All
UNIX operating systems and Windows 2000 Server include an SMTP server.

b. Type the installation owner’s email address.

c. Click Next.
If the configuration program cannot connect with the SMTP server, a warning
message is displayed. Provide a valid host name or address for the SMTP server
or ignore the warning and proceed with the installation.

18. To use the current repository as the global registry repository, select Use this
Repository and click Next.
The global registry repository is used for storing SBOs and network locations. For
more information on the global registry and global registry user, refer to Global
registry, page 31 and Preparing for the global registry, page 56.

a. Accept the user login name of the global registry user or type in a new user
login name.

b. Type the global registry user’s password.

c. Confirm the global registry user’s password and click Next.

19. To use a different repository as the global registry repository, select Specify a
Different Repository and click Next
The global registry repository is used for storing SBOs and network locations. For
more information on the global registry and global registry user, refer to Global
registry, page 31 and Preparing for the global registry, page 56.

a. Type the repository name.
The repository must be known to the connection broker you specified during
DFC installation.

b. Type the user login name of the global registry user for the repository.

c. Type the global registry user’s password.

20. To designate the global registry repository at a different time, select Do Later and
click Next.

21. Choose whether to accept or modify the repository configuration scripts.
In general, you do not need to edit these scripts.
• To accept the scripts, click Next.
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• To edit a script, select it and click Edit. After you edit and save the scripts, click
Next.

The scripts run and the repository is configured.

22. Choose whether to configure additional repositories on the host.
• To configure additional repositories, select the checkbox and click Next, then

skip back to Step 9.
• To continue, click Exit from server configuration and click Next.

23. Click Finish.
The upgrade process is complete.

24. Start the Tomcat instance running the Java method server and ACS server using the
instructions in Starting and stopping the Java method server, page 136.
The Tomcat instance starts automatically only on Windows hosts that restart after
installation.

25. If you created new full-text indexes before upgrading the server, perform these tasks
using the instructions in the Content Server Full-Text Indexing Installation Guide:

a. Shut down the existing index agent, which is migration mode.

b. Convert the index agent to normal mode using the Index Agent Administration
Tool.

26. To create the new indexes after upgrading the server and repository, use the
instructions in the Content Server Full-Text Indexing Installation Guide.
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Postinstallation Tasks

This chapter describes what to do before users can begin working with a repository. It includes
information about both required and optional activities.

This chapter contains the following major topics:
• Reviewing the server installation logs, page 131
• Enabling a repository as a global registry, page 132
• Enabling the Surrogate Get method in UNIX distributed configurations, page 133
• Running dm_root_task manually on UNIX or Linux systems, page 134
• SMTP server on Windows, page 134
• Changing the default passphrase, page 134
• Administrative tool script, page 135
• Starting and stopping Content Servers and connection brokers, page 135
• Starting and stopping the Java method server, page 136
• Adding users and groups to a repository, page 137
• Enabling jobs after installation , page 138
• Changing the installation owner account , page 139
• The assume user and change password programs, page 139
• Backing up key store files, page 140
• Creating additional repositories or connection brokers, page 140

Reviewing the server installation logs
The Content Server installer and configuration program both create log files.

The log files may be stored in:

1. The current working directory.
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For the configuration program, this is typically $DM_HOME/install (UNIX) or
%DM_HOME%\install (Windows). For the installer, this is the location from which
you run the installer, if the installation owner is able to write to that location. (For
example, if the installer is run from a CD, the installation location is not writable.)

2. The parent directory of the installation location, if the installation owner does not
have write permission on the current working directory or if the location is not
writable

3. The user’s home directory, if the installation owner does not have write permission
on the parent directory or if the location is not writable

The file names are installation_owner_username.ServerInstaller.log and
installation_owner_username.ServerConfigurator.log.

Each script that runs during repository configuration creates a log file. These are stored
in the $DOCUMENTUM/dba/config/repository_name directory.

Content Server stores other log files in the $DOCUMENTUM/dba/log directory. After
you install or upgrade the server, examine the log file for the repository for error reports.
The log is called repository_name.log.save.date.time, where repository_name is the name
of the repository you created or upgraded, and date and time are the date and time the
log was saved.

Another log file is $DM_HOME/install/SetupError.log, which contains information on
the operating system environment, the server version, Java environment, and hardware.

Enabling a repository as a global registry
To enable a repository as a global registry after configuration, you must activate the
dm_bof_registry user.

To enable a repository as a global registry:

1. Access Documentum Administrator in a browser and connect to the repository.

2. Click Administration→User Management→Users.

3. Locate the user named dm_bof_registry and click the Information icon.

4. Verify that the user name attribute is set to dm_bof_registry.
The value dm_bof_registry is required.

5. Optionally, change the user login name to a new value.

6. Change the user’s password.

7. Set the dm_bof_registry user’s status to Active.

132 Content Server Installation Guide



Postinstallation Tasks

8. Click Ok to save the user.

9. During DFC installation on client machines, such as the Webtop or Documentum
Administrator hosts, provide the user login name and password.
This updates the dfc.properties file and enables that DFC installation to contact
the global registry as required.

10. To manually modify the dfc.properties file to designate a global registry repository
and user credentials:

a. On the DFC host, navigate to $DOCUMENTUM/config (UNIX or Linux) or
%DOCUMENTUM%\config (Windows).

b. From a command prompt, execute the following command to generate the
encrypted form of the global registry user’s password:
java -cp dfc.jar com.documentum.fc.tools.RegistryPasswordUtils
password_of_user
where password_of_user is the global registry user’s clear-text password. In
step d below, you will need to enter the encrypted form of this password in
the dfc.properties file.

c. Open the dfc.properties file in a text editor.

d. Modify the following attributes:
dfc.bof.registry.repository=global_registry_repository_name
dfc.bof.registry.username=user_login_name
dfc.bof.registry.password=encryped_password_of_user
where encryped_password_of_user is the encrypted password you generated in
step b above.

e. Save the dfc.properties file.

Enabling the Surrogate Get method in UNIX
distributed congurations

In UNIX distributed configurations, after installing any remote Content Servers and
adding the file stores at the remote sites to the distributed store, use Documentum
Administrator to set the get method for each component of the distributed store to
Surrogate Get.
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Running dm_root_task manually on UNIX or
Linux systems

If dm_root_task does not execute correctly during Content Server installation, the
file permissions are incorrect on the dm_check_password and dm_change_password
programs, which are required for user authentication. You can run the dm_root_task
script manually.

To run the dm_root_task manually:

1. Log in as the root user.

2. Navigate to the $DOCUMENTUM/dba directory.

3. Run the task:
dm_root_task
The script runs.

4. Type the name of the administrators group and press return.
The permissions on the files are changed.

SMTP server on Windows
If you did not supply a valid SMTP server host name during installation, use IDQL or
Documentum Administrator to add a valid SMTP server host name to the smtp_server
attribute of the server config object. Reinitialize the server after you update the server
config object.

Changing the default passphrase
During Content Server installation, a keystore is created containing a passphrase that is
used for encryption. After installation, we recommend changing the default passphrase
to a custom passphrase. For instructions and more information on encryption, keystores,
and passphrases, refer to Chapter 12, Protecting Repository Objects, in the Content Server
Administrator’s Guide.

If you create a custom passphrase after server installation, any time you restart the server
host you must run the dm_crypto_boot utility. For more information on this utility, refer
to Chapter 12, Protecting Repository Objects, in the Content Server Administrator’s Guide.

134 Content Server Installation Guide



Postinstallation Tasks

Administrative tool script
During repository configuration, if the administrative tool script does not run properly
and you see an error message, you can run it manually using the steps below.

To complete the installation and run the administrative tool script:

1. Click OK to close the error message.

2. On the dialog box, uncheck the Run Script Again box and click Next.

3. Complete the installation.

4. Run this command, substituting the path to $DOCUMENTUM for $DOCUMENTUM,
the name of your repository for repository_name, and the database connection string
for database_connection_string:
dmbasic -f$DOCUMENTUM\product\5.3\install\admin\toolset.ebs
-P repository_name $DOCUMENTUM\product\5.3\install\admin
database_connection_string -e ToolSetup

For example, if the path to $DOCUMENTUM is c:\Documentum, the
repository name is TestARepository, and the database connection string is
tweezer.documentum.com:
dmbasic
-f c:\DOCUMENTUM\product\5.3\install\admin\toolset.ebs -P TestArepository
c:\DOCUMENTUM\product\5.3\install\admin tweezer.documentum.com -e ToolSetup

Starting and stopping Content Servers and
connection brokers

If an index agent and index server are running against a particular repository, start the
software components in this order:

1. Start the Content Servers.

2. Start the index server.

3. Start the index agent.

Shut down the software in this order:

1. Shut down the index agent.

2. Shut down the index server.

3. Shut down the Content Servers.
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On Windows systems, start and stop servers and connection brokers from the Server
Manager tool. To access the tool, click Start→Programs→Documentum→Server
Manager. On the correct tab, select the repository or connection broker and click Start or
Stop. You can also launch the server configuration program from Server Manager and
use it to create additional repositories or connection brokers in the installation, uninstall
existing repositories or connection brokers, and modify the existing repositories.

On UNIX and Linux systems, start servers with the dm_start_serverconfigname script,
where serverconfigname is the object name of the particular Content Server’s server config
object. To stop servers, use the dm_shutdown_serverconfigname script. Both scripts are
located in the $DOCUMENTUM/dba directory.

If you create a custom passphrase after server installation, any time you restart the server
host you must run the dm_crypto_boot utility. For more information on this utility, refer
to Chapter 12, “Protecting Repository Objects,” in the Content Server Administrator’s Guide.

Starting and stopping the Java method server
Apache Tomcat, in which the Java method server and ACS server run, is installed
when a Content Server installation is created. Tomcat does not start automatically after
installation except on a Windows host that restarts after installation. You must manually
start the Java method server on UNIX and Linux host and on any Windows host that
does not restart after installation.

Use these instructions for starting and stopping Tomcat.

For complete information on running Java methods with Tomcat, refer to the
“Application Server” section of Chapter 4, “Methods and Jobs,” in the Content Server
Administrator’s Guide.

On Windows

On Windows, Tomcat is installed and runs as a service. It is installed with the startup
property set to Automatic.

To start Apache Tomcat:

1. Click Start→Programs→Administrative Tools→Services.

2. On the Services dialog box, scroll to Documentum Java method server.

3. Right-click Documentum Java method server.

4. Click Start.
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5. Close the Services dialog box.

To stop Apache Tomcat:

1. Click Start→Programs→Administrative Tools→Services.

2. On the Services dialog box, scroll to Documentum Java method server.

3. Right-click Documentum Java method server.

4. Click Stop.

5. Close the Services dialog box.

On UNIX and Linux

On UNIX and Linux, you must use scripts to start and stop Tomcat. It does not start or
stop automatically when the host is restarted.

To start Apache Tomcat:

1. Connect to the Content Server host as the Documentum installation owner.

2. Navigate to the $DM_HOME/tomcat/bin/ directory.

3. Run the startup.sh script.

To stop Apache Tomcat:

1. Connect to the Content Server host as the Documentum installation owner.

2. Navigate to the $DM_HOME/tomcat/bin/ directory.

3. Run the shutdown.sh script.

Adding users and groups to a repository
When a repository is created, it contains accounts for the repository owner, installation
owner, and several users required for server functionality, but no other users and no
groups. The installation owner must add users and groups to the repository. The
easiest way to add users and groups is with Documentum Administrator. You can
only use Documentum Administrator 5.3 SP1 and up with a 5.3 SP1 repository. For
information on installing Documentum Administrator 5.3 SP1, refer to theWDK and
WDK Applications Installation Guide. For information on creating users and groups, refer
to online Help for Documentum Administrator and to the chapter called Users and
Groups in the Content Server Administrator’s Guide.
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Enabling jobs after installation
Jobs are automated tools for performing repository maintenance tasks. When the
repository is installed, many jobs are in the inactive state and do not run until the state
is changed to active. After you install, review the chapter “Tools and Tracing” in the
Content Server Administrator’s Guide and Documentum Administrator online Help and
active jobs as necessary.

See the sections below for more information on these subjects:
• Update Statistics, page 138
• Enabling the Purge Audit job, page 138
• Enabling the Log Purge job, page 138

Update Statistics

The Update Statistics tool (dm_UpdateStats) generates current statistics for the RDBMS
tables.

Generating statistics is always useful, particularly after you perform load operations or if
table key values in the underlying RDMBS tables are not normally distributed.

The Update Statistics tool is installed in the active state. It runs once per week. Verify
its scheduled run time to ensure that it runs during a time when the repository is not
being heavily used, such as Saturday night.

Enabling the Purge Audit job

The Purge Audit job deletes old audit trail objects from the repository. The job runs as
the installation owner. However, when a repository is created, the installation owner is
not granted sufficient extended privileges to run the job.

After you create a repository, create a new user with Superuser privileges, connect as
that user, and grant the installation owner account PURGE AUDIT extended privileges.

Enabling the Log Purge job

Content Server, the connection broker, the agent exec process, jobs, lifecycles, and
sessions all store reports and logs in the repository and on the server host file system.
These reports can take up a considerable amount of space in the repository. The Log
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Purge job automates deleting old logs and reports. The Log Purge job is installed in the
inactive state and must be activated for each repository after installation.

Changing the installation owner account
By default, the user account from which you install Content Server becomes the
installation owner. After installing Content Server and configuring the repositories, you
may want to identify a different account as the installation owner.

To change the installation owner:

1. Create a new user to replace the current installation owner.
For information about creating users, refer to online Help for Documentum
Administrator.

2. on UNIX or Linux, set the required environment variables in the new installation
owner’s environment.
Refer to UNIX and Linux host preparation, page 48 for information on this.

3. Log in using the current installation owner account.

4. Stop all repositories on the host.

5. Stop all connection brokers on the host.

6. Set the appropriate value for the new installation owner by editing
the value of install_owner in the server.ini file, which is located at
$DOCUMENTUM/dba/config/repository_name/server.ini:
install_owner=new_dmadmin

7. Change the permissions in the data, dba, product, full-text, and share subdirectories
of the DOCUMENTUM installation root directory.

The assume user and change password
programs

The assume user and change password programs are two programs that Documentum
provides and implements by default for your installation.
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Assume user

The assume user program is called whenever a client (end user or application) executes a
DO_METHOD function for a procedure for which the run_as_server attribute is set to
FALSE. When the procedure is executed (and the server knows where to find the assume
user program), the server runs the procedure as the logged-in user. If the server cannot
find the assume user program because assume_user_location is set to null, or if the
run_as_server attribute is set to TRUE, the procedure executes under the server’s account.

This feature is enabled by default. The Setup program copies the assume user program
to the $DOCUMENTUM/dba directory and sets the assume_user_location attribute of
the server config object to this location.

If you want to disable this feature, set the assume_user_location attribute in the
server config object to blank and reinitialize the server. Refer to the Content Server
Administrator’s Guide for instructions about changing the server’s configuration.

Change Password

Change password is called whenever the server receives a request to change a password.

This program is copied by the Setup program to $DOCUMENTUM/dba. The installation
script also sets the change_password_location attribute of the server config object to
point to the file in $DOCUMENTUM/dba.

If you want to disable this capability, set the change_password_location attribute to
blank and reinitialize the server. Refer to the Content Server Administrator’s Guide for
instructions on changing a server’s configuration.

Backing up key store les
After you install the Server and repository, back up the key store files. These are all files
in $DOCUMENTUM/dba/secure.

Creating additional repositories or connection
brokers

To create additional repositories or connection brokers in a particular Content
Server installation on Windows, use the Documentum Server Manager
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(Start→Programs→Documentum→Documentum Server Manager). On the Utilities
tab, click Server Configuration Program, then use the instructions in Configuring the
Server and repository, page 95 for express configuration or in Configuring the Server and
repository , page 105 for custom configuration to create new repositories or connection
brokers.

On UNIX or Linux, start the Server configuration program
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Chapter 10
Uninstalling Content Server

This chapter explains how to delete a repository or connection broker and how to remove an existing
server installation. Do not remove an existing installation to upgrade to a new Documentum release,
because all upgrades are in-place upgrades. Use the procedures in this chapter only if you want to
remove an existing server, a repository and its contents, a connection broker, or a server software
installation.

This chapter contains the following information:

• Requirements, page 143
• Order of uninstalling, page 143
• Deleting a remote Content Server, page 144
• Deleting a repository, page 145
• Deleting a connection broker, page 146
• Uninstalling a Content Server software installation, page 147

Requirements
To delete a repository or connection broker or uninstall Content Server, you must:

• Be able to log in as the Documentum installation owner
• Have sufficient RDBMS privileges to drop tablespaces or databases

Order of uninstalling
You must use a particular order to uninstall Content Server, a repository, the index
agent, and the index server.

To uninstall an index agent, the repository it serves must be running. To uninstall
an index server, the repository must be shut down. If the index server is on the
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Content Server host, additional issues arise because of shared libraries in the software
installations.

Uninstall the software components in this order:

1. Shut down and uninstall the index agent.

2. Shut down the repository.

3. Shut down and uninstall the index server.

4. Delete the repository, if required.

5. Uninstall the Content Server software, if required.

6. Uninstall the Index Agent Configuration Program, if required.

Deleting a remote Content Server
Use these instructions to delete a remote Content Server and its software installation in a
distributed content environment. These instructions only delete the remote server. They
do not delete the repository or affect the primary Content Server for the repository.

To delete the server, you must be able to log in as the Documentum installation owner.
On Windows, do not use the server manager program to uninstall the server. It launches
the configuration program for primary Content Servers, not remote Content Servers.

Before you delete the software installation, you must also delete any connection brokers
on the host. Use the instructions in Deleting a connection broker, page 146.

To delete a remote Content Server:

1. Log in to the host as the Content Server installation owner.

2. Navigate to the $DM_HOME/install directory (UNIX or Linux) or
%DM_HOME%\install folder (Windows).

3. Start the remote Content Server configuration program.
• On Windows, double-click cfsConfigurationProgram.exe.
• On UNIX or Linux, navigate to $DM_HOME/install and type:

%dm_launch_cfs_server_config_program.sh

A Welcome dialog box is displayed.

4. Click Next.

5. On Windows, type in the installation owner’s password and click Next.

6. Select Delete Content-File Server and click Next.

7. Type the installation owner’s name and password and click Next.
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The service is deleted.

8. Click Finish.

To delete the server software installation from the remote host:

1. Navigate to $DOCUMENTUM/_uninst/Server (UNIX or Linux) or
%Documentum%\_uninst\Server (Windows)

2. Run the server uninstaller:
• On Windows, double-click uninstall.exe.
• On UNIX, type:

uninstaller.bin.

Deleting a repository
Use these instructions to delete a repository.

To delete a repository you must:
• Be able to log in as the Documentum installation owner
• Have sufficient RDBMS privileges to drop tablespaces or databases.
To delete a repository:

1. Log in to the host as the Content Server installation owner.

2. Start the Server configuration program.
• OnWindows, click Start→Documentum→Server Manager, select the repository,

and click Delete.
• On UNIX and Linux, navigate to the $DM_HOME/install directory and run the

Server_Configuration_Program.bin program.
The Server configuration program starts.

3. Click Next.

4. On Windows, provide the installation owner password and click Next.

5. Choose Custom Installation and click Next.

6. Choose Create New, Upgrade, or Delete Repositories and click Next.

7. ChooseDelete an Existing Repository, select the repository to delete, and clickNext.
You are asked if you want to delete the component.

8. Click OK.
The installer stops the repository and provides the location of the tablespace or
database deletion script.
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This is $DOCUMENTUM/server_uninstall/delete_db/repository_name, where
repository_name is the name of the repository.

9. Click Ok.

10. Indicate whether to configure another repository or exit from the configuration
program and click Next.
An information dialog box is displayed.

11. Click Finish.

12. From the RDBMS, drop the database tables associated with the repository.

Deleting a connection broker
Use these instructions to delete a connection broker.

To delete a connection broker, you must be able to log in toWindows as the Documentum
installation owner.

To delete a connection broker:

1. Connect to the host as the Content Server installation owner.

2. Start the Server configuration program.
• On Windows, click Start→Documentum→Server Manager→Connection

Broker, select the connection broker, and click Delete.
• On UNIX and Linux, navigate to the $DM_HOME/install directory and run the

Server_Configuration_Program.bin program.
3. Click Next.

4. On Windows, provide the installation owner password and click Next.

5. Choose Custom Installation and click Next.

6. Choose Create New, Upgrade, or Delete Connection Brokers and click Next.

7. Choose Delete an Existing Connection Broker, select the connection broker to
delete, and click Next.
You are asked if you want to delete the component.

8. Click OK.

9. Indicate whether to configure another connection broker or exit from the
configuration program and click Next.
An information dialog box is displayed.

10. Click Finish.
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Uninstalling a Content Server software
installation

Use these instructions to uninstall the Content Server software from a host. You can only
uninstall the software after deleting all of the repositories and connection brokers in
the installation. Use the instructions in Deleting a repository, page 145 and Deleting a
connection broker, page 146 to delete the repositories and connection brokers.

To uninstall the server software:

1. Delete all repositories and connection brokers in the installation.
Use the instructions in Deleting a repository, page 145 and Deleting a connection
broker, page 146.

2. On Windows:

a. Click Start→Settings →Control Panel→Add/Remove Programs.

b. Select Content Server and click Remove.

c. Optionally, remove the DFC Runtime Environment.
Refer to the documentation for DFC for instruction on how to uninstall it. If you
install a new version of Content Server, the correct version of DFC is installed.

3. On UNIX and Linux:

a. Navigate to the $DOCUMENTUM/_uninst/Server directory.

b. Run the server uninstaller:
uninstaller.bin.

c. Optionally, navigate to $DOCUMENTUM_SHARED/_uninst/dfc and remove
the DFC Runtime Environment:
uninstall.bin

Refer to the documentation for DFC for complete instructions on how to
uninstall.
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Appendix A

Preinstallation Checklists

Use these checklists to ensure that you have all required information and have performed all required
tasks before you install or upgrade the server. There are checklists for Content Server installation
and for database installation and configuration.

• Content Server checklists, page 149, including:

— Preinstallation checklist, page 150

— Preupgrade checklist, page 152

— Content Server installation checklist, page 154

— New repository creation checklist, page 155

— Full-text indexing checklist, page 156

— Repository upgrade checklist, page 158

— Connection broker configuration checklist, page 159
• Database checklists, page 159, including:

— Oracle checklist, page 160

— SQL Server checklist, page 160

— Sybase checklist, page 162

— DB2 checklist, page 162

Content Server checklists
Review these checklists before you install or upgrade Documentum Content Server.
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Preinstallation checklist

Before you install Content Server or configure a repository™, complete the following
tasks:

Table A-1. Preinstallation tasks

Requirement For More Information Completed?

Review the Content Server
Release Notes for the server
release you are installing or
upgrading.

The current release notes are on the
server products CD in PDF format
and on the FTP site.

Validate your hardware
configuration

Content Server Release Notes

Validate your operating
system

Content Server Release Notes

Validate your operating
system-database
combination

Content Server Release Notes

Ensure that the server
host’s video card uses a
minimum of 256 colors.

Documentation for the host computer

On UNIX and Linux hosts,
ensure that at least 2 MB of
shared memory is allocated
and that semaphores are
enabled.

Shared memory and semaphore
requirements, page 51

For new installations,
ensure that the RDBMS
is installed and running
properly.

Chapter 4, Preparing the Database
for Content Server Installation.

If you are upgrading a repository,
refer to Chapter 8, Upgrading
Content Server, for information on
the database code page.

For an upgrade, review
any special database
requirements

Chapter 8, Upgrading Content Server
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Requirement For More Information Completed?

If you are installing on
Oracle or DB2, decide
whether to configure the
database for improved
performance. Note that
this must be done before
Content Server is started.

System performance and database
parameters on Oracle and DB2, page
72 and Appendix F, Defining Oracle
or DB2 Database Parameters for
Repository Tables

Decide whether to install
a small, medium, or large
repository.

Repository size, page 29

On Windows, obtain the
name of the host where
the SMTP server is located
that the Server will use for
email notifications.

Other required software, page 22

Documentation for Windows 2000

Decide whether to use
the express or custom
configuration option.

Express or custom configuration,
page 28

Decide whether to install a
distributed configuration.

Installing a distributed configuration,
page 30 and the Documentum
Distributed Configuration Guide

Decide whether to use
a Lightweight Delivery
Access Protocol (LDAP)
directory server.

Appendix C, “Using an LDAP
Directory Server,” in the Content
Server Administrator’s Guide and
Content Server Release Notes

Decide whether to enable
Trusted Content Services

Trusted Content Services, page 33

Decide whether to enable
Content Services for EMC
Centera

Content Services for EMC Centera,
page 33

Decide whether to enable
Content Storage Services

Content Storage Services, page 34

Decide whether to enable
Content Collaborative
Services

Collaborative Edition, page 34

Decide whether to enable
Retention Policy Services

Retention Policy Services, page 35
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Requirement For More Information Completed?

Decide the names of any
new repositories you are
configuring.

Repository name and ID, page 35

Decide whether to create
the repository owner
account and database
storage areas manually or
allow the installer to create
them.

Review the section on the repository
owner in Windows host preparation,
page 41 or UNIX and Linux host
preparation, page 48; consult your
database administrator.

Create any necessary
accounts and groups on the
operating system and in
the database.

Windows host preparation, page
41 and UNIX and Linux host
preparation, page 48

On UNIX and Linux, create
any required services file
entries. .

Setting up the services file, page 55

Ensure that Java is installed
on the Content Server host.

Refer to the Content Server Release
Notes and DFC Release Notes for
information about the required Java
version.

Review the Documentum-
specific information for
your database.

Chapter 4, Preparing the Database
for Content Server Installation and
Database checklists, page 159

If you are installing a
distributed configuration,
ensure that all computers
in the configuration are set
to the same UTC time.

Refer to documentation for the
computer systems.

Preupgrade checklist

If you are upgrading a repository, review this additional checklist:
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Table A-2. Preupgrade checklist

Task For More Information Completed?

Review the Documentum
System Migration Guide.

Documentum System
Migration Guide.

Back up the repository. Documentum Content Server
Administrator’s Guide

Decide whether to enable
Trusted Content Services

Trusted Content Services,
page 33

Decide whether to enable
Content Services for EMC
Centera

Content Services for EMC
Centera, page 33

Decide whether to enable
Content Storage Services

Content Storage Services,
page 34

Decide whether to enable
Content Collaborative
Services

Collaborative Edition,
page 34

Temporarily increase the
amount of rollback space
available in your RDBMS.

The number of rollback
segments should be
commensurate with the
size of your repository and
should be in segments of
equal size.

Documentation for your
database.

Ensure that you have
sufficient disk space on
the computer hosting the
database.

Run the repository
consistency checker script
and correct any errors you
find.

Content Server
Administrator’s Guide
and Chapter 8, Upgrading
Content Server

Optionally, migrate the
database to UTF-8.

Documentation for your
database and Chapter 4,
Preparing the Database for
Content Server Installation
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Task For More Information Completed?

Shut down the repository
and all servers running
against the repository.

Content Server
Administrator’s Guide

Shut down any local
connection brokers.

Content Server
Administrator’s Guide

OnWindows, set the service
representing the repository
you are planning to upgrade
to manual rather than
automatic.

On UNIX and Linux,
create the new installation
directory for the upgraded
installation under the
$DOCUMENTUM/product
directory (the new
$DM_HOME directory).

UNIX and Linux host
preparation, page 48

OnUNIX and Linux, modify
the DM_HOME variable
in the installation owner’s
.cshrc or .profile file to
point to $DOCUMENTUM/
product/version_number.

UNIX and Linux host
preparation, page 48

OnUNIX and Linux, modify
the library path variable in
the installation owner’s
.cshrc or .profile file to point
to the location of the shared
libraries required by the
server.

UNIX and Linux host
preparation, page 48

Content Server installation checklist

Before you install the server software on your system, complete the following tasks:
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Table A-3. Installation checklist

Task For More Information Completed?

Determine the
Documentum installation
owner user name and
password.

Windows host preparation,
page 41 and UNIX and
Linux host preparation,
page 48

On UNIX and Linux,
optionally create the
installation directory

UNIX and Linux host
preparation, page 48

OnUNIX and Linux, obtain
the root password

This is the operating system
root password. The root
password is required to
complete the installation.

New repository creation checklist

Before you create a new repository, complete the following tasks:

Table A-4. New repository preinstallation checklist

Task For More Information Completed?

Determine the
Documentum installation
owner user name and
password

Windows host preparation, page
41 and UNIX and Linux host
preparation, page 48

On UNIX and Linux,
obtain the root password

Choose the repository
name

Repository name and ID, page 35

Choose the repository ID Repository name and ID, page 35

Obtain the repository
owner name (database
user) and password

Windows host preparation, page
41 and UNIX and Linux host
preparation, page 48

Obtain the database
administrator name and
password

Database administrator account,
page 72 and your database
administrator
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Task For More Information Completed?

On Oracle, set up the
networking parameters

Oracle requirements, page 73

On DB2, obtain database
alias name

DB2 requirements, page 81

Create an estimate of
your repository size
(small, medium, or large)

Repository size, page 29

On SQL Server,
determine the data file
size you need

This information is required if the
server Setup program creates the
SQL Server account.

On SQL Server,
determine the log file
size you need

This information is required if the
server Setup program creates the
SQL Server account.

On Windows, determine
the Windows domain
where Documentum
users are authenticated

Windows only. This domain is
the default domain if users do not
specify a Windows domain when
they connect. Choose the domain
with the largest number of users.

Determine the port
numbers to be used
by the repository and
connection broker

The default connection broker
port is 1489. For information on
port numbers under UNIX, refer
to Setting up the services file,
page 55.

Full-text indexing checklist

Before installing a new server and repository or upgrading an existing repository,
complete the following checklist, which contains a list of tasks that must be performed in
order to prepare for implementing full-text indexing. For more information, refer to the
Content Server Full-Text Indexing Installation Guide.
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Table A-5. Checklist for full-text indexing

Task For More Information Completed?

Determine whether to
install the index agent
and index server on the
Content Server host or
remotely

Determine the port
numbers the index agent
uses

Determine the base port
the index server uses

Ensure that 4,000 ports
above the base port
number are unused and
available for index server
(for example, if the base
port number is 3,000, port
numbers from 3,000 to
7,000 must be available)

Determine the user
account(s) to use for
installing the index agent
and index server

Ensure that the user
accounts are set up

Network administrators

For a Content Server
upgrade, decide whether
to migrate the indexes
before or after the
server and repository
are upgraded

Determine where the
full-text indexes are to be
created and stored

Ensure that any additional
hosts required by the index
agent and index server are
configured
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Task For More Information Completed?

Mount the drive where the
content files are located
to make the content
accessible to the index
server(s)

Documentation from the
hardware and operating
system vendors

Determine for
which languages to
require grammatical
normalization

After new indexes are
created as part of an
upgrade, verify that
the new indexes are
functioning correctly

Content Server Full-Text
Indexing Installation Guide

Repository upgrade checklist

Before you upgrade a repository, perform the following tasks and review information
in Chapter 8, Upgrading Content Server.

Table A-6. Preinstallation checklist for upgrading a repository

Task For More Information Completed?

Determine the
Documentum installation
owner user name and
password

Windows host preparation,
page 41 and UNIX and
Linux host preparation,
page 48

On UNIX and Linux,
determine the root
password

On UNIX and Linux only.
This is the operating
system root password. The
root password is required
to complete the upgrade.

Determine the names of
the repositories you are
upgrading

Determine the
Documentum version from
which you are upgrading
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Task For More Information Completed?

Determine whether to
enable Content Server
features that may not be
enabled in the repository,
such as Retention Policy
Services, Collaborative
Services, Trusted Content
Services, and Content
Storage Services.

Determine which full-text
indexing configuration to
use.

Content Server Full-Text
Indexing Installation Guide

Connection broker conguration checklist

Before configuring a connection broker, perform the following tasks:

Table A-7. Connection broker conguration preinstallation checklist

Task For More Information Completed?

Determine the host name
where the connection
broker will run

Determine the
Documentum installation
owner name and password

Windows host preparation,
page 41 and UNIX and
Linux host preparation,
page 48

Determine the port number
the connection broker will
use

Database checklists
Review the checklist for your relational database management system before you install
and configure the repository’s database.
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Oracle checklist

Review this checklist when you configure Oracle.

Table A-8. Oracle preinstallation checklist

Task For More Information Completed?

For new Oracle
installations, install the
instance with the UTF-8
code page.

Oracle documentation

Determine whether to
migrate an existing Oracle
instance to UTF-8.

Oracle documentation

Ensure that the database
aliases are in the
tnsnames.ora file on the
Content Server host.

Oracle documentation and
Oracle database aliases,
page 74

Ensure that the Oracle
Listener is running on the
Oracle host.

Oracle documentation

Ensure that the
Oracle optimizer
meets Documentum
recommendations.

Oracle optimization, page
74

Decide whether to
configure the database
for improved performance.

System performance and
database parameters on
Oracle and DB2, page 72

SQL Server checklist

Review this checklist when you configure SQL Server.
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Table A-9. SQL Server checklist

Task For More Information Completed?

Configure ODBC. Configuring anODBCData
Source for SQL Server, page
76

Use a full SQL Server
installation using the
Custom option.

SQL Server documentation

Ensure that case-sensitivity
is enabled in SQL Server.

Configuring SQL Server
Case Sensitivity, page 76

Ensure that the SQL
Server sort order is set to
Dictionary.

Ensure that row-level
locking is enabled.

If SQL Server uses
Windows authentication,
ensure that the installation
owner has system
administrator privileges in
SQL Server.

Ensure that the
Documentum repository
owner and installation
owner meet the
requirements.

SQL Server requirements,
page 75

Install the SQL Server client
on the Content Server host.

SQL Server documentation

If SQL Server is installed
remotely, install Microsoft
Data Access Components
2.71 on the Content Server
host.

SQL Server documentation

Install SQL Server with
case-sensitivity and
row-level locking enabled.

SQL Server documentation

Install SQL Server for
internationalization.

SQL Server requirements,
page 75

Content Server Installation Guide 161



Preinstallation Checklists

Sybase checklist

Review this checklist when you configure Sybase:

Table A-10. Sybase checklist

Task For More Information Completed?

Install the database with
the UTF-8 code page.

Enabling the UTF-8 code
page on Sybase, page 79

In the $SYBASE/server_
name.cfg file, set the system
parameters number of
open objects, number of
open indexes, and number
of locks.

Sybase parameters, page 79

In a new repository, set the
page size to a minimum
size of 4 KB or 8 KB. In
an upgraded repository,
page size may remain at
2 KB but 4 KB or 8 KB is
recommended.

Sybase documentation and
Setting the Sybase 12.5
page size, page 80

Ensure that the Sybase
version is at least 12.5.

Sybase documentation

Ensure that the Sybase
directory structure is
correct.

Sybase documentation and
Sybase directory structure,
page 81

DB2 checklist

Review this checklist when you configure DB2:

Table A-11. DB2 checklist

Task For more information Completed?

Configure the database to
use the UTF-8 code page.

DB2 documentation
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Task For more information Completed?

Decide whether to
configure the database
for improved performance.

System performance and
database parameters on
Oracle and DB2, page 72

Ensure that the DB2 clients
are installed on the Content
Server host.

DB2 documentation

Set the required parameters
correctly.

Installing and configuring
DB2, page 83

Use the DB2 Performance
Wizard for improved
performance with Content
Server.

Using the Performance
Wizard, page 84

Configure DB2. Configuring DB2 From the
Control Center, page 86 or
Configuring DB2 From the
command line, page 87
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Appendix B

Required Environment Variables on
UNIX and Linux Hosts

If you are installing Content Server on UNIX or Linux, you must set certain environment variables
in the installation owner’s environment. These are discussed in Setting up the installation owner
account, page 52.

If you use the dm_launch_server_config_program.sh script to start the server configuration program,
all other required environment variables are set automatically, including those required by each
database. If you do not use the dm_launch_server_config_program.sh script, you must manually set
the following additional environment variables:

Table B-1. Required environment variables

Environment Variable Description Required values

PATH The path must include:
• JAVA_HOME/bin before
the following two
variables

• $DM_HOME/bin
• $DOCUMENTUM/dba

JAVA_HOME Home directory for Java
installation on Content
Server host

Ensure that $JAVA_HOME
points to the Java version
shipped by Documentum,
$DOCUMENTUM_
SHARED/java/version_
number, where
version_number is the
correct Java version for
your platform and Content
Server version. Refer to
the Content Server Release
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Environment Variable Description Required values

Notes for the correct
version number.

CLASSPATH • $DOCUMENTUM_
SHARED/dctm.jar,
which must be first in
the CLASSPATH

• $DM_HOME/dctm-
server.jar

• $DOCUMENTUM_
SHARED/config

LD_LIBRARY_PATH Solaris and Linux shared
library path

• The DFC location,
$DOCUMENTUM_
SHARED/dfc

• $JAVA_HOME/lib
• $DM_HOME/bin
• To use electronic
signatures on
PDF documents,
$DM_HOME/fusion

• $DOCUMENTUM/
fulltext/fast40

• $DOCUMENTUM/
fulltext/IndexServer/lib

• $DOCUMENTUM/
share/clients/unix/
solaris

• Both Solaris and Sybase
include a shared library
called libintl.so. With
Sybase, if you include
/usr/lib in the library
path, ensure that it is
after any Documentum
or Sybase directories
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Environment Variable Description Required values

SHLIB_PATH HP-UX shared library path • The DFC location,
$DOCUMENTUM_
SHARED/dfc

• $DM_HOME/bin
• $DM_HOME/unix/hpux
• $DOCUMENTUM/
fulltext/fast40

• $DOCUMENTUM/
fulltext/IndexServer/lib

• $DOCUMENTUM/
share/clients/unix/hpux

• To use electronic
signatures on
PDF documents,
$DM_HOME/fusion

• $JAVA_HOME/lib
• $JAVA_HOME/jre/bin/
classic

• $JAVA_HOME/jre/lib/
PA_RISC2.0/native_
thread

• $JAVA_HOME/jre/bin

LIBPATH AIX shared library path • The DFC location,
$DOCUMENTUM_
SHARED/dfc

• $DM_HOME/bin
• $DM_HOME/unix/aix
• $JAVA_HOME/lib
• $JAVA_HOME/jre/bin:
• $JAVA_HOME/jre/bin/
classic

• $DOCUMENTUM/
fulltext/fast40

• $DOCUMENTUM/
fulltext/IndexServer/lib

• $DOCUMENTUM/
share/clients/unix/aix

• On DB2, $DB2_BASE/lib
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Environment Variable Description Required values

• To use electronic
signatures on
PDF documents,
$DM_HOME/fusion

• Any directories in the
database hierarchy
containing libraries you
need access to

The following table lists required environment variables for each relational database management
system, which must be set if you do not use the dm_launch_server_config_program.sh script:

Table B-2. Required database environment variables

Relational database management system Required environment variables

Oracle • ORACLE_HOME
• PATH = $ORACLE_HOME/bin
• On Solaris, LD_LIBRARY_PATH =
$ORACLE_HOME/lib

• On HP-UX, SHLIB_PATH =
$ORACLE_HOME/lib

• On AIX, LIBPATH = $ORACLE_
HOME/lib

Sybase • SYBASE
• SYBASE_OCS
• PATH = $SYBASE/$SYBASE_OCS/bin
• LD_LIBRARY_PATH =
$SYBASE/$SYBASE_OCS/lib

DB2 • DB2_BASE
• DB2_HOME
• DB2_OWNER
• DB2INSTANCE
• INSTHOME DB2DIR
• PATH = $DB2_BASE/bin
— $DB2_BASE/adm
— $DB2_BASE/misc
— $DB2_BASE/lib

• CLASSPATH = $DB2_BASE/bin
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Relational database management system Required environment variables

— $DB2_BASE/adm
— $DB2_BASE/misc
— $DB2_BASE/lib

• LIBPATH = $DB2_BASE/bin
— $DB2_BASE/adm
— $DB2_BASE/lib
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Appendix C

Troubleshooting Content Server
Installation

This appendix contains information for troubleshooting common Content Server installation
problems. It contains the following sections:
• Determining what went wrong, page 171
• Recovering from a failed repository configuration or upgrade, page 174
• Enabling tracing in repository configuration scripts, page 175
• Recovering from a stalled Content Server upgrade, page 176

Determining what went wrong
Before you proceed:
• Ensure that you are connected as the installation owner.
• On UNIX and Linux, ensure that the environment variables are set correctly in the

installation owner’s environment.

For complete information, refer to Setting up the installation owner account, page 52.
• Review the server installation logs.

For complete information, refer to Reviewing the server installation logs, page 131.
Use the following table to determine what went wrong from the symptoms.
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Table C-1. Troubleshooting checklist

Symptom Cause Fix

You are trying to install or
upgrade the server but you
are not connected as the
installation owner.

Connect using the
installation owner account.

The environment variables
are not set correctly.

While installing a
repository, you see an
error message indicating
that the user is not a valid
UNIX user:

Configuration of
the docbase fails
with the message
'user must be a
valid unix user'
exec(): 0509-036
Cannot load program
/u01/app/documentum/
product/5.2/bin/
dmisvaliduser
because of the
following errors:
0509-150 Dependent
module libldap50.so
could not be loaded.
0509-022 Cannot load
module libldap50.so.
0509-026 System
error: A file or
directory in the
path name does not
exist.

There are three possible
causes of this error:

1. The installation owner
account does not have
the installation owner
group designated as
the user’s primary
group. Group
ownership of the
Documentum binaries
is incorrect.

2. The shared library path
environment variable
is not set correctly.

3. On DB2, the
$DB2_BASE
environment variable
is not set correctly.

To fix these three causes:

1. Make the installation
owner group the
installation owner’s
primary group.

2. Set the shared library
path environment
variable correctly. For
complete information
on setting environment
variables, refer
to Setting up the
installation owner
account, page 52.

3. Refer to the
documentation for
DB2 and to Chapter 4,
Preparing the Database
for Content Server
Installation.

Server upgrade appears to
hang.

There may be a cyclic
group.

Refer to Recovering from
a stalled Content Server
upgrade, page 176.
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Symptom Cause Fix

OnWindows hosts, you see
the following error during
installation:

Could not initialize
interface awt
exception
ExceptionInitializationError

The correct video driver
for the video card is not
installed on the host.

Review the hardware and
software configuration of
the host.

You see the following error
during an upgrade of an
older repository:

Failed to retrieve
serverconfig
object with name
<serverconfigname>.

***Failed to encrypt
passwords for
docbase ec_epac,
status -1057226550
**Operation
failed ** [DM_
CRYPTO_E_NO_LOCAL_
COMPONENT_STORE]
error: "No local
component store
for server" Please
read error log
C:\WINNT\Temp\dm_
chec_bin.
ServerConfigurator.
log for more
information.

The dm_ContentRepli-
cation method has some
parameter arguments left
over from EDMS98.

Delete the following
entry from the
dm_ContentReplication
method:

serverconfigname
[domain\]user,passwd

You see the following
errors during upgrade
from 5.2.5 to 5.3 on Oracle
9:

Tue Feb 22 21:48:08
2005 098000
[DM_SESSION_I_
INIT_BEGIN]info:
"Initialize

Invalid Oracle views
belonging to types _sv, _sp,
_rv, and _rp.

A view in Oracle becomes
invalid when the base
table(s) it references change
by altering it (for example,
by adding/dropping a

Make the views valid
before upgrading Content
Server.

To determine which views
in the Oracle installation
are invalid, you can run
the following query from
SQLPLUS logging in to
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Symptom Cause Fix
dmContent." Tue
Feb 22 21:48:08
2005 567000
[DM_SESSION_I_
INIT_BEGIN]info:
"Initialize
dmiSubContent."
Tue Feb 22 21:48:08
2005 598000
[DM_TYPE_MGR_E_CANT_
FIND_TABLE]error:
"Failure to
find table
dmi_subcontent_sv
as part of fetch of
type dmi_subcontent:
error from database
system is ORA-24372:
invalid object for
describe" Tue Feb 22
21:48:08 2005 598000
[DM_SESSION_E_INIT_
FAILURE1]error:
"Failure to complete
dmiSubContent
initialization."

You might also see this
message:

ORA-24372: invalid
object for describe

column, or dropping a
unique constraint index).

as the repository owner.
(owner of the tablespace
used by documentum):

select object_name,
object_type from
user_objects where
status='INVALID';

To recompile the views:

ALTER VIEW view_name
COMPILE;

The Oracle-supplied
package named
DBMS_UTILITY has
a procedure named
COMPILE_SCHEMA. This
procedure will compile all
stored code, views, etc.,
for the schema provided.
The best way to compile all
database objects that are
invalid is to use a script
in the $ORACLE_HOME/
rdbms/admin directory
named utlrp.sql. This
script finds all objects in
the data dictionary that are
invalid and compiles them.
This script is typically
mentioned in patch notes
but you can use it any time
a schema change occurs. )

Recovering from a failed repository
conguration or upgrade

If repository configuration fails, whether you are upgrading an existing repository or
creating a new one, you can recover from the failure.
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Typical reasons for a failure include problems with the database connection or errors
in server creation. Before you proceed with the following instructions, read the server
installation logs and correct any problems. For more information about logs, refer to
Reviewing the server installation logs, page 131.

To recover from a failed installation or upgrade:

1. Correct any problems noted in the server installation logs.

2. Restart the server configuration program.

3. Choose Custom installation.

4. Select the repository where the failure occurred.

5. Check Upgrade.
This takes you through the configuration steps again and re-runs the scripts that
create the repository.

Enabling tracing in repository conguration
scripts

When the repository configuration scripts fail, it is useful to see the command that was
being run at the time of the failure in addition to the information in the output file. You
can obtain this information by enabling tracing in the scripts.

To enable tracing in the repository conguration scripts:

1. Restart the repository configuration program.

2. Choose custom installation.

3. At the screen where you can modify the configuration scripts, open the problem
script for editing.

4. Immediately after the connect call, add the following line to the script:
sta$ = dmAPIExec("trace,c,4," & "trace_file_name")

5. Save the script.

6. Rerun the script.
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Recovering from a stalled Content Server
upgrade

A server upgrade that stalls in the middle or takes hours to complete can be caused by
cyclic groups. A cyclic group is a group where the group itself is a subgroup of a member
group, causing the server to cycle during the upgrade.

If the server has encountered a cyclic group, the last line of the server log is:
Thu Aug 7 14:00:14 2003 715540 [DM_SESSION_I_INIT_BEGIN]info:"Initialize dmGroup."
Use the following instructions to identify the cyclic group. After you locate the cyclic
group, contact Documentum Technical Support for assistance in correcting the problem,
which requires direct SQL statements in the database.

To identify and correct a cyclic group:

1. From the operating system, stop the server startup.
• On Windows, open Task Manager, select the correct server process on the

Processes tab, and click End Process.
• On UNIX and Linux, determine the correct server process and use the kill

command to kill the process.
2. If you are on UNIX or Linux, restart the server using the –osqltrace option:

dm_start_repositoryname -osqltrace

3. If you are on Windows, edit the server startup command and then restart the server.

a. Click Start→Programs→Documentum→Server Manager.

b. Select the correct repository.

c. Click Edit Service.

d. In the Command field, add -osqltrace after the repository name.

e. Click Okay.

f. Restart the server.

4. When the server appears to hang, open the server log and identify the query that is
looping.
If there is a cyclic group, the last query in the log is recorded multiple times and
takes this format:
Mon Aug 11 13:33:17 2003 435439: 21547[1]
SELECT SB_.R_OBJECT_ID FROM repository_owner.dm_group_s SB_
WHERE (SB_.R_OBJECT_ID=:objectp AND SB_.I_VSTAMP=:versionp)
Mon Aug 11 13:33:17 2003 435608: 21547[1] :objectp = 1200fb8080000909
Mon Aug 11 13:33:17 2003 435608: 21547[1] :versionp = 0
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In the above example, the cyclic group has the r_object_id of 1200fb8080000909.

5. Run the following query:
SELECT group_name
FROM dm_group_s
WHERE r_object_id='r_object_id_of_cyclic_group

This query returns the name of the group, which you need for determining which
group is the cyclic group.

6. Run the following query:
SELECT groups_names
FROM dm_group_r
WHERE r_object_id = ‘r_object_id_of_cyclic_group’

The query returns the names of each group that is a member of the problem group.

7. For each of the group names returned, run this query:
SELECT r_object_id from dm_group_s where group_name
= ‘member_group_name'
The query returns the r_object_id for each member group.

8. Repeat steps 6 and 7 iteratively for each subgroup until you locate the cyclic group.

9. Contact Documentum Technical Support for assistance in correcting the problem.
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Appendix D

Content Server Installation Directories
and Repository Conguration Scripts

This appendix explains concepts essential for installing the Content Server. The following topics are
discussed:

• Content Server installation file structure, page 179
• Scripts run during installation or upgrade, page 183
• Configuration objects, page 185

Content Server installation le structure
A basic Content Server installation results when you accept all default values offered
during the installation procedure.

A server installation consists of a number of files distributed among several directories.
Some of these files, such as the executable files, are supplied on your Content Server
Installation CD. Others, such as the server startup file, are created during the installation
process.

The installation procedure creates _uninst, data, dba, fulltext, product, server_uninstall,
and share subdirectories in the $DOCUMENTUM directory. In the product directory,
the procedure creates a subdirectory named for the version of the software that you are
installing and puts the executable files in subdirectories of that directory. The share,
data, and dba directories are populated with the files and subdirectories that fall into
those categories.

Each directory contains files and subdirectories necessary for a Documentum installation.
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_uninst

This directory contains the server uninstaller.

Data

The files and directories in this category are the content storage areas and the directories
that contain the full-text indexes. These directories must exist and location objects must
be defined for them in the repository before you start Content Server. (The installation
procedure creates a default storage area and associated location object and a default
fulltext index object and associated location object.)

The Data directory contains directories that store the data manipulated by users and
Content Server. The installation procedure creates a subdirectory for the repository in
the Data directory and in that repository subdirectory, creates a content storage area.

The data includes the full-text indexes and the content files associated with objects in
the repositories. The location of these directories is the most flexible component of your
configuration.

Most sites will want to add more storage areas and index directories, particularly as the
repository grows larger. Refer to the Content Server Administrator’s Guide for information
and instructions about adding additional storage areas and full-text index storage
directories.

DBA

The DBA directory contains the Log and Config directories and several files. The Log
directory is where the server places any log files generated by user actions during a
session with the server. The server creates any necessary subdirectories for these log
files under the Log directory. The Config directory includes a subdirectory for each
repository that contains the startup files for the repository and its server.

Fulltext

The Fulltext directory contains the third-party full-text indexing software.
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Product

The Product subdirectory contains the Content Server executables.

Server_Uninstall

This directory contains a script that can be run manually to destroy a repository’s
database tables after you delete the repository.

Share

The Share directory holds all the files that can be shared by the server and the clients.
Clients that connect to the Share directory remotely can receive some performance
benefits in file-sharing and event notification. (The client must be using NFS software
to receive these benefits. Refer to the Content Server Administrator’s Guide for more
information.)

The Share directory has four subdirectories:

• Data

The Data directory contains data that is read and written by the server and the clients.
It has two subdirectories, Events and Common. Ensure that these subdirectories can
be mounted by clients.

— Events

The Events directory contains a file for any user who has queued inbox items
that have not been viewed. The files are empty. They serve as a flag to the server
that unviewed items are in that user’s inbox.

— Common

The Common directory is where the server puts copies of requested content files
if users are not using client local areas and if users do not specify an alternate
location for the files.

— Clients

The Clients subdirectory contains the win and unix subdirectories, which
respectively contain the files and executables for Windows and UNIX clients.

— Temp
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The Temp directory is used by the server as a temporary storage space. For
example, results generated by the execution of a procedure using the Apply
method’s DO_METHOD function are stored here.

— SDK

The SDK directory contains two subdirectories of files that are useful to software
developers. The two subdirectories are:

— Include.

This directory contains the dmapp.h file and the import libraries, among other
things.

— Example.

This directory contains code examples.

Additional directories

The directories that are created during installation are described in Table D–1, page 182

Table D-1. Subdirectories created during installation

Directory Description

bin Contains the Content Server software

convert Contains the transformation engine
executable files

example* Contains code examples

external_apps Contains a shared library

fusion Contains files required for electronic
signature functionality, a Trusted Content
Services feature

include* Contains header files for any external
applications that will communicate with
Content Server

install Contains the installation scripts

messages *.e files (error messages)

Uniscape Contains NLS files for server codepage
conversions

unix* Contains the libraries for a UNIX client
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Directory Description

unsupported Contains executable files that are provided
for your convenience but that are not
supported by Content Server

webcache Includes webcache.ini. Refer to
documentation for Documentum
WebCache for more information.

thumbsrv Installation directory for Thumbnail
Server. Refer to documentation for
Documentum Media Services for more
information.

win*

* Optional

Contains the executable files for a
Microsoft Windows client These include
IAPI and IDQL for MS Windows and the
DDE server and libraries

tomcat Contains Apache Tomcat installation files
used to create a Tomcat instance for the
Java method server

Scripts run during installation or upgrade

During repository configuration, the following scripts are run, whether you are installing
a new repository or upgrading an existing repository:
• headstart.ebs

The headstart.ebs script loads the initial default objects for the repository. It creates
mount point objects, location objects, filestore objects, and method objects.

• dm_apply_formats.ebs

The dm_apply_formats.ebs script creates or updates format objects, which are
required for content file operations.

• dm_routerConv_install.ebs

The dm_routerConv_install.ebs script is run only during repository upgrades. It
loads methods that are used for converting routers to workflow templates.

• templates.ebs

The templates.ebs script creates default templates that are used by Documentum
clients for creating new documents in the repository.

• replicate_bootstrap.ebs
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The replicate_bootstrap.ebs script creates objects and registered tables that are
required for replication.

• desktop_client.ebs

The desktop_client.ebs script creates folders required by Documentum Desktop
Client and installs the default SmartList.

• display_config_setup.ebs

The display_config_setup.ebs script configures the repository for the Documentum
Offline Client.

• offline_config_setup.ebs

The offline_config_setup.ebs script migrates offline configuration settings from the
offline_config object to the repository config object.

• ci_schema_install.ebs

The ci_schema_install.ebs script installs the object types used by Documentum
Content Intelligence Services.

• dfc.ebs

The dfc.ebs script loads default objects required by the Documentum Foundation
Classes.

• toolset.ebs

The toolset.ebs script installs repository administration tools.
• dm_ldap_install.ebs

The dm_ldap_install.ebs script creates or upgrades the ldap object type and upgrades
any existing ldap objects.

• dm_xml_install.ebs

The dm_xml_install.ebs script installs object types and formats for XML files.
• dm_gwm_install.ebs

The dm_gwm_install.ebs script executes scripts that install workflow-related types,
methods, folders, and jobs.

• upgrade_java_methods_51.ebs

The upgrade_java_methods_51.ebs script upgrades existing Java methods.
• dd_populate.ebs

The dd_populate.ebs script populates the data dictionary with attribute and type
information from data files.

• csec_plugin_upgrade_53.ebs

The csec_plugin_upgrade_53.ebs upgrades the plug-in for using content-addressable
storage areas.
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• dm_cas_install.ebs, which creates a method, location, template type, folder structure,
and template object for use in the electronic signature functionality.

• dm_wfTimer_upgrade.ebs

The dm_wfTimer_upgrade.ebs script, located in the $DM_HOME/install/admin
directory, converts workflow pre- and post-timers set up in pre-5.3 respositories to
the 5.3 SP1 timer implementation. The syntax for running the script is:
dmbasic -f dm_wfTimer_upgrade.ebs -e Install --
repository_nameuserpassword

• create_fulltext_objects.ebs

The create_fulltext_objects.ebs script creates objects related to full-text indexing
in the repository.

• dfc_javadbexpr.ebs

The dfc_javadbexpr.ebs script creates types, relation types, acls, and repository
folders for DFC evaluation of validation expression constraints in Java.

• dfc_bof2.ebs

The dfc_bof2.ebs script creates the types for dm_module, dmc_jar, and
dmc_java_library and configures a repository to use DFC 5.3 SP1.

Conguration objects

In each repository, there are objects that, taken together, define your configuration. These
objects include:

• Server config object
• Docbase config object
• Full-text index objects
• Location objects
• Mount point objects
• Storage objects
• Format objects
• Method objects
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As you make choices about how you want to configure your installation and repositories,
you will modify these objects or add new ones to implement your decisions. Refer to the
Content Server Administrator’s Guide for more information on configuration.

186 Content Server Installation Guide



Appendix E

Object Type Categories for Oracle
Database Storage

This appendix lists the object types by their size category. An object type’s size category is used
in two contexts:

• To determine where to create the object type’s tables and indexes if the optional
[FUNCTION_SPECIFIC_STORAGE] parameters are defined in the server.ini file

• To determine the default initial and next extent allotments for the object type’s tables in the RDBMS
The categories for each context are not exactly the same. Refer to Type categories for tablespace
specifications, page 187, to find the categories for tablespace determination and to Type categories for
extent allocation, page 188, to see the tables listing the categories for extent allotments t.

For information about setting the default storage parameters, refer to Appendix F, Defining Oracle or
DB2 Database Parameters for Repository Tables .

Type categories for tablespace specications
By default, the tables and indexes for all object types are created in the same tablespace.
However, you can set parameters in the server.ini file to define alternate tablespaces for
large and small object types. When you do so, the system sorts the objects into large and
small for the purposes of determining which object types to create in which tablespace.

The majority of the object types are considered small for this purpose. The following
list shows the object types that are considered large. Any type not appearing on this
list is considered small.

dm_acl dm_process dmi_dump_object_record

dm_assembly dm_reference dmi_linkrecord

dm_audittrail dm_relation dmi_load_object_record

dm_composite dm_router dmi_otherfile
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dm_document dm_script dmi_queue_item

dm_folder dm_smart_list dmi_replica_record

dm_locator dm_sysobject dmr_containment

dm_note dm_workflow dmr_content

dm_procedure dm_workitem

Type categories for extent allocation
This section lists object type size categorizations for extent allocation and the default
initial and next extent storage parameters for each category.

The object types are categorized as large, small, or default based on how many objects of
the type will be created in the repository. For example, dm_document is categorized
as large because most enterprises create large numbers of documents in a repository.
Similarly, dm_docbase_config is categorized as small because a repository has only one
docbase config object. Those types that don’t fall into either the large or small category
are categorized as default.

Object types categorized as large

The object types categorized as large are created with an initial extent size of 100K.
The next extent size is 1M. The following object types are categorized as large for the
purposes of allocating extents.

dm_acl dm_reference dmi_dump_object_record

dm_assembly dm_relation dmi_load_object_record

dm_document dm_router dmi_object_type

dm_folder dm_sysobject dmi_queue_item

dm_locator dmi_containment dmi_replica_record

dm_note dmr_content dmi_subcontent
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Object types categorized as small

The object types categorized as small are created with an initial extent size of 10K. The
next extent size is 50K. The following object types are categorized as small for the
purposes of allocating extents.

dm_alias dm_filestore dm_relation_type

dm_blobstore dm_foreign_key dm_server_config

dm_distributed_store dm_format dm_store

dm_dump_record dm_fulltext_index dmi_change_record

dm_docbase_config dm_linkedstore dmi_expr_code

dm_docbaseid_map dm_load_record dmi_recovery

dm_extern_file dm_location dmi_session

dm_extern_free dm_mount_point dmi_sequence

dm_extern_store dm_opticalstore dmi_tdk_collect

dm_extern_url dm_outputdevice dmi_tdk_index

dm_federation dm_registered dmi_vstamp

Object types categorized as default

The object types categorized as default are created with an initial extent size of 20K. The
next extent size is 100K. The following object types are categorized as default for the
purposes of allocating extents.

dm_activity dm_federation_log dm_qual_comp

dm_aggr_domain dm_func_expr dm_query

dm_application dm_group dm_script

dm_app_ref dm_job dm_smart_list

dm_audittrail dm_job_request dm_staged

dm_builtin_expr dm_key dm_type

dm_cabinet dm_literal_expr dm_user

dm_cond_expr dm_method dm_value_assist

dm_cond_id_expr dm_nls_dd_info dm_value_func

dm_component dm_plugin dm_value_list
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dm_dd_info dm_policy dm_value_query

dm_domain dm_procedure dm_workflow

dm_expression dm_process dm_workitem

dmi_dist_comp _record dmi_linkrecord dmi_registry

dm_expr_code dmi_linkrecord dmi_transactionlog

dm_expr_code dmi_package dmi_type_info
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Dening Oracle or DB2 Database
Parameters for Repository Tables

To improve performance and increase the throughput of the system, you may want to control where
repository information is stored. For example, you can store frequently used data on different disks
than less-frequently used data. Defining database parameters to store data in different tablespaces
also partitions data into smaller, more manageable pieces.

When a repository is created, the system automatically creates object-type tables and indexes in the
underlying RDBMS. (The object-type tables and indexes are described in Content Server Fundamentals.)

By default, Content Server creates all object-type tables and indexes in the same tablespace. The size
and number of the extents allotted for each table are determined by default configuration parameters.

You can edit the server.ini file to change the default database configuration parameters when
the repository is created, before you start the server. To do this, use the instructions in System
performance and database parameters on Oracle and DB2, page 72.

On DB2, you can change the tablespace for the object-type tables and indexes. On Oracle, you can
change two parameters:

• The tablespace for the object-type tables and indexes
• The size of the extents allotted for system-defined object types
You cannot change the number of extents allotted for the object types.

Under Oracle 9, the default value is LOCAL. When the LOCAL value is set, users cannot specify an
extent size and values you set in the server.ini key are ignored by Oracle. If you intend to set the
[TYPE_EXTENT_SIZE] and [FUNCTION_EXTENT_SIZE] parameters in the server.ini file, ensure that
any new Oracle 9 tablespaces are created using DICTIONARY as the value for extent_management.
Refer to Oracle’s documentation for more information on extent_management.
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Dening the tablespace
The parameters in the [FUNCTION_SPECIFIC_STORAGE] and [TYPE_SPECIFIC_
STORAGE] sections of the server.ini file define the tablespace in which to create the
object-type tables and indexes.

FUNCTION_SPECIFIC_STORAGE

Set the parameters in the [FUNCTION_SPECIFIC_STORAGE] section to define the
tablespace for the type tables and indexes for a particular category of object types.
Documentum sorts object types into the categories large and small for the purposes of
defining their tablespace. Object types in the large category are those that are expected
to have a large number of object instances. For example, dm_SysObject is in the large
category. Object types in the small category are those that are expected to have very
few object instances. For example, dm_docbase_config is in the small category. Each
repository has only one Docbase config object.

The format of the [FUNCTION_SPECIFIC_STORAGE] section is:
[FUNCTION_SPECIFIC_STORAGE]
database_table_large=tablespace_name
database_table_small=tablespace_name
database_index_large=tablespace_name
database_index_small=tablespace_name

For example, to define a tablespace for the object-type tables in the large category, include
the following lines in the server.ini file, substituting the name of the tablespace:
[FUNCTION_SPECIFIC_STORAGE]
database_table_large=tablespace_name

For example, to put the indexes for the large category in the tablespace named
production_1, include the following lines in the server.ini file:
[FUNCTION_SPECIFIC_STORAGE]
database_index_large=production_1

You can specify the function-specific parameters singularly or in any combination.

TYPE_SPECIFIC_STORAGE

Set the parameters in the [TYPE_SPECIFIC_STORAGE] section in the server.ini file to
define a tablespace for the type tables or indexes for a specific object type.

The format of the [TYPE_SPECIFIC_STORAGE] section is:
[TYPE_SPECIFIC_STORAGE]
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database_table_typename=tablespace_name
database_index_typename=tablespace_name

You can specify the type-specific parameters individually. For example, to put the
object-type tables for the dm_SysObject type in the tablespace named sysobj_space,
include the following lines in the server.ini file:
[TYPE_SPECIFIC_STORAGE]
database_table_dm_sysobject=sysobj_space

If you want to put both the tables and indexes for an object type in non-default
tablespaces, define the tablespace for each. Defining a tablespace for an object type’s
tables doesn’t affect where the type’s indexes are stored. The system creates the indexes
in the default tablespace. Defining a tablespace for a type’sindexes does not affect where
the type’s tables are stored.

For example:
[TYPE_SPECIFIC_STORAGE]
database_table_dm_sysobject=sysobj_space
database_index_dm_sysobject=sysobj_idx_space

The object-type tables and indexes of any object type not specified in a type-specific
parameter are created in the default tablespace or, if specified, in the tablespace for
the type’s category.

If the server.ini file includes both function-specific and type-specific parameters that
apply to an object type, the type-specific parameters override the function-specific
parameters. For example, suppose you add the following function-specific and
type-specific parameters to the file:
[FUNCTION_SPECIFIC_STORAGE]
database_index_large=production_1
[TYPE_SPECIFIC_STORAGE]
database_table_dm_sysobject=sysobj_space

Both parameters apply to the dm_SysObject type because dm_SysObject is in the large
category. The object-type tables for dm_SysObject are created in the sysobj_space
tablespace because the type-specific parameter overrides the function-specific parameter.

Dening the Oracle extent sizes

For the purposes of extent allocation, the Documentum object types are sorted into
three categories: large, small, and default. The category name describes the quantity
of expected objects of the type. For example, dm_document is considered a large
type because most enterprises generate large quantities of documents. In contrast,
dm_repository_config is a small type because there is only one docbase config object in a
repository. Those object types that typically do not have large numbers of objects or very
small numbers of objects fall into the default category.
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A type’s category determines how much database storage is allocated to it by default.
Object types categorized as:

• Large object type receive an initial extent of 100 KB and a next (second, third, fourth,
etc.) extent of 1 MB.

• Small object types receive an initial extent of 10 KB and a next extent of 50 KB.
• Default object types receive an initial extent of 20 KB and a next extent of 100 KB.
The default storage parameters set the initial and next extent sizes. There are also
parameters that define the default minimum and maximum number of extents allotted
to an object type table and the percentage increase of extents allotted after the second
extent. The minimum number of allotted extents is 1 and the maximum number is
determined by Oracle, based on the data block size. By default, object-type tables and
indexes are allocated the minimum number of extents when they are created.

The percentage increase default is 10%. This means that extents allotted after the second
extent are increased in size by 10% over the previously allocated extent. For example, if
the second extent’s size is 100 KB, then the size of the third extent is 110 KB, 10% greater
than 100 KB. The fourth extent would be 121 KB, 10% greater than 110 KB.

You can change the initial and next extent default sizes for an individual object type or
for an entire category by setting parameters in the server.ini file before the repository
is created.

You can change the next extent parameter, the minimum and maximum extent
parameters, and the percentage increase parameter. However, you must do so using the
Oracle ALTER TABLE command through sqlplus. Refer to the Oracle documentation
for instructions.

Changing storage parameters for individual object
types on Oracle

To change the initial and next extent parameters for an object type, add a
[TYPE_EXTENT_SIZE] section to the server.ini file. This section has the following format:
[TYPE_EXTENT_SIZE]
database_ini_ext_typename=new_value[K|M]
database_next_ext_typename=new_value[K|M]

typename must be the internal name of a system-defined object type. It cannot be a
user-defined object type. The database_ini_ext_typename parameter defines the size of the
initial extent allotted to the type. The database_next_ext_typename parameter defines the
size of the second extent allotted to the type.

new_value is an integer. If you include K, the value is interpreted as Kilobytes. If you
include M, the value is interpreted as Megabytes. If you include neither K nor M, the
value is interpreted as bytes.
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For example, to change the defaults for dm_sysobject, add the following lines to the
server.ini file:
[TYPE_EXTENT_SIZE]
database_ini_ext_dm_sysobject=new_value[K|M]
database_next_ext_dm_sysobject=new_value[K|M]

You can set either parameter or both for an object type. The section can include parameter
definitions for more than one object type. For example:
[TYPE_EXTENT_SIZE]
database_ini_ext_dm_sysobject=new_value[K|M]
database_next_ext_dm_sysobject=new_value[K|M]
database_next_ext_dm_user=new_value[K|M]

Changing storage parameters for categories of types
on Oracle

To change the initial and next extent parameters for all object types in one category,
add a [FUNCTION_EXTENT_SIZE] section to the server.ini file. This section has the
following format:
[FUNCTION_EXTENT_SIZE]
database_ini_ext_large=new_value[K|M]
database_ini_ext_small=new_value[K|M]
database_ini_ext_default=new_value[K|M]
database_next_ext_large=new_value[K|M]
database_next_ext_small=new_value[K|M]
database_next_ext_default=new_value[K|M]

The database_ini_ext_large parameter defines the size of the initial extent allotted by
default to object types categorized as large. The database_ini_ext_small parameter defines
the size of the initial extent allotted by default to object types categorized as small. The
database_ini_ext_default parameter defines the size of the initial extent allotted by default
to object types categorized as default.

The database_next_ext_large parameter defines the size of the second extent allotted by
default to object types categorized as large. The database_next_ext_small parameter
defines the size of the second extent allotted by default to object types categorized as
small. The database_next_ext_default parameter defines the size of the second extent
allotted by default to object types categorized as default.

new_value is an integer. If you include K, the value is interpreted as Kilobytes. If you
include M, the value is interpreted as Megabytes. If you include neither K nor M, the
value is interpreted as bytes.

For example, to change the default extent sizes for all large object types, add the
following to the server.ini file:
[FUNCTION_EXTENT_SIZE]
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database_ini_ext_large=new_value[K|M]
database_next_ext_large=new_value[K|M]

You can set any combination of the parameters. It isn’t necessary to set the parameters
for all three categories. You can also set only one of the parameters for a category. To
illustrate, the following example sets the initial extent for objects categorized as large
and the next extent for object types categorized as default:
[FUNCTION_EXTENT_SIZE]
database_ini_ext_large=200K
database_next_ext_default=120K

User-dened object types

A user-defined object type derives its database storage parameters from its supertype. If
the type has no supertype, then the type is assigned to the large category for tablespace
assignment and to the default category for the extent allocations

You cannot change the storage parameters for user-defined object types.

On DB2, if you create a tablespace for objects of type dm_SysObject,then create a
user-defined object type whose supertype is dm_SysObject, the user-defined object
type is not stored in the tablespace for dm_SysObject. It is stored instead in the default
tablespace, unless you explicitly define the tablespace for dm_SysObject in the server.ini
file.
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Appendix G

Installing Content Server With
Microsoft Cluster Services

This chapter describes how to install and configure Documentum to provide failover support under
Microsoft Cluster Services. This chapter contains the following information:

• Preinstallation requirements, page 197
• Overview, page 198
• Choosing a configuration, page 198
• Configuring an active/passive cluster, page 199
• Configuring an active/active cluster, page 212
• Upgrading a repository installed with Cluster Services, page 232

Preinstallation requirements
Before you install and configure Content Server and a repository under Microsoft Cluster
Services, read Chapter 2, Planning for Content Server Installation , Chapter 3, Preparing
for Content Server Installation, and perform the preinstallation tasks described there.

Additionally, complete the checklists in Appendix A, Preinstallation Checklists.

The instructions that follow assume that the underlying database is on a different
computer from the computer used for Content Server, but the database may reside on
the Content Server host computer.

Whether you are configuring an active/passive cluster or an active/active cluster, set up
the shared disks to be used by the repositories.

Ensure that the shared disk includes a directory to use for content storage.

If you are configuring an active/active cluster, the user who configures Microsoft Cluster
Services must have read and write permissions on both nodes on the directories where
the connection broker logs reside.
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To use Cluster Services, the repository owner must have an account in the domain in
which you install the repository.

Follow the instructions in Chapter 8, Upgrading Content Server, to upgrade to Server 5.2.

Documentum Site Caching Services is not supported in repositories using Cluster
Services.

Full-text indexing is not supported for installations on Cluster Services.

Overview
This chapter provides instructions for setting up two different possible Documentum
configurations under Microsoft Cluster Services. In both configurations, two machines,
called the first cluster node (or first node) and second cluster node (or second node) are
connected to form a cluster. The cluster groups resources, such as virtual IP address,
virtual network host names, and shared disks, into resource groups. The connection
broker and Content Server are also part of the resource group.

At a particular time, the resource group is owned by one node and can only be accessed
by that node.

If one node goes down, the resource group is moved automatically to the node that is
still running. The connection broker and server start on the running node and take over
from the connection broker and server on the failed node.

Choosing a conguration
You can install Documentum under Cluster Services in many possible configurations. For
example, you might have multiple repositories on one machine, with failover to another
machine, or you might have repositories on two machines that fail over to each other.

Two popular configurations are called active/passive and active/active. This chapter
provides detailed installation instructions for both configurations.

Choose your configuration based on available hardware and your organization’s
business needs. In the active/passive configuration, one machine is idle until it is needed
for failover.

In an active/passive configuration, the first node is considered the primary node and
the second node is considered the standby node. There is one resource group. The
repository is stored on the shared disk. The connection broker and Content Server run
on the primary node.
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Figure G-1. Active/passive cluster conguration

If the primary node fails, the standby node takes ownership of the resource group. After
the cluster resources are brought on line on the standby node, the connection broker and
Content Server start on the standby mode.

In an active/active configuration, each node is considered the standby to the other node.
Each node owns its own resource group. Each resource group has its own virtual IP
address, a virtual host name, shared disk, connection broker, repository, and Content
Server.

Figure G-2. Active/active cluster conguration

If a node fails, its resource group is moved to the surviving node. The surviving node
then manages two resource groups. When the failed node is running again, the cluster
administrator can move one resource group back.

Conguring an active/passive cluster
Follow these procedures to configure an active/passive cluster and install servers and a
repository. You must complete all of the procedures in the sections that follow:
• Creating the cluster resource group, page 200
• Creating the Server installation on the host, page 200
• Configuring the repository, page 203
• Configuring the connection brokers, page 210
• Creating additional cluster resources, page 211
• Verifying failover, page 212
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Creating the cluster resource group

Use this procedure to set up the cluster resource group, which contains a virtual IP
address, virtual network host name, and shared disk partition.

To create the cluster resource group:

1. Use the MSCS Cluster Administrator utility to create a cluster resource group
containing the following resources:
• A virtual IP address

This is the IP address that the server uses. Other products can share the IP
address because the connection broker and server only listen on particular ports.

• A virtual network host name

This is the virtual host name for the IP address. It should have a dependency
with the virtual IP address.

• A shared disk partition

This is the location of the repository data directory, where content files are
located.

2. Take the resource group on line and move it back and forth between the primary
and standby machines.
This is to ensure that the IP address, virtual network host name, and shared disk
partition fail over properly.

a. In the Cluster Administrator, right-click the cluster group name.

b. ClickMove Group.
The resource group is toggled between the machines and the owner name
changes.

3. Ensure that the first node owns the resource cluster group.

Creating the Server installation on the host

The first part of the installation process copies files from the installation media to your
hard disk. Follow these instructions regardless of your RDBMS.

On each of the two nodes, copy the files from the installation media to create a Content
Server installation on each node.

Use the same drive on each node for the installation. For example, create the installation
on drive D: on each machine.
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If you exit the Setup part of the installation program, all Content Server registry entries
are deleted. To install a component that was not previously installed, you must go
through the complete Setup program.

To create the server installation on the host computer:

1. Log in to the host system using the installation owner account.
Use an account that is a member of the local Administrators group.
On Windows, user accounts are not case-sensitive, but Content Server installation
fails if you connect to the host using the incorrect case in the user name and
password. For example, if the account is set up as JPSmith and you connect as
jpsmith, you can log in to the host, but server installation fails.

2. To install from the Documentum download site:

a. Navigate to the correct product directory.

b. Navigate to the server version corresponding to your operating system and
database.

3. To install from a CD:

a. Insert the CD into the CD-ROM drive.

b. On the CD, navigate to the subfolder corresponding to your operating system
and database.

4. Save the compressed distribution file from the CD or the FTP site to your hard disk.

5. Navigate to the file’s location on your hard disk.

6. Double-click the file.
The following files are extracted from the compressed file:
bofcollaborationSetup.jar
bofworkflowSetup.jar
consistency_checker.ebs
dfcoperatingsystemSetup.jar
serveroperatingsystemSetup.jar
serverWinSuiteSetup.exe (Windows) or
serveroperatingsystemSuiteSetup.bin (UNIX and Linux)
serveroperatingsystemSuiteSetup.jar
tcfSetup.jar
tomcatoperatingsystem4127Setup.jar

7. Double-click the file named serverWinSuiteSetup.exe.
The Setup program starts and a Welcome dialog box is displayed.

8. Read the information on the dialog box and click Next.
The installer verifies operating system requirements.
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9. Choose installation directories for Content Server and DFC.

a. Click Next to accept the default Content Server installation directory or click
Browse to choose a different installation directory.
The default directory is C:\Documentum.

b. To install the DFC developer documentation, select the checkbox.

c. To install the Primary Interop Assembly, select the checkbox.
Check the Primary Interop Assembly Installer checkbox to request installation of
a Microsoft installer package (.msi file) for the DFC primary interop assembly
(PIA), or leave the box unchecked if you do not wish to have the package
installed. The installer places the installer package for the DFC PIA into the
setup subdirectory of the program root.

d. Click Next.

e. Click Next to accept the default DFC installation directory or click Browse to
choose a different directory.
A dialog box is displayed indicating the default user directory. This directory is
used by DFC during the checkout or export of documents.

f. Click Next to accept the default User directory or click Browse to choose a
different directory.

g. Designate a repository that is a business objects framework global registry for
the DFC to use.

h. Type the global registry user’s user login name and password for the repository.
Do not check Validate Entries or the installer fails.

10. To enable Trusted Content Services, select the checkbox and type in the Trusted
Content Services license key, then click Next.

11. To enable Content Services for EMC Centera, select the checkbox and type in the
Content Services for EMC Centera license key, then click Next.

12. Type the port numbers for the Java Method Server.
• The first port is the primary port used by the Java Method Server (Apache

Tomcat) for communications with Content Server.

The default port is 9080.
• The second port is the port used for Tomcat administration.

The default port is 9007.
The ports must not be used by another application and must not be the ports used by
Site Caching Services.

13. Click Next.
A panel displays the software to be installed.
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14. If any components already exist on the host computer, click Yes or Yes to All to
replace the older components.
A panel displays information about the products installed and their locations and
indicates that the installation is complete.

15. Click Next.
The Documentum Foundation Classes (DFC) Runtime Environment and
Documentum Content Server software are installed.

16. Choose whether to continue with server configuration.
• To configure the server immediately, click Configure server now and click Next.
• To configure the server at another time, click Configure server later and click

Next.
17. Click Next.

18. Choose whether to restart the host now or later.
The installation is not complete until the host is restarted.
• To restart the host immediately, click Yes, restart my system and click Finish.

The host restarts.
• To restart the host later, click No, restart my system at a later time and click

Finish.

Server installation is complete.
19. Ensure that the resource group is on the first node.

Conguring the repository

This section describes how to configure a repository and its associated connection broker.
Perform this part of the installation after the installation files have been copied to your
system, and the Setup program has shut down and restarted your system.

Follow these instructions to create the servers on both nodes and the repository on the
shared drive.

To congure the repository:

1. Log in to Windows as the Documentum installation owner.
If the setup process continues automatically, a Welcome dialog box is displayed. If
the setup process does not continue automatically, follow these steps:

a. Restart the host manually.

b. After the reboot is completed, log in as the Documentum installation owner.
The resource group has been moved to the second node.
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c. Move the resource group to the first node.

d. Navigate to the DM_HOME/install directory.

e. Double-click the Server_Configuration_Program.exe file.
A welcome dialog box is displayed.

2. Click Next.
The Installation Owner Password dialog box is displayed.

3. Type the installation owner’s password and click Next.
The installer verifies the password.

4. If you did not enable Trusted Content Services during installation, optionally choose
to enable TCS, type in the license key, and click Next.

5. If you did not enable Content Services for EMC Centera during installation,
optionally choose to enable the feature, type in the license key, and click Next.

6. Click Custom Configuration and click Next.

7. Choose whether to configure a connection broker, a repository, or both, and click
Next.
• If you checked connection broker, the Connection Broker Configuration dialog

box is displayed.
• If you checked repository but not connection broker, the repository Configuration

Dialog box is displayed. Skip to Step 9.
8. Configure a connection broker on the Content Server host.

a. Choose Create a New Connection Broker and click Next.

b. Type the connection broker name and the port number on which the connection
broker listens.
The default port is 1489.

c. ChooseManual connection broker startup.
Do not configure more connection brokers.

d. Click Next.

9. Configure a repository.

a. Click Create a New Repository and then click Next.
The Data Directory dialog box is displayed. The data directory is where Content
Server stores content files.

b. Click Next to accept the default data directory location, or click Browse to select
a different location, then clickNext.
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Do not choose a directory that is used by another repository for content file
storage or any other purpose. The data directory location must be on the shared
disk partition that belongs to the cluster resource group
The Share Directory Destination dialog box is displayed.

c. Click Next to accept the default share directory location, or click Browse to
select a different location, then clickNext.
The Share directory is where client products, sample code, and libraries are
stored.
The Repository Information dialog box is displayed.

d. Type the name of the repository.
For more information on the repository name, refer to Repository name and
ID, page 35.
If you are installing on the second node, use the same repository name you used
for the first node.

e. Type the repository ID.
For more information on the repository ID, refer to Repository name and ID,
page 35.
If you are installing on the second node, use the same repository ID you used
for the first node.

f. Select the repository size.

g. Select the authentication domain.

h. Indicate whether the repository service starts automatically or manually.

i. Click Next.

j. Choose the mode in which clients connect to the repository.
• Check Native for unsecure connections
• Check Secure for secure connections
• Check Native and Secure if clients can use either connection mode.

k. Click Next.

10. If you are installing on the first node, choose Create a new database user account,
then provide database information.

a. Choose the correct database connection string for your database instance.
• On Oracle, select the connection string from the dropdown list.
• On SQL Server, select an ODBC Datasource from the dropdown list
• On DB2, select the database name from the dropdown list

b. Type the database user’s name.
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The database user’s name defaults to the repository name. The user becomes
the repository owner.

c. Type the database user’s password and confirm the password.

d. Type the database administrator’s user name and password.

e. Click Next.

f. Accept the default paths and sizes for database storage or change them and
click Next.
• On Oracle, these are the Data Tablespace Data File Path and Index Tablespace

Data File Path
• On SQL Server, these are the Data Device File Path and Log Device File Path
• On DB2, these are the Tablespace File Path and Index Data File Path

The tablespace or database creation dialog box is displayed.
g. Edit or accept the default database scripts.

• To edit the tablespace or database creation or deletion script, select the script
and click Edit Script. When you have saved the file, click Next.

• To accept the default scripts and run them, click Next.

The new tablespaces or databases are created.
11. If you are configuring the second node, chose Use an existing database account and

provide database information.

a. Choose the correct database connection string for the database instance you
are using.
• On Oracle, select the connection string from the dropdown list.
• On SQL Server, select an ODBC Datasource from the dropdown list
• On DB2, select the database name from the dropdown list

b. Type the database user’s name.
Use the account you created for the first node. This user is the repository owner.

c. Type the database user’s password.

d. Click Next.

e. Choose the correct index tablespace or data file name.

f. Click Next.

12. Type the connection broker connection information for the connection broker to
which you want the repository to project.
This information is used to create the server.ini file. The default connection broker
is the connection broker on the server host, but the repository can project to any
connection broker on your network.
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a. Type the connection broker port number.
The port number is the port where the connection broker listens.

b. Type the connection broker host name and click Next.
The connection broker connection is tested.

13. Accept or modify the server.ini and webcache.ini files.
The server.ini file contains Content Server initialization information. The
webcache.ini file contains Site Caching Services initialization information.
• To accept the files, click Next.
• To edit the server.ini file, select Server Initialization File and click Edit Script.

After you save the file, click Next.
• To edit the webcache.ini file, select WebCache Initialization File and click Edit

Script. After you save the file, click Next.
The server starts and the Edit Scripts dialog box is displayed.

14. If you are installing on the second node, transfer the aek.key file from the first to
the second node:

a. On the second node, delete the %DOCUMENTUM%\dba\secure\aek.key file.

b. Copy the %DOCUMENTUM%\dba\secure\aek.key file from the first node to
the same location on the second node.

c. On the second node, navigate to %DM_HOME\bin.

d. Open a command line and run this command:
dm_encrypt_password -docbase repository_name -rdbms
-encrypt database_password

e. Restart the server on the second node.

15. If you are installing on the first node, select Repository Headstart and click Edit
Script.

16. Modify the Repository Headstart script to point to the location object of the shared
drive on which the repository resides.

a. Locate these lines:
status=dmAPISet("set,c,l,file_system_path", dataHome & Basic.PathSeparator$ _

& docbaseName & Basic.PathSeparator$ & "content_storage_01")

b. Change them to
status=dmAPISet("set,c,l,file_system_path",drive_
letter:\documentum\data\repositoryname\content_storage_01")

where drive_letter is the shared drive where the repository data directory resides.
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17. Indicate whether to edit any other scripts.
Run the default scripts unless you are very familiar with the internal configuration
of Content Server.
• To run the default repository configuration scripts, click Next.
• To edit additional repository configuration scripts, select the script and click Edit.

Click Next after you edit and save any of the scripts.
The scripts run and the repository is configured.

18. If you are installing on Windows, provide SMTP server information.
The SMTP server is used to send email notifications to the installation owner and
repository users.

a. Type the name or IP address of a computer on your network that hosts an
SMTP Server.
The computer can be a remote host or the computer hosting Content Server. All
UNIX operating systems and Windows 2000 Server include an SMTP server.

b. Type the installation owner’s email address.

c. Click Next.
If the configuration program cannot connect with the SMTP server, a warning
message is displayed. Provide a valid host name or address for the SMTP server
or ignore the warning and proceed with the installation.

19. To use the current repository as the global registry repository, select Use this
Repository and click Next.
The global registry repository is used for storing SBOs and network locations. For
more information on the global registry and global registry user, refer to Global
registry, page 31 and Preparing for the global registry, page 56.

a. Accept the user login name of the global registry user or type in a new user
login name.

b. Type the global registry user’s password.

c. Confirm the global registry user’s password and click Next.

20. To use a different repository as the global registry repository, select Specify a
Different Repository and click Next
The global registry repository is used for storing SBOs and network locations. For
more information on the global registry and global registry user, refer to Global
registry, page 31 and Preparing for the global registry, page 56.

a. Type the repository name.
The repository must be known to the connection broker you specified during
DFC installation.

b. Type the user login name of the global registry user for the repository.
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c. Type the global registry user’s password.

21. To designate the global registry repository at a different time, select Do Later and
click Next.

22. If you are enabling SSL, indicate whether to restart the repository and click Next.
Restarting the repository enables secure client connections to the server.

23. Choose whether to restart the repository service in order to enable SSL (secure)
client connections.
• To enable SSL (secure) client connections, click Restart repository now and click

Next.

The repository stops and is restarted.
• To restart the repository at a different time, click Restart repository later and

click Next.
24. Click Finish.

25. On AIX, restart the repository.
This loads required full-text plugins.

26. If you created a new repository on a host where Thumbnail Server is already
installed, manually configure the base_url:

a. Determine the value of base_url.
• The base_url attribute takes the following format:

http://host:port/thumbsrv/getThumbnail?

host is the name of the host where you are installing. The value of host can
be the machine name (for example, isadora) or a fully-qualified name (for
example, isadora.mycompany.com).

port is the primary Thumbnail Server port you provided when you installed
Thumbnail Server.

• The Thumbnail Server installation log contains the value of base_url for the
host. The log is located in %DM_HOME%\thumbsrv\install\install.log.

b. Use IDQL or Documentum Administrator to connect to the repository as a
superuser.

c. Execute the following query to set base_url:
UPDATE dm_filestore OBJECTS SET base_url='base_url' WHERE
media_type=1

base_url is the value you determined in Step a above.

d. Disconnect from the repository.

27. Shut down Content Server and the connection broker.

28. Move the cluster group to the second node.
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29. Use the instructions in Creating the Server installation on the host, page 200 and
Configuring the repository, page 203 to repeat the installation and configuration
procedures for the second node.

30. Start the Tomcat instance running the Java method server and ACS server using the
instructions in Starting and stopping the Java method server, page 136.
The Tomcat instance starts automatically only on Windows hosts that restart after
installation.

Conguring the connection brokers

You must configure the connection brokers on both nodes to listen on the virtual
network host.

To congure the connection brokers:

1. Start Server Manager by clicking Start→Programs→Documentum→Server
Manager.

2. Highlight connection broker and click Edit Service.

3. Add the following line to the service command:
-host virtual_network_host_name

For example, if the virtual network host name is dmcluster1:
-host

dmcluster1

4. Click OK.

5. Highlight repository and click Edit server.ini.

6. Edit the connection broker_PROJECTION_TARGET section of the server.ini file:
[connection broker_PROJECTION_TARGET]

host=virtual_network_host_name
For example:

host = dmcluster1

7. Save the server.ini file.

8. Navigate to C:\Windows or C:\WINNT and open the dmcl.ini file in a text editor.

9. Edit the connection broker_PRIMARY section of the dmcl.ini file:
[connection broker_PRIMARY]

host=virtual_network_host_name
For example:

host = dmcluster1
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10. Save the dmcl.ini file.

11. Repeat these steps on the other node.

Creating additional cluster resources

Use these procedures to create cluster resources for the connection broker and Content
Server. Perform the procedures only on the node that currently owns the existing
resource group.

Be sure to perform both procedures.

To create the connection broker cluster resource:

1. Open the Cluster Administrator utility.

2. Highlight the name of the existing cluster group, for example, dmgroup1.

3. Click File→ New→ Resource.

4. In the Name field, type connection broker.

5. In the Resource Type field, select Generic Service.

6. Click Next.

7. In the Possible Owners dialog box, ensure that both nodes are in the Possible
Owners list box and click Next.

8. Move the virtual network host name from the Available Resources list box to the
Resource Dependencies list box and click Next.

9. Type the connection broker service name and click Use Network Name as Computer
Name.
To locate the connection broker service name, click Start→Administrative
Tools→Services and double-click Documentum connection broker Service
connection broker. The Service Name field value is the connection broker service
name.

10. Click Next.

11. Click Finish, then click OK.

12. Highlight connection broker and select File→ Bring Online.

To create the server cluster resource:

1. Open the Cluster Administrator utility.

2. Highlight the name of the existing cluster group.

3. Click File→ New→ Resource.
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4. In the Name field, type repository_nameDocbase.
For example, if the repository name is theodora, type theodoraDocbase.

5. In the Resource Type field, select Generic Service.

6. Click Next.

7. In the Possible Owners dialog box, ensure that both nodes are in the Possible Owners
list box and click Next.

8. Move the shared disk partition, virtual network name, and connection broker from
the Available Resources list box to the Resource Dependencies list box, then click
Next.

9. Type dmServerrepository_name as the service name.

10. Click Use Network Name as Computer Name.

11. Click Next.

12. Click Finish, then click OK.

13. Bring the Content Server generic service resource on line by highlighting
repository_nameDocbase and selecting File→ Bring Online.

Verifying failover

After you complete the preceding procedures, verify that failover works properly.

To verify failover:

1. On a client machine, ensure that the dmcl.ini entries refer to the virtual network
host name or virtual IP address.

2. Connect to the repository from the client machine.

3. Start the Cluster Administrator utility.

4. Move the resource group from the node where it is running to the other node.

5. After the resource group comes online on the other node, verify that the client can
execute queries.

Conguring an active/active cluster
In an active/active cluster, each node initially has its own repository and server. You
create two cluster resource groups, and each node owns one. Each cluster resource
group has its own virtual IP address, virtual network host name, one shared disk drive
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(where the repository resides), one connection broker, and one Content Server. If a
server fails on one node, a second server starts on the second node to keep the repository
on the first node running.

To configure an active/active cluster, you must complete the procedures in the following
sections:
• Creating the first cluster resource group, page 213
• Creating the Server installation on the hosts, page 214
• Configuring the first repository, page 216
• Configuring the second cluster resource group, page 223
• Configuring the second repository, page 224
• Modifying server.ini and dmcl.ini, page 230
• Creating the connection broker generic service resource, page 230
• Creating the Content Server service resource, page 231
• Verifying failover, page 232

Creating the rst cluster resource group

Use this procedure to set up the first cluster resource group.

To create the rst cluster resource group:

1. Use the MSCS Cluster Administrator utility on the first node to create a cluster
resource group containing the following resources:
• A virtual IP address

This is the IP address of the first repository.
• A virtual network host name

This is the virtual host name for the IP address. It must have a dependency
with the virtual IP address.

• A shared disk partition

This is where the repository content files are stored.
2. Take the resource group on line and move it back and forth between the two

machines.
This is to ensure that the IP address, virtual network host name, and shared disk
partition fail over properly.

a. In the Cluster Administrator, right-click the cluster group name.

b. ClickMove Group.
The group is toggled between the nodes and the Owner column changes.
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3. Ensure that the first node owns the resource cluster group.

Creating the Server installation on the hosts

On each of the two nodes, copy the files from the installation media to create an Content
Server installation on each node.

Use the same drive on each node. For example, create the installation on drive D:
on each machine.

The first part of the installation process copies files from the installation media to your
hard disk and sets environment variables needed by Content Server.

If you use the Cancel button to exit the Setup part of the installation program, all Content
Server registry entries are deleted. To install a component that was not previously
installed, you must go through the complete Setup program.

To create the server installation on the host computer:

1. Log in to the host system using the installation owner account.
Use an account that is a member of the local Administrators group.
On Windows, user accounts are not case-sensitive, but Content Server installation
fails if you connect to the host using the incorrect case in the user name. For example,
if the account is set up as JPSmith and you connect as jpsmith, you can log in to the
host, but server installation fails.

2. To install from the Documentum download site:

a. Navigate to the correct product directory.

b. Navigate to the server version corresponding to your operating system and
database.

3. To install from a CD:

a. Insert the CD into the CD-ROM drive.

b. On the CD, navigate to the subfolder corresponding to your operating system
and database.

4. Save the compressed distribution file from the CD or the FTP site to your hard disk.

5. Navigate to the file’s location on your hard disk.

6. Double-click the file.
The following files are extracted from the compressed file:
bofcollaborationSetup.jar
bofworkflowSetup.jar
consistency_checker.ebs
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dfcoperatingsystemSetup.jar
serveroperatingsystemSetup.jar
serverWinSuiteSetup.exe (Windows) or
serveroperatingsystemSuiteSetup.bin (UNIX and Linux)
serveroperatingsystemSuiteSetup.jar
tcfSetup.jar
tomcatoperatingsystem4127Setup.jar

7. Double-click the file named serverWinSuiteSetup.exe.
The Setup program starts and a Welcome dialog box is displayed.

8. Read the information on the dialog box and click Next.
The installer verifies operating system requirements.

9. Choose installation directories for Content Server and DFC.

a. Click Next to accept the default Content Server installation directory or click
Browse to choose a different installation directory.
The default directory is C:\Documentum.

b. To install the DFC developer documentation, select the checkbox.

c. To install the Primary Interop Assembly, select the checkbox.
Check the Primary Interop Assembly Installer checkbox to request installation of
a Microsoft installer package (.msi file) for the DFC primary interop assembly
(PIA), or leave the box unchecked if you do not wish to have the package
installed. The installer places the installer package for the DFC PIA into the
setup subdirectory of the program root.

d. Click Next.

e. Click Next to accept the default DFC installation directory or click Browse to
choose a different directory.
A dialog box is displayed indicating the default user directory. This directory is
used by DFC during the checkout or export of documents.

f. Click Next to accept the default User directory or click Browse to choose a
different directory.

10. To enable Trusted Content Services, select the checkbox and type in the Trusted
Content Services license key, then click Next.

11. To enable Content Services for EMC Centera, select the checkbox and type in the
Content Services for EMC Centera license key, then click Next.

12. Type the port numbers for the Java Method Server.
• The first port is the primary port used by the Java Method Server (Apache

Tomcat) for communications with Content Server.

The default port is 9080.
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• The second port is the port used for Tomcat administration.

The default port is 9007.
The ports must not be used by another application and must not be the ports used by
Site Caching Services.

13. Click Next.
A panel displays the software to be installed.

14. If any components already exist on the host computer, click Yes or Yes to All to
replace the older components.
A panel displays information about the products installed and their locations and
indicates that the installation is complete.

15. Click Next.
The Documentum Foundation Classes (DFC) Runtime Environment and
Documentum Content Server software are installed.

16. Choose whether to continue with server configuration.
• To configure the server immediately, click Configure server now and click Next.
• To configure the server at another time, click Configure server later and click

Next.
17. Click Next.

18. Choose whether to restart the host now or later.
The installation is not complete until the host is restarted.
• To restart the host immediately, click Yes, restart my system and click Finish.

The host restarts.
• To restart the host later, click No, restart my system at a later time and click

Finish.

Server installation is complete.
19. Repeat the server installation on the second node in the cluster.

Conguring the rst repository

This section describes how to configure the first repository and its associated connection
broker. Perform this part of the installation after the installation files have been copied to
both machines, and the Setup program has shut down and restarted them.

You must perform these steps twice. The first time sets up the first repository and server
on the first node. The second time sets up the first repository’s failover server on the
second node.
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To congure the rst repository:

1. Log in to Windows as the Documentum installation owner.
• The first time through these instructions, connect to the first node and configure

a server and repository.
• The second time through these instructions, connect to the second node and

configure the failover server.
If the setup process continues automatically, a Welcome dialog box is displayed. If
the setup process does not continue automatically, follow these steps:

a. Restart the host manually.

b. After the reboot is completed, log in as the Documentum installation owner.
The resource group has been moved to the second node.

c. Move the resource group to the first node.

d. Navigate to the DM_HOME/install directory.

e. Double-click the Server_Configuration_Program.exe file.
A welcome dialog box is displayed.

2. Click Next.
The Installation Owner Password dialog box is displayed.

3. Type the installation owner’s password and click Next.
The installer verifies the password.

4. If you did not enable Trusted Content Services during installation, optionally choose
to enable TCS, type in the license key, and click Next.

5. If you did not enable Content Services for EMC Centera during installation,
optionally choose to enable the feature, type in the license key, and click Next.

6. Click Custom Configuration and click Next.

7. Choose whether to configure a connection broker, a repository, or both, and click
Next.
• If you checked connection broker, the connection broker Configuration dialog

box is displayed.
• If you checked repository but not connection broker, the repository Configuration

Dialog box is displayed. Skip to Step 9.
8. Configure a connection broker on the Content Server host.

a. Choose Create a New connection broker and click Next.

b. Type the connection broker name and the port number on which the connection
broker listens.
The default port is 1489.
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c. ChooseManual connection brokerstartup.
Do not configure additional connection brokers.

d. Click Next.

9. Configure a repository.

a. Click Create a New Repository and then click Next.
The Data Directory dialog box is displayed. The data directory is where Content
Server stores content files.

b. Click Next to accept the default data directory location, or click Browse to select
a different location, then clickNext.Do not choose a directory that is used by
another repository for content file storage or any other purpose.
The Share Directory Destination dialog box is displayed. The Share directory is
where client products, sample code, and libraries are stored.

c. Click Next to accept the default share directory location, or click Browse to
select a different location, then clickNext.
The Repository Information dialog box is displayed.

d. Type the name of the repository.
For more information on the repository name, refer to Repository name and
ID, page 35.
If you are installing on the second node, use the same repository name you used
for the first node.

e. Type the repository ID.
For more information on the repository ID, refer to Repository name and ID,
page 35.
If you are installing on the second node, use the same repository ID you used
for the first node.

f. Select the repository size.
Use the same size on both nodes.

g. Select the authentication domain.

h. CheckManual for repository startup type.

i. Click Next.

j. Choose the mode in which clients connect to the repository.
• Check Native for unsecure connections
• Check Secure for secure connections
• Check Native and Secure if clients can use either connection mode.

k. Click Next.
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10. If you are configuring the repository on the first node, choose Create a new database
user account, then provide database information.

a. Choose the correct database connection string for your database instance.
• On Oracle, select the connection string from the dropdown list.
• On SQL Server, select an ODBC Datasource from the dropdown list
• On DB2, select the database name from the dropdown list

b. Type the database user’s name.
The database user’s name defaults to the repository name. The user becomes
the repository owner.

c. Type the database user’s password and confirm the password.

d. Type the database administrator’s user name and password.

e. Click Next.

f. Accept the default paths and sizes for database storage or change them and
click Next.
• On Oracle, these are the Data Tablespace Data File Path and Index Tablespace

Data File Path
• On SQL Server, these are the Data Device File Path and Log Device File Path
• On DB2, these are the Tablespace File Path and Index Data File Path

The tablespace or database creation dialog box is displayed.
g. Edit or accept the default database scripts.

• To edit the tablespace or database creation or deletion script, select the script
and click Edit Script. When you have saved the file, click Next.

• To accept the default scripts and run them, click Next.

The new tablespaces or databases are created.
11. If you are configuring the second node, choose Use an existing database account and

provide database information.

a. Choose the correct database connection string for the database instance you
are using.
• On Oracle, select the connection string from the dropdown list.
• On SQL Server, select an ODBC Datasource from the dropdown list
• On DB2, select the database name from the dropdown list

b. Type the database user’s name.
Use the account you created for the first node. This user is the repository owner.

c. Type the database user’s password.

d. Click Next.
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e. Choose the index tablespace or data file name for you database and ensure that
you use the same one both times through these instructions.

f. Click Next.

12. Type the connection broker connection information for the connection broker to
which you want the repository to project.
This information is used to create the server.ini file. The default connection broker
is the connection broker on the server host, but the repository can project to any
connection broker on your network.

a. Type the connection broker port number.
The port number is the port where the connection broker listens.

b. Type the connection broker host name and click Next.
The connection broker connection is tested.

13. Accept or modify the server.ini and webcache.ini files.
The server.ini file contains Content Server initialization information. The
webcache.ini file contains Site Caching Services initialization information.
• To accept the files, click Next.
• To edit the server.ini file, select Server Initialization File and click Edit Script.

After you save the file, click Next.
• To edit the webcache.ini file, select WebCache Initialization File and click Edit

Script. After you save the file, click Next.
The server starts and Edit Scripts dialog box is displayed.

14. If you are installing on the second node, transfer that the aek.key file from the first to
the second node:

a. On the second node, delete the %DOCUMENTUM%\dba\secure\aek.key file.

b. Copy the %DOCUMENTUM%\dba\secure\aek.key file from the first node to
the same location on the second node.

c. On the second node, navigate to %DM_HOME\bin.

d. Open a command line and run this command:
dm_encrypt_password -docbase repository_name -rdbms
-encrypt database_password

e. Restart the server on the second node.

15. Provide SMTP server information.
The SMTP server is used to send email notifications to the installation owner and
repository users.
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a. Type the name or IP address of a computer on your network that hosts an
SMTP Server.
The computer can be a remote host or the computer hosting Content Server. All
UNIX operating systems and Windows 2000 Server include an SMTP server.

b. Type the installation owner’s email address.

c. Click Next.
If the configuration program cannot connect with the SMTP server, a warning
message is displayed. Provide a valid host name or address for the SMTP server
or ignore the warning and proceed with the installation.

16. To use the current repository as the global registry repository, select Use this
Repository and click Next.
The global registry repository is used for storing SBOs and network locations. For
more information on the global registry and global registry user, refer to Global
registry, page 31 and Preparing for the global registry, page 56.

a. Accept the user login name of the global registry user or type in a new user
login name.

b. Type the global registry user’s password.

c. Confirm the global registry user’s password and click Next.

17. To use a different repository as the global registry repository, select Specify a
Different Repository and click Next
The global registry repository is used for storing SBOs and network locations. For
more information on the global registry and global registry user, refer to Global
registry, page 31 and Preparing for the global registry, page 56.

a. Type the repository name.
The repository must be known to the connection broker you specified during
DFC installation.

b. Type the user login name of the global registry user for the repository.

c. Type the global registry user’s password.

18. To designate the global registry repository at a different time, select Do Later and
click Next.

19. If you are enabling SSL, indicate whether to restart the repository and click Next.
Restarting the repository enables secure client connections to the server.

20. If you are installing on the second node, click Cancel and skip to the next section,
Configuring the second cluster resource group, page 223.

21. If you are installing on the first node, select Repository Headstart and click Edit
Script.
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22. Modify the Repository Headstart script to point to the location object of the shared
drive on which the repository resides.

a. Locate these lines:
status=dmAPISet("set,c,l,file_system_path", dataHome & Basic.PathSeparator$ _

& docbaseName & Basic.PathSeparator$ & "content_storage_01")

b. Change them to
status=dmAPISet("set,c,l,file_system_path",drive_
letter:\documentum\data\repositoryname\content_storage_01")

where drive_letter is the shared drive where the repository data directory resides.
Ensure that the directory referenced in the script exists.

23. Indicate whether to edit any other scripts.
Run the default scripts unless you are very familiar with the internal configuration
of Content Server.
• To run the default repository configuration scripts, click Next.
• To edit the repository configuration scripts, click Edit. Click Next after you edit

and save any of the scripts.
The scripts run and the repository is configured.

24. Choose whether to restart the repository service in order to enable SSL (secure)
client connections.
• To enable SSL (secure) client connections, click Restart repository now and click

Next.

The repository stops and is restarted.
• To restart the repository at a different time, click Restart repository later and

click Next.
25. Click Finish.

26. If you created a new repository on a host where Thumbnail Server is already
installed, manually configure the base_url:

a. Determine the value of base_url.
• The base_url attribute takes the following format:

http://host:port/thumbsrv/getThumbnail?

host is the name of the host where you are installing. The value of host can
be the machine name (for example, isadora) or a fully-qualified name (for
example, isadora.mycompany.com).

port is the primary Thumbnail Server port you provided when you installed
Thumbnail Server.
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• The Thumbnail Server installation log contains the value of base_url for the
host. The log is located in %DM_HOME%\thumbsrv\install\install.log.

b. Use IDQL or Documentum Administrator to connect to the repository as a
superuser.

c. Execute the following query to set base_url:
UPDATE dm_filestore OBJECTS SET base_url='base_url' WHERE
media_type=1

base_url is the value you determined in Step a above.

d. Disconnect from the repository.

27. Shut down Content Server and the connection broker.

28. Move the cluster group to the second node.

29. Repeat steps 1 to 26 on the second node to create the failover repository.

30. Start the Tomcat instance running the Java method server and ACS server using the
instructions in Starting and stopping the Java method server, page 136.
The Tomcat instance starts automatically only on Windows hosts that restart after
installation.

Conguring the second cluster resource group

Use these instructions to create the second cluster resource group.

To create the second cluster resource group:

1. Use the MSCS Cluster Administrator utility on the second node to create a cluster
resource group containing the following resources:
• A virtual IP address

This is the IP address for the second repository.
• A virtual network host name

This is the virtual host name for the IP address. It should have a dependency
with the virtual IP address.

• A shared disk partition

This is the location of the repository data directory.
2. Take the resource group on line and move it back and forth between the two

machines.
This is to ensure that the IP address, virtual network host name, and shared disk
partition fail over properly.

a. In the Cluster Administrator, right-click the cluster group name.
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b. ClickMove Group.
The group is toggled between the nodes and the Owner column changes.

3. Ensure that the second node owns the resource group.

Conguring the second repository

This procedure creates the second repository and configures primary and failover servers
for the repository, one on each machine.

You must perform these steps twice. The first time sets up the second repository and
server on the second node. The second time sets up the failover server on the first node.

To congure the second Repository:

1. Log in to Windows on as the Documentum installation owner.
• The first time through these instructions, connect to the second node and

configure a repository and server.
• The second time through these instructions, connect to the first node and

configure a failover server for the repository.
If the setup process continues automatically, a Welcome dialog box is displayed. If
the setup process does not continue automatically, follow these steps:

a. Navigate to the DM_HOME/install directory.

b. Double-click the Server_Configuration_Program.exe file.
A welcome dialog box is displayed.

2. Click Next.
The Installation Owner Password dialog box is displayed.

3. Type the installation owner’s password and click Next.
The installer verifies the password.

4. If you did not enable Trusted Content Services during installation, optionally choose
to enable TCS, type in the license key, and click Next.

5. If you did not enable Content Services for EMC Centera during installation,
optionally choose to enable the feature, type in the license key, and click Next.

6. Click Custom Configuration and click Next.

7. Choose whether to configure a connection broker, a repository, or both, and click
Next.
• If you checked connection broker, the connection broker Configuration dialog

box is displayed.
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• If you checked repository but not connection broker, the repository Configuration
Dialog box is displayed. Skip to Step 9.

8. Configure a connection broker on the Content Server host.

a. Choose Create a New connection broker and click Next.

b. Type the connection broker name and the port number on which the connection
broker listens.
The default port is 1489.

c. Choose Manual connection broker startup.

d. Click Next.

9. Configure a repository.

a. Click Create a New Repository and then click Next.
The Data Directory dialog box is displayed. The data directory is where Content
Server stores content files. The data directory location must be on the shared
disk partition that belongs to the cluster resource group

b. Click Next to accept the default data directory location, or click Browse to select
a different location, then clickNext.Do not choose a directory that is used by
another repository for content file storage or any other purpose.
The Share Directory Destination dialog box is displayed. The Share directory is
where client products, sample code, and libraries are stored.

c. Click Next to accept the default share directory location, or click Browse to
select a different location, then clickNext.
The Repository Information dialog box is displayed.

d. Type the name of the repository.
If this is the second time through these instructions and you are configuring the
failover server on the first node, use the same repository name you used for
the second node.
For more information on the repository name, refer to Repository name and
ID, page 35.

e. Type the repository ID.
If this is the second time through these instructions and you are configuring
the failover server on the first node, use the same repository ID you used for
the second node.
For more information on the repository ID, refer to Repository name and ID,
page 35.

f. Select the repository size.
Use the same size on both nodes.
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g. Select the authentication domain.

h. ChooseManual repository startup.

i. Click Next.

j. Choose the mode in which clients connect to the repository.
• Check Native for unsecure connections
• Check Secure for secure connections
• Check Native and Secure if clients can use either connection mode.

k. Click Next.

10. If you are installing on the second node, check Create new account and provide
database information.

a. Choose the correct database connection string for your database instance.
• On Oracle, select the connection string from the dropdown list.
• On SQL Server, select an ODBC Datasource from the dropdown list
• On DB2, select the database name from the dropdown list

b. Type the database user’s name.
The database user’s name defaults to the repository name. The user becomes
the repository owner.

c. Type the database user’s password and confirm the password.

d. Type the database administrator’s user name and password.

e. Click Next.

f. Accept the default paths and sizes for database storage or change them and
click Next.
• On Oracle, these are the Data Tablespace Data File Path and Index Tablespace

Data File Path
• On SQL Server, these are the Data Device File Path and Log Device File Path
• On DB2, these are the Tablespace File Path and Index Data File Path

The tablespace or database creation dialog box is displayed.
g. Edit or accept the default database scripts.

• To edit the tablespace or database creation or deletion script, select the script
and click Edit Script. When you have saved the file, click Next.

• To accept the default scripts and run them, click Next.

The new tablespaces or databases are created.
11. If you are configuring the first node, check Use Existing and provide database

information corresponding to the information you provided when you configured
the second node.
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a. Choose the correct database connection string for the database instance you
are using.
• On Oracle, select the connection string from the dropdown list.
• On SQL Server, select an ODBC Datasource from the dropdown list
• On DB2, select the database name from the dropdown list

b. Type the database user’s name.
Use the account you created for the second node. This user is the repository
owner.

c. Type the database user’s password.

d. Click Next.

e. Choose the correct index tablespace or data file name.

f. Click Next.

12. Type the connection broker connection information for the connection broker to
which you want the repository to project.
This information is used to create the server.ini file. The default connection broker
is the connection broker on the server host, but the repository can project to any
connection broker on your network.

a. Type the connection broker port number.
The port number is the port where the connection broker listens.

b. Type the connection broker host name and click Next.
The connection broker connection is tested.

13. Accept or modify the server.ini and webcache.ini files.
The server.ini file contains Content Server initialization information. The
webcache.ini file contains Site Caching Services initialization information.
• To accept the files, click Next.
• To edit the server.ini file, select Server Initialization File and click Edit Script.

After you save the file, click Next.
• To edit the webcache.ini file, select WebCache Initialization File and click Edit

Script. After you save the file, click Next.
The Edit Scripts dialog box is displayed.

14. Transfer the aek.key file from the second to the first node:

a. On the first node, delete the %DOCUMENTUM%\dba\secure\aek.key file.

b. Copy the %DOCUMENTUM%\dba\secure\aek.key file from the second node
to the same location on the first node.

c. On the first node, navigate to %DM_HOME\bin.
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d. Open a command line and run this command:
dm_encrypt_password -docbase repository_name -rdbms
-encrypt database_password

e. Restart the server on the first node.

15. Provide SMTP server information.
The SMTP server is used to send email notifications to the installation owner and
repository users.

a. Type the name or IP address of a computer on your network that hosts an
SMTP Server.
The computer can be a remote host or the computer hosting Content Server. All
UNIX operating systems and Windows 2000 Server include an SMTP server.

b. Type the installation owner’s email address.

c. Click Next.
If the configuration program cannot connect with the SMTP server, a warning
message is displayed. Provide a valid host name or address for the SMTP server
or ignore the warning and proceed with the installation.

16. To use the current repository as the global registry repository, select Use this
Repository and click Next.
The global registry repository is used for storing SBOs and network locations. For
more information on the global registry and global registry user, refer to Global
registry, page 31 and Preparing for the global registry, page 56.

a. Accept the user login name of the global registry user or type in a new user
login name.

b. Type the global registry user’s password.

c. Confirm the global registry user’s password and click Next.

17. To use a different repository as the global registry repository, select Specify a
Different Repository and click Next
The global registry repository is used for storing SBOs and network locations. For
more information on the global registry and global registry user, refer to Global
registry, page 31 and Preparing for the global registry, page 56.

a. Type the repository name.
The repository must be known to the connection broker you specified during
DFC installation.

b. Type the user login name of the global registry user for the repository.

c. Type the global registry user’s password.
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18. To designate the global registry repository at a different time, select Do Later and
click Next.

19. If you are enabling SSL, indicate whether to restart the repository and click Next.
Restarting the repository enables secure client connections to the server.

20. If you are configuring the failover server on the first node, click Cancel and exit the
configuration program.

21. If you are configuring the repository and server on the second node, select
Repository Headstartt and click Edit Script.

22. Modify the Repository Headstart script to point to the location object of the shared
drive on which the repository resides.

a. Locate these lines:
status=dmAPISet("set,c,l,file_system_path", dataHome & Basic.PathSeparator$ _

& docbaseName & Basic.PathSeparator$ & "content_storage_01")

b. Change them to
status=dmAPISet("set,c,l,file_system_path",drive_
letter:\documentum\data\repositoryname\content_storage_01")

where drive_letter is the shared drive where the repository data directory resides.
Ensure that the directory referenced in the script exists.

23. Choose whether to edit any other scripts.
Run the default scripts unless you are very familiar with the internal configuration
of Content Server.
• To run the default repository configuration scripts, click Next.
• To edit the repository configuration scripts, click Edit. Click Next after you edit

and save any of the scripts.
The scripts run and the repository is configured.

24. Shut down Content Server and the connection broker.

25. Move the resource group to the first node.

26. Repeat these steps to configure the second repository on the first node.

27. After you configure the second repository on the first node, move the cluster group
to the first node.
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Modifying server.ini and dmcl.ini

You may want to edit server.ini and dmcl.ini on both nodes to ensure that each repository
projects to the connection brokers on the two nodes.

In the follow examples, assume that the virtual network hosts for the two cluster resource
groups are called dmcluster1 and dmcluster2. It does not matter which cluster resource
group is primary and which is backup.

Edit all four of the server.ini files so that they read as follows:
[connection broker_PROJECTION_TARGET]
host=dmcluster1
[connection broker_PROJECTION_TARGET_1]
host=dmcluster2
Edit the two dmcl.ini files so that they read as follows:
[connection broker_PRIMARY]
host=dmcluster1
[connection broker_BACKUP_0]
host=dmcluster2

Creating the connection broker generic service
resource

Configure the second connection broker as a generic service resource for the second
resource group.

To create the connection broker generic service resource:

1. On both machines, ensure that the user who configured the cluster has read and
write permission on the directory where connection broker logs are stored.
This is typically drive:\documentum\dba\log.

2. On the node that currently owns the second resource group, open the Cluster
Administrator utility.

3. Highlight the name of the second resource group and select File→New→Resource.

4. In the Name field, type ConnectionBroker2.

5. In the Resource Type field, choose Generic Service.

6. Click Next.

7. Ensure that both nodes are listed in the Possible Owners list box and click Next.

8. Move the virtual network host name from the Available Resources list box to the
Resource Dependencies list box and click Next.
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9. Type the following in Command Line, substituting the driver letter where the server
is installed for drive and the virtual network host name for the second cluster
resource group for virtual_network_hostname:

drive:\documentum\product\5.2\bin\dmconnection broker.exe

-host virtual_network_hostname

-logfile drive:\documentum\dba\log\connection broker2.log

10. Type drive:\documentum in the Current Directory field.

11. Click Use Network Name as Computer Name and click Next.

12. Click Finish, then OK.

13. Highlight the cluster resource ConnectionBroker2 and click File→ Bring Online.

Creating the Content Server service resource

You must create a service resource for Content Server on the node that owns the second
resource group.

To create the Content Server service resource:

1. On the node that owns the second resource group, open the Cluster Administrator
utility.

2. Highlight the name of the second resource group and select File→ New→ Resource.

3. In the Name field, type repository_nameDocbase.

4. In the Resource Type field, choose Generic Service.

5. Click Next.

6. Ensure that both nodes are listed in the Possible Owners list box and click Next.

7. Move the shared disk partition, virtual network name and connection broker2 from
the Available Resources list box to the Resource Dependencies list box and click Next.

8. Type dmServerrepository_name as the service name.

9. Click Use Network Name as Computer Name and click Next.

10. Click Finish, then OK.

11. Highlight the cluster resource repository_nameDocbase and click File→ Bring Online.
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Verifying failover

After you complete the preceding procedures, verify that failover works properly.

To verify failover:

1. On a client machine, ensure that the dmcl.ini entries refer to both virtual network
host name or virtual IP address.

2. Connect to both repositories from the client machine.

3. Start the Cluster Administrator utility.

4. Move the two resource groups back and forth between the nodes.

5. After a resource group comes online on a new node, verify that the client can execute
queries.

Upgrading a repository installed with Cluster
Services

Use the following general procedure to upgrade a repository installing with Microsoft
Cluster Services.

To upgrade an active/passive, single-repository cluster:

1. Shut down the Content Servers on both nodes.
This shuts down the repository.

2. Shut down both hosts.

3. Restart the first node.
Do not restart the Content Server on the first node.

4. On the first node, upgrade the server software.
Use the instructions in Upgrading the Server software installation on the host, page
122.

5. Upgrade and configure the repository and connection broker.
Use the instructions in Upgrading the connection broker, the Server and the
repository, page 126. Complete all of the instructions, including running the scripts
that configure the repository.

6. Open the Services dialog box and verify that the Java method server was created
correctly.
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If the service called Documentum Java method server is started, it was created
correctly.

7. Test the repository to verify that it is functioning correctly.

8. Shut down the repository on the first node.

9. Shut down the first node.

10. Start the second node.

11. Start the connection broker on the second node.

12. Upgrade the server software on the second node.
Use the instructions in Upgrading the Server software installation on the host, page
122.

13. Start the configuration program and choose Custom Configuration.
Use the instructions in Upgrading the connection broker, the Server and the
repository, page 126.

14. Choose upgrade and the repository to upgrade.

15. When the configuration program reaches the panel on which scripts are run, click
Cancel.
Do not run the scripts. The Java method server is created and the repository is
upgraded.

16. Start the Tomcat instance running the Java method server and ACS server using the
instructions in Starting and stopping the Java method server, page 136.
The Tomcat instance starts automatically only on Windows hosts that restart after
installation.

Use the following general procedure to upgrade a repository installing with Microsoft
Cluster Services. It applies to both active/passive and active/active installations.

To upgrade an active/active, two-repository cluster:

1. Shut down the running Content Servers on both nodes.
This shuts down both repositories.

2. Shut down both hosts.

3. Restart the first node.
Do not start the Content Servers on the first node.

4. On the first node, upgrade the server software.
Use the instructions in Upgrading the Server software installation on the host, page
122.

5. Upgrade and configure the repository and connection broker.
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Use the instructions in Upgrading the connection broker, the Server and the
repository, page 126. Complete all of the instructions, including running the scripts
that configure the repository.

6. Open the Services dialog box and verify that the Java method server was created
correctly.
If the service called Documentum Java method server is started, it was created
correctly.

7. Test the repository to verify that it is functioning correctly.

8. Shut down the repository on the first node.

9. Shut down the first node.

10. Start the second node.

11. Start the connection broker on the second node.

12. Upgrade the server software on the second node.
Use the instructions in Upgrading the Server software installation on the host, page
122.

13. Start the configuration program and choose Custom Configuration.
Use the instructions in Upgrading the connection broker, the Server and the
repository, page 126.

14. Choose upgrade and the repository to upgrade.

15. When the configuration program reaches the panel on which scripts are run, click
Cancel.
Do not run the scripts. The Java method server is created and the repository is
upgraded.

16. Start the Tomcat instance running the Java method server and ACS server using the
instructions in Starting and stopping the Java method server, page 136.
The Tomcat instance starts automatically only on Windows hosts that restart after
installation.
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Conguring Multiple Servers on a
Single Host for a Particular Repository

Multiple Content Servers can be run on a single host against a particular repository. This appendix
provides instructions for creating such a configuration..

Windows hosts
Use these instructions after a repository is configured to create additional servers for that
repository on the repository host. (For instructions on configuring additional servers
for a repository on remote hosts, refer to the section called “Server Load Balancing” in
the Content Server Administrator’s Guide.)

To congure additional servers on a Windows host:

1. Connect to the repository as a Superuser using IAPI or Documentum Administrator
and create a new server config object.
For example, if the existing server config object is called caruso, call the new server
config object caruso1.

2. Disconnect from the repository.

3. Create a server.ini file for the new server.

a. On the server host file system, navigate to the
%DOCUMENTUM%\dba\config\repository_name directory,
where repository_name is the name of the repository.

b. Create a copy of the server.ini file called server1.ini.

c. Open the server1.ini file and add these lines:
service=caruso1
server_config_name=caruso1

d. Save the server1.ini file.
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4. Navigate to the \Winnt\System32\drivers\etc\ and open the services file in a text
editor.

5. Assign port numbers to the new server.
For example, if these entries exist for the primary server
dm_caruso 10000/tcp # repository service caruso
dm_caruso_s 10001/tcp # repository secure service
Add the following entries for the new server:
dm_caruso1 10005/tcp # repository service caruso1
dm_caruso1_s 10006/tcp # repository secure service

6. Save the services file.

7. Create Windows registry entries for the new server.

a. Open the registry and back it up.

b. Navigate to HKEY_LOCAL_
MACHINE\SYSTEM\CurrentControlSet\Services\.

c. Locate the service key for the existing Content Server.

d. Use the Save Key menu to write out the key values for the existing Content
Server service.

e. Create a new key with a new name.

f. Restore the key values you wrote out to the new key.

g. Change the ImagePath variable to include the path to the new server.ini file
and a new log file.
For example, if the existing ImagePath is
d:\Documentum\product\5.3\bin\dmserver_v4.exe -repository_name

test1 -security acl -init_file
d:\Documentum\dba\config\test1\server.ini -run_as_service

-install_owner dmadmin -logfile
d:\Documentum\dba\log\test1.log
The new ImagePath would be:
d:\Documentum\product\5.3\bin\dmserver_v4.exe -repository_name

test1 -security acl -init_file
d:\Documentum\dba\config\test1\server1.ini -run_as_service

-install_owner dmadmin -logfile
d:\Documentum\dba\log\test1_1.log
For additional information on creating a new service, refer to Windows
documentation from Microsoft.

8. Set the new server to manual start mode using Start→Programs→Administrative
Tools→Services panel.

9. Restart the host.
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10. Click Start→Programs→Administrative Tools→Services and start up the new
server.

11. Start IDQL and verify that the server is running correctly:
$ IDQL caruso.caruso1 -Uusername -Ppassword

UNIX hosts
Use these instructions after a repository is configured to create additional servers for that
repository on the repository host. (For instructions on configuring additional servers
for a repository on remote hosts, refer to the section called “Server Load Balancing” in
the Content Server Administrator’s Guide.)

To create this configuration, you must edit the etc/services file, which requires root
privileges.

To congure additional servers on a UNIX host:

1. Connect to the repository as a Superuser using IAPI or Documentum Administrator
and create a new server config object.
For example, if the existing server config object is called caruso, call the new server
config object caruso1.

2. Disconnect from the repository.

3. Create a server.ini file for the new server.

a. On the server host file system, navigate to the$DOCUMENTUM/dba/config/
repository_name directory, where repository_name is the name of the repository.

b. Create a copy of the server.ini file called server1.ini.

c. Open the server1.ini file and add these lines:
service=caruso1
server_config_name=caruso1

d. Save the server1.ini file.

4. Navigate to /etc/services and open the services file in a text editor.

5. Assign port numbers to the new server.
For example, if these entries exist for the primary server
dm_caruso 10000/tcp # repository service caruso
dm_caruso_s 10001/tcp # repository secure service
Add the following entries for the new server:
dm_caruso1 10005/tcp # repository service caruso1
dm_caruso1_s 10006/tcp # repository secure service
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6. Save the services file.

7. Navigate to the $DOCUMENTUM/dba directory and make a copy of the repository
startup and shutdown scripts:
cp dm_start_caruso dm_start_caruso1
cp dm_shutdown_caruso dm_shutdown_caruso1

8. Open the startup script in a text editor.

9. Change
logfile=$logdir/caruso.log
to
logfile=$logdir/caruso1.log

10. Change
./documentum -repository_name caruso -security acl -init_file
/trout1/documentum/dba/config/caruso/server.ini $@ >> $logfile 2>&1 &

to
./documentum -repository_name caruso -security acl -init_file
/trout1/documentum/dba/config/caruso1/server1.ini $@ >> $logfile 2>&1 &

11. Open the shutdown script in a text editor.

12. Change
DM_PID=`./iapi caruso -U$DM_DMADMIN_USER -P -e << EOF |

grep 'root_pid' | sed -e 's/ .*[: A-Za-z]//'

to
DM_PID=`./iapi caruso.caruso1 -U$DM_DMADMIN_USER -P -e << EOF |

grep 'root_pid' | sed -e 's/ .*[: A-Za-z]//'

13. Change
./iapi caruso -U$DM_DMADMIN_USER -P -e << EOF

to
./iapi caruso.caruso1 -U$DM_DMADMIN_USER -P -e << EOF

14. Save the shutdown file.

15. Start both servers:
dm_start_caruso
dm_start_caruso1

16. Start IDQL and verify that the server is running correctly:
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$ IDQL caruso.caruso1 -Uusername -Ppassword

17. Check the log file for the new server in $DOCUMENTUM/dba/log/caruso1.log.
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